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Instrument Descriptions

Baker AWA-IV 2 kV/4 kV Model Front Panel

All Baker AWA-IV series analyzers feature a large eight-inch touch window with a graphical user interface.  The 

interface features a logical layout of large touch icons that improve ease of use.  Each tester’s voltage capacity is 

identified by the markings found just below the touch window.

Fig 1: Front panel controls for AWA-IV 2 kV and 4 kV models.

Item Description

1 VGA port—used to connect the tester to a larger monitor (not included) for easier viewing of 

test results.

2 USB ports—Industry standard USB ports are accessible from the front panel for connections to 

a printing device, and data storage and retrieval devices.

3 Ethernet connector—The tester can be connected to a network via the ethernet connector.

4 E-stop equipment power shut-off—This large, highly visible red button is easily pressed on the 

front panel for equipment shut-downs.  It cuts all power to the unit swiftly and safely.

5 DC test/HiPot button.

6 Open ground light.

7 Leads energized light.
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Instrument Descriptions

Item Description

8 Test leads 1–3 select buttons.

9 Voltage output control knob—Turn the knob clockwise to increase the applied voltage or 

counterclockwise to decrease the voltage.  The rate of voltage increase or decrease is set via 

the touch window interface.  Do not force the knob; turning the knob harder does not cause 

voltage to ramp any quicker and may damage the instrument.

10 High-voltage test leads—The Baker AWA-IV uses high-voltage test leads for surge, Baker 

ZTX, and DC testing.  Three test leads (red) and a ground lead (black) are provided for motor 

test connections.  Both sides of the connection clips must be in contact with the terminal of 

the motor being measured. You must keep the leads clean and dry for best measurement 

performance.

11 Resistance leads—For the AWA-IV 2 kV and 4kV models, one red test lead and one black 

ground lead are used for low-voltage testing.

CAUTION:  The test leads have exposed metal areas.  Do not touch the leads while tests are running.  Always ensure 

that the test leads are not placed in proximity to the frame or ground potential.

Low-voltage Resistance Test Leads

Both sides of the connection clips must be in contact with the terminal of the motor being measured. Most recent 

AWA-IV 2/4kV testers have two low-voltage resistance test leads. Ensure that the leads are connected as shown in 

the example below.

 

Fig 2: Proper orientation of AWA-IV 2/4 kV 2-lead connectors.
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Instrument Descriptions

Baker AWA-IV 6 kV/12 kV Model Front Panel

Fig 3: Front panel controls for Baker AWA-IV 6 kV and 12 kV models.

Item Description

1 VGA port—used to connect the tester to a larger monitor (not included) for easier viewing of 

test results.

2 AUX/Power Pack connector.

3 USB ports—Industry standard USB ports are accessible from the front panel for connections to 

a printing device, and data storage and retrieval devices.

4 Reset button.

5 Ethernet connector—The tester can be connected to a network via the ethernet connector.

6 Reset button.

7 E-stop equipment power shut-off—This large, highly visible red button is easily pressed on the 

front panel for equipment shut-downs.  It cuts all power to the unit swiftly and safely.

8 Open ground light.

9 Voltage output control knob—Turn the knob clockwise to increase the applied voltage or 

counterclockwise to decrease the voltage.  The rate of voltage increase or decrease is set via 

the touch window interface.  Do not force the knob; turning the knob harder does not cause 

voltage to ramp any quicker and may damage the instrument.

10 Leads energized light.

11 DC test/HiPot button.
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Instrument Descriptions

Item Description

12 Test leads 1–3 select buttons.

13 High-voltage test lead, black, ground.

14 High-voltage test leads—The Baker AWA-IV uses high-voltage test leads for surge, Baker 

ZTX, and DC testing.  Three test leads (red) and a ground lead (black) are provided for motor 

test connections.  Both sides of the connection clips must be in contact with the terminal of 

the motor being measured.  You must keep the leads clean and dry for best measurement 

performance.

15 Resistance leads—For the 12 kV models, three test leads with no ground lead are used for 

low-voltage testing. The clips and cord color can vary depending on the design.  AWA-IV 6 kV 

models do not have this set of leads.

CAUTION:  The test leads have exposed metal areas.  Do not touch the leads while tests are running.  Always ensure 

that the test leads are not placed in proximity to the frame or ground potential.

Baker AWA-IV 6 kV Model Distinctions

The AWA-IV 6 KV model differs from the AWA-IV 12 kV with respect to test leads and procedures for use. 

The AWA-IV 6 kV analyzer uses only one set of leads for both high- and low-voltage testing; it  does not include a 

separate set of low-voltage resistance test leads.

The clips are currently rated for 48 volts.  Ensure that the clips are not placed in proximity to the frame or other 

ground potential. 

Fig 4: AWA-IV 6 kV; high voltage leads only.

8 Baker AWA-IV 71-050 EN V6 Quick Reference Guide     www.megger.com



Preparing for Testing

Preparing for Testing

Process Overview

The basic process for testing a motor on the AWA-IV includes the following steps:

1. Open an existing database or create a new one.

2. Select an existing motor to test, or create a new motor (motor ID and test ID).

3. Select tests to run.

4. View and confirm test parameters, or modify test parameters.

5. Run tests automatically, semi-automatically, or manually. Each step is described in more detail in this chapter.

Creating or Opening a Database

1. Start the Baker AWA-IV application by clicking on the icon on the tester window or the MS Windows Start 

button.

2. Click on the appropriate radio button for creating a new database or opening an existing one.

 

Fig 5: Dialog box for creating or opening a database.

3. When creating a new database, a dialog box will open so you can name the new database. Enter the database 
name in the field then click OK.

4. When opening an existing database, highlight the database needed from the list and click OK.
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Preparing for Testing

Selecting a Motor to Test

1. Click on the Data tab to select existing motors, or to create and store information for new motors. Each motor 

will be listed in the Explore tab’s Motor Tree on the left side of the window. The Motor Tree provides a complete 

listing of all motors stored in a particular database.

2. To select the Motor ID for an existing motor, locate it within the Explore tab then click on the Motor ID to 
highlight it and to load its information in the Data tab.

 

Fig 6: Using the Data tab to create a new motor.
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Preparing for Testing

Creating a New Test ID

If a Test ID does not exist for the motor you want to test, you can create a new one for current and future use.

1. Click on the Tests tab.

2. Click on the Edit Test ID checkbox to enter edit mode.

3. Editing Test IDs is password protected. Enter the default password (or a new one if it has been changed) into the 
Password field. 

NOTE:  Windows login default password: baker      Test parameter setup default password: bakerpas

4. To change a password, click on Change Password, type in the current password (default or most recent), enter 
the new password and confirm, then click on Set Password.

5. Click OK to close the password dialog box.

 

Fig 7: Setting a password within the Tests tab.

6. Click the Add button. The Create New Test ID dialog box appears.

7. If an existing Test ID is close to what you will need, ensure that it is selected in the Test ID field then click on 
the Copy Current Test ID radio button. Otherwise, click on the Add Blank Test ID radio button to start from 
scratch.
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Preparing for Testing

8. Give the new Test ID a descriptive name and choose a target motor voltage class from the drop-down list then 
click on OK.

 

Fig 8: Create New Test ID dialog box.

9. You can further modify the Test ID by selecting the desired tests to be performed via the ON/OFF buttons.

 

Fig 9: Selecting tests to perform, and controls for configuring or viewing test parameters.
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Preparing for Testing

10. You can also provide specific values and parameters for each test as needed by clicking on the Configure/View 
buttons. In the following example, DA Only is selected from the DA/PI tests drop-down list and Ramp Voltage is 
selected from the HiPot/Step Voltage test list.

 

Fig 10: Selecting test parameters from the DC Tests Setup window.

11. Click Save to save the changes made to the new Test ID or click OK in response to a confirmation dialog 
appearing after making parameter changes. The new Test ID will be added to the list.
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Preparing for Testing

Creating a New Motor ID

1. If the motor you are testing does not yet have a Motor ID in the system, you will need to create a new Motor ID. 

To add a new Motor ID to the selected database, click on the Add button.

2. Click on the Clear button to remove all information currently entered in the fields.

3. Type the Motor ID, Location, Building, and nameplate information in the appropriate fields.

NOTE: The labels for the Location and Building fields can be changed as desired by using the Options  Changeable 

Labels items in the View tab.

4. Best practices suggest adding all information pertinent to the motor to facilitate testing. This information can be 
useful during the testing and troubleshooting processes.

5. Click on the Save button to add the motor information to the database.

6. The Select Test ID dialog box will appear so you can assign the most appropriate Test ID to the motor. Test IDs 
contain the testing parameters (for example, tests performed, voltages, and pass/fail criteria) along with a basic 
motor description. For example, a Test ID named 480Vw/Rotor>100HP StepV includes tests for a 480-volt motor 
that has the rotor installed during testing, is less than 100 horsepower and will feature step voltage testing.

7. Click OK after selecting the best available Test ID for the motor you will be testing.

 

Fig 11: New motor added to Motor Tree. Information entry and Test ID selection.

8. The new motor will appear in the motor tree on the left side of window.

9. You can then view the tests selected for the motor along with the test parameters then make adjustments if 
needed to better suit your testing objectives.
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Preparing for Testing

Selecting Tests and Setting Up Test Parameters

As noted in the process for creating a new Test ID, you can select which tests you want to run for a selected motor by 

clicking on the ON/OFF buttons for each test type. You can also view and configure parameters for each test type by 

clicking on the buttons in the right column for each test type.

 

Fig 12: Selecting tests to perform, and controls for configuring or viewing test parameters.

NOTE: The following sections provide brief introductions to each test setup window. For details on the windows and 

the parameters set within, refer to the AWA-IV user manual.
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Preparing for Testing

Setting Up Temperature and Resistance Tests

1. To enter the temperature value and set up resistance tests, click on either the Manual or 3 Lead/High V button.

2. The Temperature/Resistance Test setup window appears so you can provide the information needed for your test.

3. Using this window, you can enable or disable temperature entry or resistance testing, select specific parameters 
to include in your testing, or adjust testing parameters to fit your needs.

 

Fig 13: Temperature/Resistance Test setup window.

4. The Test Results section shown at the bottom of the window provides a view of the results collected when the 
test runs automatically or semi-automatically. You can also use this section directly during manual testing.

5. When you have completed your setup, close the window.
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Preparing for Testing

Setting Up DC Tests

1. Open the DC Tests setup window by clicking on any of the voltage buttons to the right of the DC tests listed.

2. Using this window, you can enable or disable test types, select DC test types to include in your testing, select 
specific parameters to include in your testing, or adjust testing parameters to fit your needs.

3. You can use the default values provided, or you can modify parameters based on IEEE, EPRI, EASA, IEC, or 
company standards.

4. Depending on the test types selected, other controls may appear within the window.

 

Fig 14: DC Tests setup window.

5. If you want to use temperature correction for your DC tests, check the Temp Correction Enable box (even if you 
have checked this option in the resistance test setup window.)

6. The Run Test buttons near the bottom left of the window are used to control testing during manual testing. The 
Voltage and Current displays to the right show you value being measured during testing.

7. When you have completed your setup, close the window.
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Preparing for Testing

Setting Up a Step-Voltage Test

1. From the DC TESTS window, click on the drop-down list for HiPot/Step Voltage then click on Step Voltage as 

shown in the image below. This will open the Config Wizard.

 

Fig 15: Setting up Step-Voltage test parameters.
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Preparing for Testing

2. Set each value to a desired level and click Next.

 

Fig 16: Step-Voltage Configuration Wizard; setting voltage parameters.

3. Add or delete steps within this window as needed, then click Finish to save the setup.

4. When you have completed your setup, close the window.

 

Fig 17: Step-Voltage Configuration Wizard; adding steps.

www.megger.com 19



Preparing for Testing

Setting Up a Surge Test

1. From the Tests tab, click on the Configure/View button in third column of the Surge test section to enter the 

setup window.

2. Using this window, you can select options to use during testing, select parameters to include in testing, and 
specify test parameter values.

3. Enter parameters based on IEEE, EPRI, EASA, IEC, or company standards.

4. Set Pass/Fail tolerances as needed for the motor under test.

5. You can also check the ZS Override button if you want the tester to automatically start at the Surge Voltage 
level, removing the need to ramp up and allowing the tester to reach the target voltage faster. This feature is 
available only for semi- automatic or manual testing. Note that the feature cannot be saved as part of a Test ID.

WARNING: When using ZS Override, test voltage will not start at zero.  Because the tester will 

immediately apply higher test voltages to the motor, take all precautions to avoid injury or death from 

severe electrical shock.

6. The large graph area plots the surge waveform during testing.

7. The Run Surge controls are used during manual testing.

 

Fig 18: Setting up Surge test parameters.

8. When you are satisfied with your specifications, close the Surge Test setup window.

When you have completed the processes for selecting an existing motor ID, creating a new motor ID (and Test ID), 

selecting tests to run, and confirming or modifying test parameters, you will be ready to run the tests on your motor. 

Details for running tests automatically, semi-automatically, or manually are provided in the next section along with 

other operating procedure information.
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Preparing for Testing

Surge Testing through Capacitors

The surge test is load dependent. Anything that adds capacitance to the motor or system under test will create more 

load on the tester.

When surge testing a motor, all capacitors should be removed or the ground should be lifted. Otherwise, the 

capacitors will absorb the surge pulse, preventing it from entering the coils.

Rotor Effect on Testing

When possible, remove or secure the rotor before testing. Rotors can affect testing results, particularly if they move 

(even slightly) during testing. Some issues can be erroneous high resistance imbalance in coil testing due to increased 

inductance, inability to polarize for DA/PI testing, or frequency shift in one or more waveform values during surge 

testing. An erratic PP EAR will often result, and the shift could even trip the EAR limits.      
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Preparing for Testing
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Basic Testing Procedures

Basic Testing Procedures

Using the Explore, Motor ID, and Route Tabs to Find Motors

The left side of the window is used to navigate through the motors within the opened database. Three methods can 

be used:

The Explore Tab

The Explore tab includes a tree structure to help you select a particular Motor ID. The two upper levels of the tree 

correspond to the location and building in which the physical motor is housed. Location and Building are the default 

tree labels, but they can be changed. The lowest level is the Motor ID.

The Motor ID Tab

The Motor ID list box provides an alphabetical listing of all motors found in the database. In the edit box located 

above the list, the currently selected Motor ID is displayed. Locate a Motor ID using one of two ways within this tab:

 � Begin typing the desired Motor ID in the edit box. The list will automatically scroll to the nearest Motor ID that 
begins with those characters.

 � Otherwise, scroll down the list until the Motor ID is located. Double click on the Motor ID or highlight the Motor 
ID and click the Display button to select.

The Route Tab

The Route tab allows construction of individual lists of Motor IDs for routing purposes. As seen in the example, the 

“Spring Outage” list is selected. This list has four associated motors.

You do not need to search the entire database to find the motors to be tested during the “spring outage” event. This 

tab also allows you to edit and print the routes.

To select a motor, simply click on the motor name in the route list. Click on the Edit Route button to start the editor.  

The Route Editor dialog box appears to help you add, rename, and delete routes. It also provides tools to add, 

remove, and change the order of the Motor IDs within a list.

 

Fig 19: Use the Route Editor to manage route information.
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Basic Testing Procedures

Running Tests Automatically, Semi-Automatically, or Manually

After you have selected a motor for testing, completed selecting the tests you want to run, and made adjustments 

to the test parameters (if needed) you can simply click on the red Run Auto Test button found in the Tests tab. The 

software will then execute each test in turn, providing you with visual cues along the way for setting up test leads, 

entering temperature values (if selected), and displaying test results within the related test windows.

 

Fig 20: Controls used to run automatic and semi-automatic testing.

You can run tests semi-automatically by clicking on the individual test type buttons found in the Tests tab. The 

software will perform the same functions as during automatic testing, but only for the selected test.
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Basic Testing Procedures

As noted in the setup window descriptions, each window has controls for manually executing tests. Resistance and 

surge tests even allow you to test individual leads. Tests can also be run manually using the analyzer’s front panel 

controls.

 

Fig 21: Controls within setup windows to run tests manually.

An automatic test will analyze the motor in the following sequence:

1. Resistance

2. Megohm

3. PI/DA

4. DC HiPot/DC Step Voltage

5. Surge

NOTE: The actual tests performed will depend on the tests you select for your motor.

At the end of the sequence, the test data will automatically be saved to the database.

1. To start an automatic test, ensure that the motor is selected.

2. Click on the Tests tab to get to the main testing window.

3. To start the test, click on the red Run Auto Test button and follow the directions.
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Basic Testing Procedures

4. The Safe To Turn On dialog box appears when a high-voltage test is selected.  Typically, it instructs you to verify 
that the correct set of leads have been properly connected; however, the content of the message can vary 
depending on your tester configuration.

 

Fig 22: Safe to Turn On dialog box; message content can vary.

5. Follow the instructions in the dialog to continue the testing process. When all tests have been run, the test data 
will automatically be saved to the database and the main test window will re-appear.

NOTE: Not all Baker AWA-IV testers have low-voltage test leads. If this option is not available, this window will be 

slightly different; however, the test operation is the same.

Test Sequence

The following sequence of tests will run automatically. If a test fails, the software will stop the testing process, leads 

will be discharged and grounded, and you will be presented with choices for continuing testing if applicable.

Under most circumstances, you should troubleshoot, diagnose, and repair the motor before going on to the next test 

in the sequence.

Temperature Entry

The Temperature/Resistance dialog will be displayed ready for the temperature reading to be entered from a third-

party temperature device.

1. Enter the temperature off the motor and click the Accept button to acknowledge the temperature being 

entered.

2. Click Next to proceed. The tester will automatically proceed with the remainder of the tests.

Resistance

This test looks for resistance imbalance between phases. If a large imbalance is found, inspect the motor for causes 

of the discrepancy. By comparing the values to a reference standard, you can evaluate the following quality and 

degradation issues:

Field testing—Inspect connections in junction box and look for high resistance connections, and improper or loose 

connections.

Quality/post failure—Look for number of turn per phase variation, diameter copper variation, turn-to-turn shorts, 

or turn opens.
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Basic Testing Procedures

Megohm

A Megohm test uses a test voltage close to the motor’s operating voltage and appropriate standards and/or company 

guidelines. This voltage will be held for 60 seconds during which the analyzer watches for overcurrent conditions and 

micro-arcs or insulation resistance values below the minimum megohm setting. Look for an unusually low Megohm 

value when compared to previous measurements or industry accepted limits. If a low Megohm value is measured, 

inspect the motor for ground wall insulation damage.

PI/DA

The Polarization Index (PI) test measures the insulation’s ability to polarize. When an insulator polarizes, the electric 

dipoles distributed throughout the insulator align with the applied electric field. As the molecules polarize, a 

polarization (absorption) current develops and adds to the insulation’s leakage current. The additional polarization 

current decreases over time and drops to zero when the insulation is completely polarized.

The PI test is typically performed at 500, 1000, 2500, or 5000 volts depending on the motor’s operating voltage. The 

duration of the PI test is 10 minutes (600 seconds). The PI value is calculated by dividing the insulation resistance at 1 

minute by the resistance at 10 minutes. In general, damaged insulators will show a low polarization index.

Many insulating materials do not easily polarize. If the 1-minute insulation resistance is greater than 5000 Megohms, 

the PI measurement may not be meaningful.

The PI test is performed on motor 100 Hp or greater. Motors less than 100 Hp should use the Dielectric Absorption 

(DA) test. On the AWA, set the PI minimum alarm at 2.0 for class B, F, and H insulation, and 1.5 for class A insulation.

The PI test should not be used as the basis for any motor acceptance criteria. It should be used as a trending and 

diagnosis tool along with other test results, including the PI curve generated.

If the Test ID was set up for a DA test, the test duration will be three minutes (180 seconds).

DC HiPot/Step Voltage

The HiPot test is performed at a test voltage higher than the Megohm test; that is, at voltages typically encountered 

at start-up.  Actual test voltages are based on the motor’s operating voltage and appropriate standards and/or 

company guidelines.

Look for unusually high leakage currents or a leakage current that does not stay constant. High leakage currents 

indicate weak ground wall insulation.

During a Step Voltage test, voltage is applied to all three phases of the winding and raised slowly to programmed 

levels then held for a predetermined period. This process is executed in equal increments (steps) until the target 

maximum voltage level is reached. Because the test is most stable at the end of each step, data is logged at this 

point. If the leakage current doubles from a given step to the next, an insulation weakness is indicated and testing 

should be stopped. If leakage current increases consistently less than double, the motor insulation is likely good.
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Surge

Effectively an electrical resonance test, the Surge test creates a non-linear voltage drop across the windings, stressing 

the turn-to-turn insulation. If weak insulation exists, the differential voltage will short out a bit of the winding, 

causing the overall inductance to go down.

Surge testing measures pulse-to-pulse EAR (Error Area Ratio) by default, and can also measure line-to-line EAR. (Refer 

to the AWA-IV User Guide for details on Surge testing and EAR measurement.)

During testing, the voltage will be slowly increased on lead 1 to the voltage specified in the

Test ID. If no pulse-to-pulse EAR failures are detected, leads 2 and 3 will be tested.

A shift to the left in the waveform patterns is a common indicator of weak insulation.

Failure modes Winding 
resistance

Meg test PI test Step-voltage 
test

Surge 
test

Weak insulation turn-to-turn X

Weak insulation phase-to-phase X

Weak insulation coil-to-coil X

Turn-to-turn shorts X X

Phase-to-phase shorts X X

Coil-to-coil shorts X X

Open coils X X

Reversed coils X

Unbalanced phases X X

Weak ground wall insulation X X X

Dirty windings X X X

Moisture X X X

Faulty feeder cables X X X

Motor lead line connections X X

Fig 23: Fault analysis chart.
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Basic Testing Procedures

Reviewing Test Results/Data

After the test results have been saved to the database, they can be reviewed using the Data tab on the right pane of 

the analyzer software main window.

The Results Summary tab (accessed from the bottom of the pane) presents a Date/Time section at the top of the 

window and a spreadsheet style view occupying the main display area.

 

Fig 24: Data tab showing example results; Date/Time window.

The Date/Time section shows a summary of the time and date of tests, and whether the tests passed or failed. 

Clicking on a specific test date/time loads the test records for that event into the main display area.

The spreadsheet style of the results view shows the actual test data acquired. The test date and time are shown in the 

first two rows. A header row marks the start of a results section for each test category followed by the specific test 

measurement results.  Color-coding helps you see whether a test category includes all passing tests (green) or failing 

results for specific measurements (red).

 

Fig 25: Example test results summary view.

The Surge, PI, and Step/Ramp Voltage test results can be viewed using the dedicated tabs found at the bottom of the 

pane.
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Basic Testing Procedures

For example, review the PI test by clicking on the PI tab. The PI view will display the PI/DA graph along with a table of 

the current and megohm readings gathered at specific times. The PI voltage, DA ratio, and PI ratio are displayed on 

the right side.

 

Fig 26: Example PI test results.

The Surge test data can be reviewed by pressing the Surge tab

 

Fig 27: Example Surge test results.
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Basic Testing Procedures

Printing Reports

Complete report generation features are available to document test results for managers, customers, owners, repair 

personnel, and more. Reports contain test, nameplate, and application data and can be sent to a printer or output as 

an RTF file.

You have three options for starting the Report Generator:

 � Click on the File  Print.

 � Hold down the control key and press “P” on your keyboard.

 � Click on the printer icon in the upper left of the main window.

The Select Filters section of the Report Generator dialog contains a selection of print filters. Check the Current 

Motor/Test Results box, or use any combination of the filters such as a date range and all motors that fail any test 

during a given test range.

The Select Reports section provides a list of available reports and report options.

 

Fig 28: Report Generator dialog.

The simplest report to generate is the current test results, which appear to the right of the Current Motor/Test 

Results check box. Check the box then select which report(s) you want to generate.

NOTE: For more detailed information on printing reports along with additional information on testing, results 

analysis, recommended test voltages, applicable standards, data transfer, and more refer to the Baker AWA-IV User 

Guide.
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Electrical and Calibration Standards

All Megger Baker Instruments standards are either certified directly or are traceable to certification by the National 

Institute of Science and Technology, formerly the United States Bureau of Standards.  To obtain other information 

concerning calibration, contact Megger Baker Instruments.

Equipment Return

Before returning any equipment or components to Megger Baker Instruments, the following steps should be taken:

1. Call the Megger Baker Instruments Fort Collins service department at (970) 282-1200.  Give the service 

representative a full description of the reason for the return, including any diagnostic or troubleshooting actions 

taken.  Please provide the specific model and serial number of the instrument.

2. Equipment returned to Megger Baker Instruments must be packaged in such a manner that it will reach the 
factory undamaged from transit.

3. For non-warranty repairs, Megger Baker Instruments service will provide a cost estimate for your approval prior to 

your shipping.

Megger Acquisition of Baker Instruments

Megger Group Limited, a manufacturer of electronic test equipment and measuring instruments for power 

applications, acquired the Baker Instruments business from SKF Group in August of 2018  

For over 50 years, the Baker Instruments business has led the electrical motor testing industry and has a recognized 

leading brand and position in this area. As such, legacy products will carry the Baker Instruments or SKF brands, 

which will be supported by Megger moving forward.

Patents

 #US04768380 • #US05679900 • #US05845230 • #US05854553 • #US05992237 • #US06006164 • #US06199422 

• #US06202491 • #US06275781 • #US06489884 • #US06513386 • #US06633822 • #US6,789,025 • 

#US6,792,360 • US 5,633,811 • US 5,870,699 • #WO_03_048714A1

Trademarks

Megger is a registered trademark of Megger Group Limited.

All other trademarks are the property of their respective owners.

NOTE:  This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 

to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference 

with the equipment if it is operated in its installation. This equipment generates, uses, and can radiate radio-

frequency energy and, if not installed and used in accordance with the product manual, may cause harmful 

interference to radio communications.  If this equipment does cause harmful interference, the user is required to 

correct the interference.

Due to the phenomena being observed and the material properties being measured, this equipment radiates radio 

frequency energy while in active test mode. Care should be taken to make sure this radio frequency energy causes 

no harm to individuals or other nearby equipment.

Notices
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Declaration of Conformity

Megger Group Limited—Baker Instruments

4812 McMurry Ave. Suite 100

Fort Collins, CO 80525  USA

Equipment Description: Testers for Surge, DC Hi-Pot, and Winding Resistance of motors.

Equipment Model Designations: Baker AWA-IV-2, Baker AWA-IV-4,  Baker AWA-IV-6, and Baker AWA-IV-12.

Application of Council Directive 72/23/EEC on the harmonization of the laws related to Member States relating 

to electrical equipment designed for use within certain voltage limits, as amended by: Council Directive 93/68/

EEC and Council Directive 89/336/EEC on the approximation of the laws related to Member States relating to the 

electromagnetic compatibility, as amended by: Council Directive 93/68/EEC. Note: due to the phenomena being 

observed and the material properties being measured, this equipment does radiate radio frequency energy while in 

the active test mode.

Referenced Safety Standards

EN 61010-1

Referenced EMC Standards

EN 61326:2001

EN 55011 Class A

EN 61000-3-2

EN 61000-3-3

EN 61000-4-2

EN 61000-4-3

EN 61000-4-5

EN 61000-4-5

EN 61000-4-6

EN 61000-4-11I, the undersigned, hereby declare that the equipment specified above conforms to the above 

Directives and Standards.

Signature:

Printed Name: Craig Powers

Title: Quality and continuous improvement leader

Notices
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1 — Baker AWA-IV Safety and General Information

Instrument Notices

CAUTION: Be sure to comply with all safety and proper operating procedures when setting up and using the tester.  

Failure to do so can result in injury to personnel or damage to equipment.

General

The AWA-IV analyzers are equipped with open ground detection circuitry.  The open ground check feature provides 

an indication that the AC power source is not properly grounded.  The presence of an open ground warning limits 

operation of high-voltage testing.  This circuitry should not hinder operation of GFI protected AC power circuits.

Before use:

 � Make sure the analyzer’s test leads are not connected together.

 �  Make sure no printer is hooked up to the USB port.

When Used with a Baker Power Pack 

When used with a Baker Power Pack, the analyzer gets its AC power from the power pack, so if the power pack is 

unplugged, the analyzer is also off.

Before use:

 � Do not allow the analyzer’s test leads to lie anywhere near the power pack test leads.  The unit’s leads should 
coil on top of the unit or loop on the power pack handle.  Otherwise, the leads could interfere with tester 
measurements.

 �  Make sure the analyzer’s (host) ground test lead is not grounded when conducting tests using a power pack.

During use:

 � Do not switch the test leads or change the Test Select switch while a test is in progress.

 � If the power pack connection to the tester is maintained and the power pack is turned off, I/O lines are 
influenced.  This will cause problems with the analyzer’s operation.  

NOTICE: A power pack is purchased with and calibrated to the Baker DX or Baker AWA-IV tester host that it is 

shipped with.  The tester is certified to work only with that power pack.

Safety Information

If the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment 

may be impaired.

Read and follow all safety precautions and safe operating practices in your guide.  Do not exceed maximum operating 

capabilities of the Baker AWA-IV tester, power packs, or the Baker ZTX accessory.

The general safety information presented here is for both operating and service personnel.  You will find specific 

warnings and cautions throughout this manual where they apply.

If using the equipment in any manner not specified by Megger, the protection provided by the equipment may be 

impaired.

WARNING: Failure to heed the following safety precautions can result in injury or death from severe 

electrical shock.
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General Safety Warnings

 �  Do not remove the product covers or panels, or operate the tester without the covers and panels properly 
installed.  Components on the inside of the tester carry voltage for operation and can render a shock if touched.

 �  Use appropriate safety equipment required by your organization, including high-voltage gloves and eye 
protection.

 �  The devices covered in this manual are not waterproof or sealed against water entry.

 �  The devices covered in this manual are intended for indoor use.  If using outdoors, you must protect the device(s) 
from rain, snow, and other contaminants.

 �  Repair parts warning: You must replace defective, damaged or broken test leads with factory-authorized parts to 
ensure safe operation and maintain performance specifications.

 �  Ground the product: The devices covered in this manual are grounded through the power cord’s grounding 
conductor.  To avoid electrical shock, plug the power cord into a properly wired/grounded receptacle before 
connecting the product test leads.

WARNING: DANGER FROM LOSS OF GROUND.  Upon loss of the protective ground connection, all 

accessible conductive parts, including knobs and controls that may appear to be insulated, can cause an 

electric shock!

NOTICE: The ground-fault system on the Baker AWA-IV requires  a proper ground for the tester to operate properly 

in all modes.  When the Baker AWA-IV tester is used as a host to a power pack, improper grounding can also affect 

operation of the power pack

Test Related Warnings

 �  Two-party operation is recommended only when using proper equipment (such as the remote E-Stop) and when 
taking appropriate precautions so both operators are aware of all conditions at all times.  

 �  Always know what test is being performed and when.  For example, do not adjust test leads when operating a 
footswitch.  Leads will have live voltage and severe electrical shock may result.

 �  For capacitor-started motors or systems with surge arrestors/power factor capacitors, be sure to disconnect all 
capacitors from the test circuit before testing.

 �  Upon completion of any DC HiPot, Megohm, polarization index (PI), step voltage, or dielectric absorption (DA) 
tests, be sure to short the winding to ground and allow time for discharge before disconnecting the test leads.  If 
you do not do this, voltage may build up on the winding.  Some industry standards suggest allowing a winding 
to discharge four times the total amount of time that DC voltage is applied to the winding.

 �  If the tester is removed from the windings before complete discharge, short winding leads together and ground 
them using appropriate jumper cables.

 �  Disconnect the tester leads before energizing or powering up the motor.

 �  Never attempt to test a winding with both host and power pack leads attached to the winding at the same time.  
Damage to the tester will occur.

Baker AWA-IV Safety and General Information
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Equipment Stop Button

The Baker AWA-IV tester features a red Equipment Stop (E-Stop) button on the front panel of the unit.  Use it to 

quickly discontinue a test and to shut off power to the unit’s high-voltage circuitry.

The button will remain locked in position until manually retracted by rotating the E-Stop button clockwise.

Fig 1: Baker AWA-IVs showing E-Stop buttons (1).

Product Safety Category—Measurement Connection

Only Megger supplied test leads designed for this instrument provide the full safety rating.

Voltage

The rated measurement connection voltage is the maximum line to earth voltage at which it is safe to connect.

Baker AWA-IV Safety and General Information
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Safety, Hazard, and Warning Symbols on the Tester

Table 1: Safety and hazard icons on the tester’s outer case.

Icon Description

Warning about hazardous voltage and risk of injury or death from severe electrical 

shock.  Located beside each red test lead on front panel of instrument and on back of 

unit.

Frame or chassis terminal.  Located on rear panel of instrument by ground terminal.  

Connects to PPX power pack ground terminal when used with PPX.  Also used to 

connect to known good ground source when Ground Check Enable is disabled.

Protective conductor terminal.  Located beside black ground test lead on front panel of 

instrument.

The Danger notice label appears on the top of the Baker AWA-IV unit.

Baker ZTX E-stop and Remote E-stop

The Baker ZTX can be used with the Baker AWA-IV 6/12kV models.  The Baker ZTX unit and the remote E-Stop unit 

are both equipped with a red Equipment Stop button.  The Equipment Stop button is on top of the Baker ZTX unit 

and it is in the line with the status lights on the remote E-Stop accessory.  

Fig 2: Baker ZTX and remote components.

Item Description

1 Baker ZTX

2 Remote E-stop accessory

3 E-stop buttons

After being pressed, the button will remain locked in position until manually retracted by rotating the E-Stop button 

clockwise.  A warning message will appear on the Baker AWA-IV screen.

Baker AWA-IV Safety and General Information
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2 — Baker AWA-IV Instrument Overview

The Baker AWA-IV automatically performs repeatable, user-programmable tests to thoroughly assess the strength of 

a motor’s insulation and circuit.  The analyzer can be programmed to perform a specific set of insulation tests in the 

shop or office, then used as programmed in the field.  The AWA-IV is also used to assure quality of motor rebuilds or 

new production motors before they are placed into service.

The Baker AWA-IV features an intuitive, touch-screen user interface.  It delivers accurate repeatable results, 

performing a comprehensive set of both high- and low-voltage tests.  Results are presented in simple, easy-to-

understand graphs and reports that give motor maintenance professionals the information they need to minimize 

costs and unplanned downtime. 

The ability to apply identical tests to a given motor over a long period allows trends to be analyzed, revealing the 

degradation of insulation over the motor’s lifetime.  This allows maintenance professionals to predict motor failure 

and replacement planning.

The AWA-IV offers computer control and waveform monitoring. The analyzer’s embedded computer conducts the 

tests, stores the results, and continuously monitors voltage levels while testing.  If the analyzer detects a weakness in 

the insulation during a given test, the test is interrupted, the operator is alerted, and all test parameters at the time of 

the interruption are reported.

The AWA-IV’s benefits can be extended to low-impedance coils—such as armatures—through the use of the Baker 

ZTX low impedance coil accessory.  The ZTX allows the AWA-IV to apply surge tests to coils that require higher 

currents.

 � Model ranges: 2 kV, 4 kV, 6 kV, 12 kV.

 � 12 kV HO (high-output) version for performing surge tests on large motors and generators.

 � Testing capabilities: winding resistance, Megohm, PI, DA, DC step-voltage, DC hipot and surge.

 � Compatible with Baker PPX Power Packs to extend testing voltage range (6 kV, 12 kV, 12 kV HO versions only).

 � IEEE- and IEC-compliant surge test.

 � Surge waveform comparison by the patented Pulse to Pulse Error Area Ratio (PP-EAR) technique.

 � Incorporates advanced inter-turn assessment capabilities in a field portable instrument.

 � Microsoft Windows® 10 IoT Enterprise 2019 LTSC operating system.

 � USB port for data transfer and printing with Windows 10 supported printers.
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Baker AWA-IV 2 kV/4 kV Model Front Panel

All Baker AWA-IV series analyzers feature a large eight-inch touch screen with a graphical user interface.  The 

interface features a logical layout of large touch icons that improve ease of use.  Each tester’s voltage capacity is 

identified by the markings found just below the touch screen.

Fig 3: Front panel controls for AWA-IV 2 kV and 4 kV models.

Item Description

1 VGA port—used to connect the tester to a larger monitor (not included) for easier viewing of 

test results.

2 USB ports—Industry standard USB ports are accessible from the front panel for connections to 

a printing device, and data storage and retrieval devices.

3 Ethernet connector—The tester can be connected to a network via the ethernet connector.

4 E-stop equipment power shut-off—This large, highly visible red button is easily pressed on the 

front panel for equipment shut-downs.  It cuts all power to the unit swiftly and safely.

5 DC test/HiPot button.

6 Open ground light.

7 Leads energized light.

8 Test leads 1–3 select buttons.

Baker AWA-IV Instrument Overview
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Item Description

9 Voltage output control knob—Turn the knob clockwise to increase the applied voltage or 

counterclockwise to decrease the voltage.  The rate of voltage increase or decrease is set via 

the touch screen interface.  Do not force the knob; turning the knob harder does not cause 

voltage to ramp any quicker and may damage the instrument.

10 High-voltage test leads—The Baker AWA-IV uses high-voltage test leads for surge, Baker 

ZTX, and DC testing.  Three test leads (red) and a ground lead (black) are provided for motor 

test connections.  Both sides of the connection clips must be in contact with the terminal of 

the motor being measured. You must keep the leads clean and dry for best measurement 

performance.

11 Resistance leads—For the AWA-IV 2 kV and 4kV models, one red test lead and one black 

ground lead are used for low-voltage testing.

CAUTION:  The test leads have exposed metal areas.  Do not touch the leads while tests are running.  Always ensure 

that the test leads are not placed in proximity to the frame or ground potential.
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Baker AWA-IV 6 kV/12 kV Model Front Panel

Fig 4: Front panel controls for Baker AWA-IV 6 kV and 12 kV models.

Item Description

1 VGA port—used to connect the tester to a larger monitor (not included) for easier viewing of 

test results.

2 AUX/Power Pack connector.

3 USB ports—Industry standard USB ports are accessible from the front panel for connections to 

a printing device, and data storage and retrieval devices.

4 Reset button.

5 Ethernet connector—The tester can be connected to a network via the ethernet connector.

6 Reset button.

7 E-stop equipment power shut-off—This large, highly visible red button is easily pressed on the 

front panel for equipment shut-downs.  It cuts all power to the unit swiftly and safely.

8 Open ground light.

9 Voltage output control knob—Turn the knob clockwise to increase the applied voltage or 

counterclockwise to decrease the voltage.  The rate of voltage increase or decrease is set via 

the touch screen interface.  Do not force the knob; turning the knob harder does not cause 

voltage to ramp any quicker and may damage the instrument.

10 Leads energized light.

11 DC test/HiPot button.

Baker AWA-IV Instrument Overview
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Item Description

12 Test leads 1–3 select buttons.

13 High-voltage test lead, black, ground.

14 High-voltage test leads—The Baker AWA-IV uses high-voltage test leads for surge, Baker 

ZTX, and DC testing.  Three test leads (red) and a ground lead (black) are provided for motor 

test connections.  Both sides of the connection clips must be in contact with the terminal of 

the motor being measured.  You must keep the leads clean and dry for best measurement 

performance.

15 Resistance leads—For the 12 kV models, three test leads with no ground lead are used for 

low-voltage testing. The clips and cord color can vary depending on the design.  AWAIV 6 kV 

models do not have this set of leads.

CAUTION:  The test leads have exposed metal areas.  Do not touch the leads while tests are running.  Always ensure 

that the test leads are not placed in proximity to the frame or ground potential.

Baker AWA-IV 6 kV Model Distinctions

The AWA-IV 6 KV model differs from the AWA-IV 12 kV with respect to test leads and procedures for use. 

The AWA-IV 6 kV analyzer uses only one set of leads for both high- and low-voltage testing; it  does not include a 

separate set of low-voltage resistance test leads.

The clips are currently rated for 48 volts.  Ensure that the clips are not placed in proximity to the frame or other 

ground potential. 

Fig 5: AWA-IV 6 kV; high voltage leads only.

Baker AWA-IV Instrument Overview

www.megger.com 9



Setting Up the Baker AWA-IV Tester

Selecting an Optimal Environment

 � The Baker AWA-IV requires adequate ventilation.  Place the analyzer where air can freely circulate around it.  

 � Avoid locations in direct sun or near heat sources.  

 � Do not stack objects on or near the analyzer.  

 � To prevent shock hazard, do not expose the analyzer to rain, snow, or moisture.  

 � Avoid locations with high levels of dirt or dust.

Making Basic Connections and Starting the Analyzer

1. Place the Baker AWA-IV on a large table or bench.  Check the power switch and ensure it is in the Off position.  

2. Plug one end of the power cable into the line connector on the left side of the analyzer and plug the other end 
into a grounded wall socket.  The analyzer will operate between 85–264 VAC 50/60Hz.

3. Locate the keyboard/mouse USB unit.  Plug the unit into one of the USB ports.  

4. If an external storage device will be used, plug it into one of the USB ports.  

5. Turn the power switch to the On position.  

6. As the analyzer powers up, various BIOS messages will appear on the screen.  

7. The analyzer will automatically log in to the software with the associated serial number information.  

NOTE: An administrator can change this to log into the Windows desktop; however, we recommend that you do 

not change it. If passwords are changed and the instrument is returned for service without the passwords, the 

instruments hard drive will be reformatted and all user-saved data may be lost. 

Connecting Test Leads to a Motor for Testing

How test leads are connected to the motor you want to test will vary depending on the specific AWA-IV model you 

will be using and the type of test you will be conducting.  For example, the AWA-IV 12 kV model has a separate set 

of low-voltage test leads used during resistance testing, while the AWA-IV 6 kV model has only the high-voltage test 

leads, which are used for all testing functions.

In most applications, test lead 1 is connected to phase A of the motor under test, lead 2 to phase B, and lead 3 to 

phase C.  In single phase or two-lead applications, only one red lead (typically lead 1) would be used while the other 

two leads are left disconnected.

Ensure that you understand how leads should be connected for your application.

NOTE: AWA test leads use Kelvin (4-wire) resistance measurement that uses an active current source, reduces the 

effect of lead resistance, and gives an accurate resistance measurement.  Each side of a lead clip contributes to the 

measurement process; one is the supply and the other reads back to the tester.  For this reason, it is important to 

ensure that both parts of the lead clips are seated well when testing. 

CAUTION: Ensure that you understand how leads should be connected for your application before energizing the 

tester.  Ensure that all safety precautions are taken to keep yourself and others safe, and to ensure proper equipment 

operation, and to avoid damaging the equipment or the unit under test.
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The following image provides an example of a typical connection to a 3-phsae motor.  

Best practices:

 � Label phase A, B, and C leads on the motor.

 � Leads 1, 2, and 3 are labeled on the cables near the connectors.

 � Ensure sufficient spacing between connected leads.

 � Safely store excess wiring to avoid tripping hazards.

 

Fig 6: AWA-IV three-phase motor connection. 

Item Description

1 AWA test lead 1 to phase A on motor.

2 AWA test lead 2 to phase B on motor.

3 AWA test lead 3 to phase C on motor.

4 Black lead to ground.

Baker AWA-IV Instrument Overview
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The following image provides an example of a typical connection to a single-phase motor.  

Best practices:

 � Label leads being tested on the motor.

 � Leads 1, 2, and 3 are labeled on the cables near the connectors.

 � Ensure sufficient spacing between connected leads.

 � Safely store excess wiring to avoid tripping hazards.

 

Fig 7: AWA-IV single-phase motor connection example; connection to a field coil on a DC motor. 

Item Description

1 AWA test lead 1 to lead 1 on motor; FC 1 in this example.

2 AWA test lead 2 to lead 2 on motor; FC 2 in this example.

3 AWA test lead 3 to ground.

4 Black lead to ground.

Configuring a Printer

The Baker AWA-IV comes with a set of printer drivers installed.  More printer drivers may be added if necessary.  

Connect the analyzer to the printer then run the configuration process via the Windows Control Panel application.  

Ensure that the proper printer driver is selected during the configuration process.  

Using the Footswitch

On the rear of the analyzer, a connector is available to plug in a footswitch to operate the analyzer for armature span 

testing.  The footswitch allows you to continue testing the entire armature easily and quickly.

The footswitch option is not available for AWA-IV 6kV or 12kV models.

Baker AWA-IV Instrument Overview
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3 — Database Management and Maintenance

Database Management

Database management is a vital component of a good predictive maintenance testing program.  Developing best 

practices for collecting meaningful data, organizing the data collected, and ensuring that users can easily access data 

contributes to optimal database management.

To support this effort, the software features database management tools that facilitate data organization.  Identifiers 

help clarify the location of specific motors, and allowing the use of multiple databases supports any organization of 

data storage.   

Consequences of Not Organizing Data

Because the Baker AWA-IV can be configured to store every test it performs, we recommend that you establish a 

structure that everyone performing tests will follow.  

Consider the following example.  A maintenance program is established to test motors at seven production plants, 

each in a remote location.  Each plant has nearly 1000 motors that need periodic testing.  All works well for several 

months until a motor that was previously tested fails.  

The maintenance manager wants to see all the test data.  When the project supervisor looks at the data, he finds 

nearly 7000 tests—all in one large database, and in a random order.  The manager spends a lot of time looking 

for the last test performed, but eventually gives up.  Upon investigation, the manager finds that each of the 

technicians using the equipment had entered data based on what made sense to them at the time.  Because of the 

disorganization, important test data has been lost, or at best is difficult to locate.  

The analyzer’s database structure is designed to facilitate data organization and to be flexible enough to allow you 

to uniquely plan for specific needs.  The Motor ID, three location fields, and multi-database support are tools that 

you can use to organize data to promote data collection and storage best practices, and ensure that valuable data is 

properly stored and easily retrieved.

Starting the Software 

To start the analyzer, locate and double-click the Baker AWA-IV icon on the Windows desktop.  The software will start 

and present a window with two options: Create a new database, or Open an existing database.

Fig 8: Opening software from the desktop.
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Creating a New Database

There are three ways to create a new database:  

1. Click on the Create a New Database radio button in the opening window.  Type the name of the database and 

click Save.

2. If the software is already running, you can create a new database by clicking on New from the File menu.

3. Alternatively, you can click on the New database icon in the toolbar.  

Whichever method you choose, the same Create New Database window will appear.  

Fig 9: Creating a new database.

4. The AWAData40 folder is the default folder.  Navigate to another folder if you prefer and enter the name of the 
new database in the box next to the file name.

5. Save as type will always be AWA/MTA Database(*.mdb).

6. Click on the Save button.  A database will be created and opened that has one default motor and the default 
Test IDs.  At this point, begin entering new motors using the Data tab Nameplate view.

Database Management and Maintenance
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Opening an Existing Database

There are three ways to open an existing database: 

1. Click on the Open an existing database radio button upon entering the software.

2. To open a database after the software is running, click on the Open option under the File menu.

3. Alternatively, click on the Open database icon in the toolbar.  

Fig 10: Selecting an existing database.

4. A Select Baker AWA-IV Database window appears to help you locate and select the desired database.  It will 
default to the folder that has been selected in View-Options-File Locations menu item.  

5. Select a database (.mdb) then click the Open button, or double-click on the desired database.

Database Management and Maintenance
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Using Multiple Databases

The analyzer software supports the use of multiple databases.  This feature gives you options for storing your test 

data.  For example, you can split data between different databases, or you can direct different locations to store data 

locally while using a central location for archiving and backup storage.  You can also group motors using the most 

beneficial strategy that suits your organization and its needs.  Consider a few examples.

 � A motor shop might want to use different databases for each customer.  

 � A preventive maintenance department could use a different database for each building in a given site.  

 � A larger organization might require that data is kept in a centrally-located database on a network and have local 
databases on each analyzer, which then update the main database.  

Fig 11: Opening an existing database.

NOTICE: It is important to establish best practices for database organization early, and to maintain adherence to your 

practices to avoid loss of data or data duplication.  Manipulation of the database may be useful for management 

and auditing purposes, but you should proceed with caution.  Do not delete records associated with Motor IDs.  

Always back up a database before deleting records or manipulating the database in any way.
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Data Transfer Feature

The data transfer feature offers a way to transfer motor and test information from one database (source) to a second 

database (destination).  The transferred information is not deleted from the source database, but rather copied to 

the destination database.  Data transfer can be used to combine two existing databases into one centrally located 

database.  It can also be used to re-organize existing databases into more convenient groupings.  When motor data 

or Test IDs need to be moved, the data transfer feature provides this functionality.  

Transferring Motor and Test Results Data

Two databases need to be open to transfer motor information, test results data, and Test IDs: a source database and 

a destination database.  Both databases must exist before beginning the transfer.  If the transfer will be to a new 

destination database, it will need to be created before beginning the data transfer.  

1. To create a new database, select the File  New menu item or click on the New icon in the toolbar.

2. To start the data transfer feature, click on Database in the main menu then Data Transfer, or click on the Data 
Transfer icon in the toolbar.  

Fig 12: Data transfer buttons.
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3. The software will open a Source window and will default to the folder in which the currently open database 
resides.  For example, in the graphic below the example database is open in the main program; so when the Data 
Transfer button is clicked, the Source window defaults to the AWAData40 folder with the Example.mdb for 
the file name.  Pick the default database or choose another database to transfer data from as needed.  

Fig 13: Select source Baker AWA-IV database 

4. After selecting the source database, click the Open button.  The Data Transfer window appears with the source 
database opened on the left side.  This is the same Motor ID tree structure as used elsewhere in the software.  

Fig 14: Data transfer source selection.

5. Click on the destination database Browse button to locate the destination database.  A Destination File Open 
dialog box appears and will default to the same folder used to open the source database.  

6. Choose a destination database to open then click on the Open button.  The Data Transfer window returns with 
both databases open.

Database Management and Maintenance
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Fig 15:     Data Transfer destination database section.

7. If either database is not the one you need, click on the Browse button next to the database you want to change, 
then locate and select the database needed.

8. When the proper source and destination databases have been opened, the Add All and Add buttons are 
enabled.  

9. Highlight the data you want to transfer then click the Add button to move the data to the Transfer List.  
Alternatively, you can double-click on a motor and it will automatically be added.

10. If you want to add all data, click on the Add All button.

11. The Transfer List displays all motors that will be transferred when you click the Transfer button.  If the Transfer 
List includes motors that do not need to be transferred, remove them by selecting the motor(s) and clicking the 
Remove button.  

12. When the Transfer List is finalized, click the Transfer button.  The software runs through the Transfer List 
adding the motor (nameplate) information if the motor does not exist in the destination database.  If the motor 
does exist, no motor information will be added unless you check the Update the nameplate box.  

13. If this box is checked, all nameplate data will be transferred during the process, overwriting any existing 
information currently stored in the destination database. 

14. Similarly, the Update Test IDs check box allows you to update (overwrite) and Test ID data for existing motors in 
the destination database with those associated with the motor test results selected for transfer.

15. As the test results are transferred, any TestID that is used will be remembered for the end step.  At that end step, 
all such referenced TestIDs (for any transferred test results) will be transferred across.

16. The software adds test records that do not exist in the destination database.  It compares the time/date stamps 
with existing test result records; if the source time/date equals a test result record in the destination database, it 
does not transfer the record.  If the software does not find a matching time/date, it adds the source test result 
record to the destination database.

17. The software creates a log during the data transfer process.  Information logged includes source/destination 
database names, Motors IDs added, the number of records updated, and Test ID data updates (if update Test 
IDs box is checked).  If the transfer encounters problems, it logs the Motors ID and reason the transfer failed.  
You can print this log by clicking on the Print Log button.  
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Transferring Test IDs

Test IDs can be transferred separately from Motor IDs.  

1. To transfer Test IDs, you will follow essentially the same process described in the “Transferring motor and test 

result data” section above.  The source and destination databases must be open before a transfer can be 

performed.  When both databases are open, the Transfer Test IDs button will be enabled.  Click on this button 

to open the Transfer Test IDs window.

Fig 16: Transfer test IDs.

2. The window displays all Test IDs in the source database, along with the Test IDs currently found in the destination 
database.  Choose the source Test IDs to transfer by highlighting them.  To select multiple IDs, use the Shift and 
Ctrl keys on your keyboard while clicking on the Test IDs.  

3. With the desired Test IDs highlighted, click on the Transfer button to start the transfer.  

4. The software will transfer (copy) the requested Test IDs to the destination database.  If a Test ID exists in the 
destination database, it will overwritten with the parameters assigned to the selected TestID.  

5. As in the motor and test result record transfer, the application writes to the Transfer Log, recording what action 
has been taken.  When finished transferring Test IDs, click on the Close button to return to the Data Transfer 
window.
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Archiving a Database 

The Archive feature provides another tool to help you move data.  The tool helps you back up and move whole 

databases from one computer to another.  In comparison, the Data Transfer tool moves motor/test information from 

one database to another.  

NOTICE: It is important to retain a current backup copy of database(s) on some persistent storage medium such as 

an external hard drive, flash drive, or a backed up network drive.

Fig 17: Archive.

The archive feature provides an easy means to back up Baker AWA-IV data.  The feature is also the best way to move 

a database to another storage device or computer.  If the archive option is used to copy a database, use the Restore 

option (discussed in the next section) to extract the database from the storage device back to the source.

To archive a database, it must be opened in the software.

1. Click on Database in the main menu then Archive.  

2. The New Archive window appears showing the default folder.  The Save in folder defaults to the path specified 
via the View menu  Options  File Locations.

3. Accept the default or browse to the folder where the archived file should be stored.  

Fig 18: New archive.
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The default name of the archived (bak) file will be a combination of the database name and the time/date of the 

archive.  For example, if the database name is Example.mdb then the archived file name will be Example_
YYYYMMDDHHMMSS.bak.  The date/time format is YYYYMMDDHHMMSS and indicates the year/month/day/hour/

minute/second when the file was archived.  

When the archive is finished, a message similar to the following will be displayed:  

Fig 19: Archive complete.

NOTICE: Ensure that you make note of the location of the archived file (.bak).

4. Click on the OK button to finish the archive process.

Restoring a Database

NOTE: In the past, archives were created for storage devices with lower capacity, so compression was used to 

minimize the space needed for storage.  File formats such as .cab and .zip were common.  Support has been 

maintained for .zip and .cab files if an older archive using these formats needs to be restored.  For such restorations, 

WinZIP will need to be installed on the system.

To view archived data with the software, the database must be restored first.     

1. Click on Database then Restore.  

Fig 20: Restore  database menu item.
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2. The Archive File window appears.  Select the database  file that you want to restore and open it.  

Fig 21: Data transfer buttons.

3. After choosing the archived database to restore, choose the folder to which the archived database will be 
extracted.  If the database is to be restored to a different folder, relocate to that folder.  When the appropriate 
folder is located, click the OK button.

Fig 22: Locate the proper folder needed.
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The software will extract the archived file.  If a database with the same name exists the user will be prompted with 

the following.  

Fig 23: Confirm file overwrite.

4. Overwrite the existing database by clicking on Yes or Yes to All.  

5. Click Cancel if the database should not be overwritten.  If the archived database is still needed, rename the 
existing database through Windows Explorer then restore again, or restore using another folder that does not 
contain the same named database.  

6. After the archived database is extracted, the software will return to the main screen.  Click on File  Open to 
open the newly-restored database.
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4 — Baker AWA-IV Software Overview

The Baker AWA-IV software automatically performs pre-configured tests on pre-configured motors.  Pre-configured 

tests are identified by Test IDs.  Pre-configured motors are identified by Motor IDs.  

Motor IDs are stored in the Baker AWA-IV’s database along with the Test ID to be used when testing that motor.  

Additional information about the motor such as manufacturer, serial number, horsepower rating, frame size, speed, 

operating voltage, and current are also stored in the Motor ID.  New motors can be entered into the database or 

existing motors can be edited, corrected, or updated.

The Test ID consists of all test parameters to be used when performing tests on a motor.  Details such as test-voltages, 

pass or fail criteria, and test times are contained in a Test ID.  You name and define Test IDs.  

The software includes predefined Test IDs for several different machines.  Usually, the most important parts of a Test 

ID are the test voltages.  Therefore, a Test ID is often named after the operating voltage of the motor.  Several motors 

can share a single Test ID.  For example, all 480-volt motors can use the same Test ID.  

Starting the Software 

To start the Baker AWA-IV, locate and double click the Baker AWA-IV icon on the Windows desktop.  The Baker 

AWA-IV software will start and present a window with two options: create a new database or open an existing 

database.  

Fig 24: Opening software from the desktop.
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Creating a New Database

There are three ways to create a new database: click on the radio button upon entering the software, click on File  

New while using the software, or click on the New Database icon while using the software. 

To create a new database when starting the software, click on the Create a New Database radio button.  Type the 

name of the database and click Save.

If the software is already running, you can create a new database by clicking on New from the File menu, or the 

New Database icon on the toolbar.  

Whichever method you choose, the same Create New Database window will appear.  

Fig 25: Creating a new database.

The Save as type folder is the default folder.  Navigate to another folder if you prefer and enter the name of the 

new database in the box next to the file name.

Click on the Save button.  A database will be created and opened that has one default motor and the default Test 

IDs.  At this point begin entering new motors using the Data tab Nameplate view.
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Opening an Existing Database

There are three ways to open an existing database: click on the Open an existing database radio button upon 

entering the software, click on File  Open while using the software, or click on the Open Database icon while 

using the software. 

A Select Baker AWA-IV Database window appears to help you locate and select the desired database.  It will default 

to the folder that has been selected in View  Options  File Locations menu item.  

Select a database (.mdb) then click the Open button or double click on the desired database.

Fig 26: Selecting an existing database.
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Using Version 4 Software for the First Time

The first time the Baker AWA-IV software is used, the Enter Test Equipment Information window will appear.  Select 

the tester type, serial number (found on a sticker on back of unit), and customer’s tester ID (can be an asset ID).   If 

the software is being installed on a desktop computer, all other fields will be gray.  

This information will be used to track each data record and to identify which Baker AWA-IV analyzer acquired the 

given record.  The tester information is usually entered at the manufacturer before the Baker AWA-IV is shipped.

  

Fig 27: Enter Test Equipment Information window.

NOTE:  Test results from a converted database (databases from a pre-4.0 version) will not have this information.  

Converted records will contain the type of Baker AWA-IV converted.  Subsequent test results will be stamped with 

machine information, which can be examined in the Application view at the bottom of the pane.

Baker AWA-IV Software Overview

28 Baker AWA-IV 71-015 EN V16 User Guide       www.megger.com



Main Window 

After selecting or creating a database, the Baker AWA-IV software Main window appears.

Fig 28: Selected database.

To view test results for a given motor or to perform a test on a motor, select the desired motor from the database.  

The Baker AWA-IV software Main window is split into two panes.  The left pane contains three different tabs—

Explore, Motor ID, and Route—that facilitate browsing through the motors in the database.  The right pane 

contains three more tabs—Data, Tests, and Trending—that help you view test data, performance of set tests, and 

trending mechanisms.
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The Main window includes several tools that help you navigate the user interface and access the software features 

and functions.  The tools include the Main menu, the Toolbar, and the Tabs mentioned above.

Fig 29: Main window tools.

Item Description

1 Main menu

2 Toolbar

3 Flyout tool tip

4 Tabs

Main Menu

The Main menu contains six menus that provide access to features and functions organized by the categories implied 

by the menu labels.  Each menu is described in the following sections.

File Menu

Clicking on the File menu drops down a list of items that help you choose the database(s) that you want to use 

during your session.  Databases that are open are listed just above the Exit item.  

Clicking on Exit closes the application.

The Print menu item provides access to printing features by opening the Report Generator.

Fig 30: File menu.
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View Menu

The View menu allows you to specify whether the Toolbar and Status Bar will be displayed in your view of the user 

interface.  A check mark next to an item indicates that the feature will be displayed.

The Options item drops down a sub-menu that provides access to additional features.

Clicking on the File Locations item opens a dialog box that helps you identify where specific file types used by the 

system are stored.  You can also use this dialog box to modify locations if needed.

Clicking on the Changable Labels item opens a dialog box so you can rename the motor location fields. Label one 

default is “Location,” label two default is “Building.”  

Clicking on the Enable Voltage Class item toggles the setting that requires the use of voltage classes.  When this 

feature is enabled, a check appears next to the item.  When voltage classes are enabled, you will be required to have 

a voltage class assigned to a new Motor ID.  Enabling voltage class restricts the Test IDs available to a motor to the 

Test IDs associated with the voltage class, ensuring that Test IDs using higher voltages cannot be assigned to the 

motor.

Clicking on the Allow Duplicate Motor ID’s item allows the system to create motor IDs that are identical.   For 

example, if you have two identical motors that both drive cooling fans, you might want to give them the same Motor 

ID.  Notes within the Motor ID, or the placement of the Motor ID in the “building” and “location” folders can be 

used to uniquely identify each motor.

Fig 31: View menu.
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Database Menu

The Database menu provides access to functions used to maintain and manipulate database files.  The data transfer, 

archive, and restore features are described in the “Database Management and Maintenance” chapter.

Clicking on Locate on Disk opens a window that shows you the current location of the database file you are 

currently using.

Clicking on Load Text File opens a window to help you select a text file to view within the system.

Fig 32: Database menu.

Window Menu

The Window menu provides you with functions for selecting which database to use (if several are open) along with 

options for displaying windows within your screen.

Fig 33: Window menu.
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Tools Menu

The Tools menu provides access to other basic tools including WordPad, MS Paint, and a web archive file viewer. 

The Baker AWA-IV generates reports in a mhtml format (optionally); these files can be viewed using the web archive 

file viewer.  WordPad can be used to view files output in MS Word format, and the MS Paint program is handy for 

annotating screen captures.

Fig 34: Tools menu.

Capturing Screens

You can capture screens as needed if you would like to include specific views in reports and other offline applications.  

The system uses standard hotkeys for capturing screens, and includes MS Paint for processing and modifying captures 

as needed.

Scroll down to the tool tray to open MS Paint.

Use the following hotkeys during the screen capture process:

 � Print Screen captures whole screen.

 � CTRL+ALT+Print Screen captures the focus window.

 � CTRL+ V pastes the captured screen in MS Paint.
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Help Menu

The Help menu provides information about the software version and the tester.  It also provides access to the current 

user manual, which is available online.

Fig 35: Help menu.

Clicking on Tester Info opens a small window like the one shown below.

Fig 36: Tester Information Viewer at startup.

This window is typically used to change the language being used in the application, and to enable other program 

features such as debug modes and allowing data transfers to overwrite nameplate information.  

NOTICE: Only knowledgeable users or administrators should make changes here.
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When the Edit button is clicked, followed by clicking on Cancel in the Password dialog box, The Tester Information 

Viewer allows access to a few basic parameters such as changing the language and enabling debug elements in 

testing.  Any user can access these parameters using this method.

Fig 37: Tester Information Viewer providing limited parameter access for users.
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When the Test parameter setup default password is entered, and the Edit button is clicked, the Test Information 

Viewer appears as shown in the example below.

Make the necessary adjustments then click on Save Changes.

Fig 38: Tester Information Viewer after entering default password.

NOTICE:  Some information shown in the viewer is available only to authorized Megger Service personnel and 

cannot be changed by the user or client administrator.

Overriding the Open Ground Interlock

If you need to disable the ground check feature (overrides the “open ground” interlock that disables the high voltage 

power supply during testing if a faulty ground is detected), follows these steps:  

1. In Tester Information Viewer, click on the Edit button then log in using the Test parameter setup default 

password.

2. Uncheck the Ground Check Enable box.  

3. Click on Save Changes.

4. Ensure that a proper ground is made to the unit by connecting a cable between the Earth ground connector on 
the back of the AWA tester to a known good ground source in the vicinity of the motor being tested. 
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Toolbar

The Toolbar contains several icons that provide shortcut access to several features that can also be accessed from 

the Main menu.  From left to right the icons (and their features) include New, Open, Print, Transfer Motors, and 

About.

Hovering the mouse cursor over an icon provides you with flyout tool tips that identify the icon.

The Toolbar also identifies the current motor displayed in the user interface along with the number of test records 

currently stored in the database for the selected device/motor. 

Fig 39: Toolbar.

Item Description

1 Icons

2 Flyout tool tip

3 Motor displayed

4 Indicates number of test records stored in database for selected device.
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Tabs

The left side of the Main window is used to navigate through the motors within the opened database.  Three tabs 

help you locate and select motors for testing.  

The Explore tab displays the motor locations in a three-level view called the Motor Tree.  

The Motor ID tab gives you an alphabetical list of Motor IDs.  You can type the first few characters of the Motor ID 

into the blank field above the list to locate a specific motor.  

The Route tab provides predefined lists of motors used to locate a subject motor.  The Route tab is similar to a route 

often used in the predictive maintenance business.  

Explore Tab

The Explore tab uses a tree structure to help you locate and select a particular Motor ID.  The two upper levels of the 

tree correspond to the location and building in which the physical motor is housed.  

Fig 40: Explore tab.

Location and Building are the default tree labels, but these labels can be changed to suit your situation and best 

practices.  

The lowest level is the Motor ID.  In the example above, the selected Motor ID is BD#3.  The motor is physically 

located at the North Platte plant, Barrier Dam.  By clicking on Motor ID, a motor and its associated data is loaded 

from the database into the related tab fields on the right side of the window.  It becomes the current motor.  Expand 

a motor location by clicking on the plus sign or contract a location by clicking on the minus sign.
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Motor ID Tab

The Motor ID tab alphabetically lists all motors currently stored in the database.  When you double-click on a motor 

in the list, the list item is highlighted and the Motor ID appears in the field found just above the list.  The motor’s 

information is also loaded into the Main Display Area to the right.

Fig 41: Motor ID tab.

Locate a Motor ID two ways within this tab: using the Motor ID search field at the top of the list, or scrolling through 

the list until you spot the motor you need.

To use the Motor ID search field, type the Motor ID needed into the field found just above the list.  The list will 

automatically scroll to the nearest Motor ID that begins with those characters and will automatically update as you 

enter more characters.  For example, if the letters Cmp are typed, the Cmprsr32-45A Motor ID would be highlighted.  

Whichever method you choose, when you find the Motor ID you are looking for, double click on that Motor ID.  

Ensure that the Motor ID you want is highlighted and appears in the field just above the list.  Using either method, 

the Motor ID will become the currently selected motor and its information will appear in the Main Display Area.  
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Route Tab

The Route tab allows you build lists of Motor IDs for routing purposes.  

Fig 42: Route tab.

As the example above shows, the “Spring Outage” list is selected.  This list has four motors associated with it.  Using 

such lists eliminates the need to search the entire database for these four motors to be tested during the spring 

outage.

This tab also allows editing and printing of these routes.  Click on the Edit Route button to open the Route Editor 

dialog box, which allows you to add, rename, and delete routes.  You can also add, remove, and change the Motor 

ID list order.  
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Fig 43: Route Editor.

Adding a Route

1. To add a new route, click on the Add button at the top of the window.  The Routes field will be blank so you 

can enter a new Route ID.  After entering the new ID, start adding Motor IDs from the Available Motors list on 

the right to the Route Motors list on the left.  

2. To add a motor, select the Motor ID on the right and click on the <<Add button.  The Motor ID will be moved 
from the Available Motors list to the Route Motors list.  Continue adding motors as needed.  Use CTRL or 
Shift keys on the keyboard to select multiple motors.

3. When you have finished, click on the Save button at the top of the window.  Click Close when you have finished 
creating the new route.

Renaming a Route

1. Select the route you want to rename from the Route List and click Edit Route.  

2. In the Route Editor dialog, click on the Rename button.  

3. The Route ID will be highlighted.  Edit the ID as needed then click the Save button.  Click Close to return to the 
Route tab.

Deleting a Route

1. Select the Route ID you want to delete from the Routes list.  Click Edit Route then in the Route Editor ensure 

that the correct route is selected.

2. Click on the Delete button.  A confirmation dialog appears to ensure that you are deleting the correct route.  

NOTE: Deleting a route does not delete the Motor IDs from the database.
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Editing Motor IDs on an Existing Route

1. Use the Route ID combo box to select the route you want to edit.  

2. The Motor IDs associated with that route will appear in the Route Motors list.  

3. Motor IDs not included in the route will appear in the Available Motors list.  

4. To add Motor IDs, select the Motor IDs that you want to add from the Available Motors list then click on the 
<<Add button.  Select one motor at a time, or use the control/shift keys to select a group of Motor IDs.  

5. To remove unwanted Motor IDs from the route, select the Motor IDs from the Route Motors list then click 
on the Remove>> button.  The Motor IDs will be removed from the Route Motor list and returned to the 
Available Motors list.  

6. To change the order of the Motor IDs in the Route Motors list, select the motor or group of motors to move and 
click on the Move Up or Move Down buttons found just below the list.

7. When you have finished editing a route, click on the Save List button to save your changes.

8. Click on Close to return to the Route tab in the Main window.
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Modifying List Elements Displayed in the Motor ID and Route Tabs

The information presented in the motor lists within the Motor ID and Route tabs can be customized by a qualified 

system administrator modifying the AWA.INI file.

In the following example, the Route tab list shows that the modification includes listing the Plant name, Building 

(BLDG/Unit), and the Motor ID.  Using the scroll bar at the bottom of the list shows all the information presented and 

formatted as defined by the AWA.INI file modification.

The same or different elements can be displayed in defined formats within the Motor ID tab as well, depending on 

how the parameter settings are defined.

Fig 44: Right pane of Main window features Data, Tests, and Trending tabs.

NOTICE: Only a qualified system administrator should make changes to the AWA.INI file.  Errors in formatting or 

syntax, accidental deletions or omissions, or other mistakes can cause improper software behavior.   

 

Best practices are recommended, including backing up original AWA.INI files to provide a reset point if needed.  For 

more information on this process, refer to the AWA Database Tool Administrator Guide.
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Viewing Test Data

The right pane of the software has three tabs at the top of the window—Data, Tests, and Trending.  Respectively, 

these tabs help you view results data for a variety of tests; confirm whether a test has been selected to run, configure 

or execute tests, and display trending graphs that chart acquired data over time. 

Fig 45: Right pane of Main window features Data, Tests, and Trending tabs.
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Using the Data Tab

The Data tab contains two sections, one above the other.  The top section shows the date and time for the test result 

data, and whether the motor passed the specific test.  By clicking on a date/time, you can view test result data for 

that specific date within the Application, Surge, PI, or Step/Ramp-Voltage tabs in the lower section.  The view in 

the lower section changes depending on which bottom tab is selected.  

Fig 46: Data tab sections.

Item Description

1 Top section shows basic test information: Test ID, date/time, test pass/fail.

2 Bottom (main) section shows data related to the bottom tabs (views) selected.
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Motor Location Fields

The first two fields in the bottom section of the Data tab are used to help locate a motor within the database.  These 

fields have the default field names “Location” and “Building.”  If these are not the best labels for your situation or 

environment, you can change them.  

To change location labels, click on View  Options  Changable Labels.

Consider the example that a motor maintenance program has several plants.  The labels of the location fields 

could be renamed to something like “Plant” and “Unit.”  The location data is used with the Motor ID to create the 

nameplate record and to make up the tree structure of the Explore tab.  

In the example Explore tab shown in the next section, motors have been organized by location in Plants and Units: 

North Platte and South Branch are Plants and Unit 23, Unit45A, Unit 17C are all units.  

Fig 47: Changeable labels.

Some organizations use three fields to describe motor locations; some refer to them as functional locations.  For 

these users, a third location field is made available by assigning a label name to the field, which will then appear 

within the Data tab main display area just below labels 1 and 2.  

Additionally, a custom string field can be added by assigning a label name to provide supporting information about 

the motor.  This information is not related to the location or the general Description field provided at the bottom of 

the display area.

Motor ID Field

The records stored by the Baker AWA-IV are hierarchically linked to each other.  The Motor ID field serves as the 

primary key for linking associated records.  The Motor ID is the primary means of locating and interacting with 

a motor’s data.  Therefore, it is important to develop a naming scheme that will facilitate locating and retrieving 

information.  

Consider the common case in which a plant has duplicate processes, with identically named motors in each process.  

This can cause confusion, because the motors have the same Motor ID, but are in different locations.  Take steps at 

the start to ensure that Motor IDs are unique.

For example, if two identical intake pumps are present in duplicate processes, database management will be easier if 

these two motors can be uniquely identified.  One way to solve this problem is to include the process ID in the motor 

ID.  For example, the motor ID for process 1 could be “Intake Pump P1” and the Motor ID for process 2 could be 

“Intake Pump P2.”
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Data Tab—Nameplate View

The Nameplate view contains the nameplate data for each motor in the database.  The software uses the first field, 

Motor ID, to uniquely identify the motor.  Values must be entered in the Motor ID field and the two motor location 

fields.  

The labels for the location fields are user definable.  In the example below, the labels are Plant and Unit.  The default 

values are Location and Building.  If  you need to change the field labels, click on View  Options  Changable 

Labels.  

The location and Motor ID fields are required because they are used in the Explore tab to help locate motors.  If  the 

enable voltage class feature is used, the Volts Oper (operating voltage) field is also required.  Ensure that the proper 

Winding Config radio button is selected for your motor.  This parameter is used elsewhere in the system.  All other 

fields in the Nameplate view are optional.  

NOTE: Many customers have found that filling in all nameplate fields greatly helps with preventive maintenance 

programs by providing one place where their plant’s motor data is kept.  Additionally, motor shop customers often 

discover that recording complete nameplate information is required when working with their customers’ motors.  

The information can also help with troubleshooting and support.

Fig 48: Data tab, nameplate view.

The Nameplate view is also used to add new motors, update existing motors, and delete unneeded motors from the 

database.   
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Adding a New Motor

1. Click on the Add button.  The Motor ID and SN (serial number) fields will be blanked out.   

NOTICE:  You must click on the Add button first when adding a new Motor ID.  Making changes to the existing 

Motor ID removes the Add button and enables Save.  Clicking on Save after making changes will modify the 

information for the existing Motor ID, and will replace the original Motor ID with the new Motor ID name.  All 

associated nameplate and test information collected on the original Motor ID will be reassigned to the new Motor ID 

name.

2. If needed, click on the Clear button to clear all fields.

3. The Location fields (Plant and Unit in this example) and Motor ID are required.  Values entered cannot begin with 
a space.  If more than one location exists, click on the down arrow of the location boxes.  You can enter a new 
Plant location simply by typing the new name in the field.   

Fig 49: Adding a new motor ID.  Required fields appear in blue in this example.

4. If voltage class restriction is enabled (View  Options  Enable Voltage Class is checked), entering a value 
in the Volts Oper field will also be required.  Entering information in other fields is highly recommended for 
tracking and other purposes, but is not required.  When you have finished entering your values, click on the Save 
button.  

5. Enter the Test ID to be used when testing the new motor.  (Refer to “Creating a Test ID” for more information on 
this topic if needed.)

NOTE: Clicking the Reset button will re-display the previous motor and nothing will be added.

Updating an Existing Motor’s Nameplate Information

1. Select the desired Motor ID then move the cursor to the field(s) you need to update and make your changes.  The 

Save button will be enabled as soon as changes are started.   

2. When finished, click on the Save button and your changes will be committed to the database.  If the changes are 
not needed, click on the Reset button.  All fields will be reset and no changes will be committed to the database.

Deleting an Existing Motor from the Database

1. Select the desired Motor ID then click on the Del (delete) button.  

2. A dialog box appears to confirm that you want to delete the selected Motor ID, and all of its test results.  If you 
are sure that you want to delete the Motor ID, click Yes.  The motor and all of its test results will be deleted.   
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Data Tab—Application View

The Application view provides a place to enter data about a particular test.  Information such as who did the test, 

who the test was done for, which MCC the test was performed from, and a general memo can all be entered in 

their respective fields when the test is conducted or at a later date.  The general memo field is a good place to put 

information such as humidity, noticeable vibration of the motor before it was tested, and so on.   

Fig 50: Data tab, Applications view.

NOTE:  The tester type, tester serial number, and calibration date are stamped on this record to indicate what tester 

performed the test.

You can use this view to add new application records (which add an empty test record), update existing information, 

and delete test results.  

To change the test result being displayed, click on the date/time in the top section of the Data tab.  The Application 

view will then display the selected date/time’s information.
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Test Params Feature

 The Data tab, Applications view contains a button labeled Test Params that opens a new window similar to the 

example shown below when clicked. 

Fig 51: Test parameters window.

This window provides you with a summary of parameters used for a specific test as it was executed by the operator 

during testing.  In many cases, it will simply reflect the parameters assigned to the Test ID; however, if an operator 

makes changes to the parameters for any reason before executing the tests, the actual parameters used will be 

reported in this window.
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Data Tab—Results Summary View

The Results Summary view displays the test results summarized in a grid or spreadsheet form.  Each column 

represents one test result.  

Fig 52: Data tab—Results Summary view example.

The first two rows are used as the heading for each column, displaying the date and time the test was performed.  If 

all tests that were performed passed, the background of the date/time cell will be green.  If one or more tests fail, the 

background will be red.  If no tests were performed, the cell background will be gray.  

Use the scroll bars to the right and bottom to scroll through the results for each test category.  The side-by-side view 

allows all test results for a motor to be seen in one view, facilitating comparison.   

To print a copy of this view, click the right mouse button anywhere on the grid.  A dialog box will appear allowing 

you to choose a printer and parameters for printing the grid.
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Data Tab—Surge View

The Surge view shows a thumbnail view of the surge waveforms for a particular test along with basic test results and 

controls for viewing graphs in more details.  

Fig 53: Data tab—Surge view showing test results.

Click on the Enlarge button to view the surge waveforms more closely.  The waveforms can be viewed in two ways 

as the next examples illustrate.

In a comparison view, all waveforms for all leads can be superimposed on each other.  You can select each lead for 

display if needed.

  

Fig 54: Enlarged Surge view—all waveforms in comparison.

In enlarged view, you can hold down the left mouse button and drag a box around an area of the screen to zoom in 

on the area.  You can also use your finger to draw the box around the area you want to zoom in on.

In a nested view, waveforms for a single selected lead at the 1/3, 2/3, and full voltage are superimposed.  
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Additionally, if the test failed, the previous to fail and the failed waveform will be displayed with the failed waveform 

being drawn in white.

Fig 55: Enlarged Surge view—waveforms nested.

The Surge view not only displays the surge waveforms for all leads, it also renders a view of the pulse-to-pulse (P-P) 

Error Area Ratio (EAR).  

Click on the EAR Graph button to view the pulse-to-pulse EAR graph.  The graph displays the EAR percentage 

between successive pulses per test lead and the tolerance used during the test.

The P-P EAR evaluates each pulse of the Surge test to identify weakness in turn insulation.  This test should be used 

whether the rotor is installed or not; threshold is typically set to 10%.  

As the voltage is increased, each surge pulse is digitized and compared to the previous pulse.  If the motor under test 

has weak insulation, the waveform frequency increases and the software will calculate the difference between the 

previous to failed waveform and the failed waveform.  If it calculates a difference greater than the tolerance set, the 

test will stop and capture the waveform for analysis and reporting.

Fig 56: Pulse-to-pulse EAR example.
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Data Tab—Pi View

Clicking on the PI (Polarization Index) tab displays the PI view, which contains the PI/DA graph and data table.  

Fig 57: Data tab, PI view.

The PI graph charts the current vs. time and the Megohm reading vs. time.  Under the PI graph are selected data 

points used in the graph.  On the right side of the graph you will see data for PASS/FAIL, test voltage, DA/PI ratios, 

and four check boxes.  

Use the Megohm Plot and Current Plot check boxes to select whether the data will be plotted in minutes or 

seconds.  Unchecking both boxes in a section removes the element from the display.

In the small graphic display area, you can hold down the left mouse button and drag a box around an area of the 

screen to zoom in on the area.  You can also use your finger to draw the box around the area you want to zoom in 

on.
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Data Tab—Step/Ramp-Voltage View

Clicking on the Step/Ramp-Voltage tab displays the Step Voltage test data in both graphical and tabular form.  The 

graph defaults to plotting current vs. voltage.   

The triangles indicate the current level at the end of each step.  

Clicking on the Current vs. Voltage or Current/Voltage vs. Time radio buttons determines what will be plotted on 

the graph and in the table.

Fig 58: Step/ramp Voltage view showing current vs. voltage.
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Clicking on the Current/Voltage vs. Time radio button provides a view similar to the example below.

Voltage is displayed in blue and real-time current in red.  The green line with triangle markers indicate the current at 

the end of each step.

Most concern is typically given to the current at the end of the voltage step.  End-of-step currents should be linear.  If 

they are not, an insulation problem is often indicated.  

The data in the table below the graph shows the test time per step, the voltage of each step, the measured end-point 

current, and the Megohm value at each end point.  

NOTE: The large swings of the red real-time current lines show the motor’s charging current while ramping up 

voltage.  These large swings do not indicate an insulation problem.

Fig 59: Step/Ramp Voltage view showing current vs. time.

In the graphic displays, you can hold down the left mouse button and drag a box around an area of the screen to 

zoom in on the area.  You can also use your finger to draw the box around the area you want to zoom in on.

Press the space bar on the keyboard to zoom back out to full view.
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Using the Tests Tab

Clicking on the Tests tab changes the display area in the right side of the Main window as shown in the example 

below.  This is the main testing window.  Each test the analyzer performs is indicated by several columns of buttons 

that show the test status.

In the left-most column are On/Off buttons that show if a test is active.  Click on the related button to turn each test 

on or off.  

Click the buttons in the center column to execute the particular test.  This is considered semi-automatic testing.  

Fig 60: Tests tab elements.

Use the test setup buttons to open a new window used to configure each test.  The button labels indicate how each 

test is set up, how many leads will be used, the test voltage applied, and so on.  Each test’s configuration window is 

described below.

A fourth shaded column appears at the end of testing.  Green indicates that the test passed; red that it failed.  A red 

indicator also displays the reason the test failed.

To run an automatic test, click the Run Auto Test button.  Each test that is turned on will be performed in the 

sequence as it appears in the Tests tab view.

To edit Test IDs, click on the Edit Test ID check box.  You will be prompted for a password.  

Enter the password and click OK.  Three new buttons will appear below the Test ID.  Use the Save button to save 

changes you make to the selected Test ID.  Use the Add button to add a new blank Test ID or to copy a selected Test 

ID.  Use the Delete button to delete the selected Test ID.   When you are finished editing Test IDs, or if you decide 

not to edit, uncheck the Edit Test ID box to disable Test ID editing.  

NOTE: Leaving the Tests view will also disable the editing of Test IDs and all changes will be lost if they have not been 

saved.
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Test Setup 

Three setup windows are used to configure tests: Temperature/Resistance, DC Tests, and Surge Test.  Each window is 

described below.  

Settings and parameters specified in the setup windows define the Test ID.  If you want to update parameters for all 

motors using the selected Test ID, check the Edit Test ID box before editing test parameters.  You can then save your 

changes when finished.

Temperature/Resistance Test Setup Window

When one of the temperature or resistance test setup buttons is clicked, the Temperature/Resistance Test setup 

window appears.  The resistance and temperature test parameters are combined into one window as shown below.  

The temperature entry and resistance test can be turned on or off using the enable radio buttons on the left side of 

the window.  

Fig 61: Temperature/Resistance test window.

The temperature entry is used to acquire the motor’s temperature (as close as possible to the winding).  Some motors 

may even have temperature detectors installed, but other methods such as scanning guns can be used to acquire the 

motor (winding) temperature.  The temperature collected via the external devices is entered manually in this setup 

window.  Temperature can be entered in degrees Celsius or Fahrenheit.   

The temperature acquired at test time is used during testing to adjust coil resistance values per IEEE 118 and 

insulation resistance values per IEEE 43/95.
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Resistance measurements can be influenced by humidity.  To enable setting the relative humidity, check the Relative 

Humidity box then enter the humidity present.  Click on Accept to commit the settings.

The resistance test has several options.  The test can be performed on a two-lead (single phase) device such as a 

single coil or a three-lead (three-phase) device such as a three-phase motor.    Resistance values can be automatically 

acquired by the analyzer, or by some other means and manually entered into the software.  The method for entering 

or obtaining resistance data is described later. 

You can tell the software to use low-voltage leads for resistance measurement (recommended when applicable).

The motor may have wye or delta winding configurations.  The wye or delta configuration is entered in the Data tab 

Nameplate view and the information is displayed here based on that entry.  

Fig 62: Resistance enabled.

By checking the Delta R (%) box, the resistance values will have their percent spread calculated at the end of the 

test.  If the percent spread is outside the number entered in the corresponding field, the motor will fail the resistance 

test.  

The acquired resistance values can be temperature corrected by checking the Correct to box and defining the related 

parameter in the adjacent field.  

The temperature the resistance value is corrected to is set to 25° C by default, but it can be changed to another 

value.  IEEE 118 recommends 25º C.  The constant used to convert resistances at one temperature to another is 

known as the IEEE 118 constant and is 234.5 for copper or 224.1 for aluminum. 

A motor that does not have a resistance reading within a target resistance range can also fail.  Correct this issue 

by checking the Target Corrected Resistance box and entering the expected corrected resistance values and 

tolerances.

NOTE: Only temperature corrected values will be used in determining if values are within tolerance.

At the end of the test, the analyzer compares corrected resistance readings to the target corrected resistance to 

determine if the motor passes.
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The lower portion of the Temperature/ Resistance Test window contains buttons used in manual and semi-automatic 

testing.  It also include three columns that display test results for all testing options.  The Delta R average result is 

also displayed here.

Three columns report measured line-to-line resistance, temperature corrected resistance, and calculated coil resistance 

values.  

As mentioned previously, there are two ways to obtain resistance data.  In automatic mode, the analyzer will measure 

the resistance when you click on the Automatic radio button.  The second way is to manually measure the leads 

using a precision resistance bridge then directly entering the values into the corresponding Measured L-L fields.

NOTE:  A precision resistance bridge is a typical example of a device that is sensitive enough to collect accurate data 

to use in resistance imbalance calculation.  It is most important to ensure that the instrument used can give you 

accuracy that is consistent with the measurement being made and the device being measured.

Fig 63: Test Results section of the Temperature/Resistance Test setup window.

Another key difference between the automatic and manual modes is that the automatic mode will make a resistance 

measurement per your specifications between a lead with the other two leads held at ground.  A balance test can be 

done, or the low-voltage leads can be used for a more precise test.  

A resistance value that is manually entered will be different: a measurement made with a bridge will be between 

two leads with a third lead allowed to float.  Due to this difference, the winding configuration becomes even more 

important.  The Baker AWA-IV software assumes that manually entered data will be made with a two-lead precision 

bridge and that the third lead is allowed to float.  A wye motor’s lead-to-lead measurement will be different from a 

delta lead-to-lead measurement.

Regardless of how the resistance measurements are acquired, after they are obtained the software will calculate the 

temperature corrected resistances and display them.  Additionally, if possible, the analyzer will calculate the individual 

coil resistances.  If not, the software will display a message indicating that a solution to the coil resistance could not 

be found.  

While the Temperature / Resistance window is open, there are several ways to start a resistance test measurement:

1. Click the Test All Leads button.  The analyzer then measures each lead’s resistance sequentially (semi-automatic 

testing).

2. Click one of the lead buttons on the Baker AWA-IV front panel.  The analyzer then measures the resistance of the 
clicked lead only and displays the results (manual testing).
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Manually Entering Resistance Measurements

Resistance measurements taken from the motor using a high-precision resistance bridge can be manually entered 

instead of having the analyzer run an automatic resistance test.  Manually entered data should be line-to-line type  

measurements.  

To enable manual data entry, click one of the manual entry buttons (Lead 1–2 (Ohms)); then the results section of 

the Resistance test window enables the Measured L-L column so you can directly enter the lead resistances taken.   

When you have finished entering data, click the Accept button.  

Wye-wound Resistance Measurement

Using the NEMA nomenclature for a wye-wound motor, the resistance measurement for lead 1 should be made 

between terminals 1 and 2 with terminal 3 left floating.  This measurement will consist of coils 1–4 in series with coils 

2–5.  Likewise, the lead 2 measurement should be made between terminals 2 and 3 with terminal 1 left floating.  The 

lead 3 measurement should be made between terminals 3 and 1 with terminal 2 left floating.  

Delta-wound Resistance Measurement

Using the NEMA nomenclature for a delta-wound motor, the lead resistance measurement should be made between 

terminals 1–6 and 2-4.  This measurement will be of coils 1–4 in parallel with the series combination of coils 2–5 and 

3–6.  The lead 2 measurement should be from terminals 2–4 and terminals 3–5.  Likewise, the lead 3 measurement 

should be made between terminals 3–5 and terminals 1–6.  

After entering all data and clicking the Accept button, the measurements will be temperature corrected and 

displayed in the Temp Corrected column.  The coil resistances will also be calculated for the individual coils and 

displayed in the Calculated Coil R column.

Coil Resistances

As discussed above, the resistance measurements made by the Baker AWA-IV are a user-configured series or a parallel 

combination of coils.  At the end of a resistance test, the analyzer will calculate and display the coil resistances.  If 

a temperature has been entered, it will report those values.  These values are found in the right-hand column of 

numbers in the Resistance window.  The calculation involves numerically solving for the coil resistances given the type 

of winding (wye or delta) and the measured balance values.

Under some circumstances, the algorithm may fail because it cannot return a valid result based on the values entered 

manually.  In such cases, the analyzer will indicate that it cannot find a solution given the balance resistance values.  
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DC Tests Configuration Window

The DC Tests configuration window is displayed when one of the Megohm, PI/DA, or HiPot test setup buttons is 

clicked in the Tests tab.  

Fig 64: DC Tests configuration window.

The Megohm is the first test to be run, followed immediately by a PI or DA test, and then a HiPot type test.  There 

are two drop-down lists for PI/DA and HiPot type tests.  The PI/DA list includes all options for PI or DA testing.  

The HiPot tests list includes Ramp-Voltage and Step-Voltage tests in addition to the standard HiPot test.  Setup 

parameters are made for the specific test type chosen from each list.  Test voltages, minimum Megohm readings, 

voltage ramp rate, test times, current trip settings, discharge times, minimum PI values and more are all entered in 

the fields within each test type column.  

The PI test has two extra options: 1) default to the Dielectric Absorption if the IR=5000MΩ at 1 minute and 2) the 

Dielectric Absorption test only.  The PI test has many subtleties; these two options let you set up the tests so that no 

unnecessary time is spent on the PI test.  

Each test can be run individually by clicking the appropriate Run Test button.  Alternatively, all selected tests can be 

run by clicking the Run Selected Tests button.

You can also specify temperature correction values and insulation type using the drop-down list and field found 

below the Run Selected Tests button.  After you select an insulation type from the list, the Temp Correction field is 

enabled so you can enter the appropriate value.

At the bottom of this section is the Touch Screen E-Stop Enabled checkbox.  If you check the box, touching the 

screen during testing will result in an automatic stop in testing, which will be recorded as a user abort.

The right side of the window displays the real-time voltage, current, and insulation resistance readings collected 

during the Megohm and HiPot tests.  The voltage and current are displayed as slider bars.  Below the slider bars are 

real-time voltage and current numerical outputs.
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Ramp Voltage Test

The ramp voltage test is mostly used when testing generators.  It gives information on the contamination level with 

the winding.  The ramp voltage test is performed for a predetermined length of time at a specific voltage level.  The 

voltage increases linearly on a specific time scale.  

As the test is operating, the key is to watch the current.  If it remains linear with the voltage, the winding is in good 

condition.  If the current wavers up and down, the winding might be contaminated.  The figure below provides a 

graphical representation of this test.  In the illustration, the unstable line suddenly increases in voltage and current.  If 

this occurs, it could indicate an imminent overcurrent trip and a problem within the winding.

Fig 65: Evaluating charging current during ramping.
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Step Voltage Test 

The Step Voltage test, also called a step test, is described in detail in IEEE 95.  Clicking on the drop-down arrow for 

HiPot tests reveals the Step Voltage test.  Clicking on the Step Voltage test menu item will start the Configuration 

Wizard used to set up the test.

Fig 66: Step voltage Config Wizard—step 1.

Fill in the appropriate information for the steps needed.  Make sure the steps are appropriate for the application 

being tested.

The second window is used to enter up to 30 voltage steps or test intervals for each step.  This window will also 

appear when the Step Voltage test runs and will display a real-time graph of the voltage and current collected during 

the test.  After this test has been set up, it can be edited prior to running.  Click on Config in the DC Tests setup 

window and the second step page appears.

Fig 67: Step voltage Config Wizard—step 2.
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Surge Test Setup Window

The Surge Test setup window, shown in the example below, appears when you click on the Surge test setup button, 

at the end of the Surge row in the Tests tab.  

Fig 68: Surge Test setup window.

In the upper left corner of the window the Surge Voltage, V Ramp Rate, and the number of Surge Pulses are 

entered in their respective fields.  

We recommend that the surge voltage be 2v + 1000 (where v is the nominal rated line voltage of the device under 

test).  The voltage ramp rate controls the rate at which the voltage increases during the test and is set to a default 

rate of 25 volts.  

Use the Surge Pulses field to define the number of pulses applied to the winding after the full test voltage is 

reached.  

The Volts/Div and µSeconds/Div fields are related to the x- and y-axis of the surge waveform graph located in the 

middle of the window.  The Volts/Div field is set to Auto by default, but you can manually enter a specific value 

if you prefer.  This field defines the y-axis scale display on the surge waveform graph.  The µSeconds/Div (x-axis) 

field is also set to Auto by default to capture the waveform in time, or you can manually enter a specific setting if 

preferred.

The top center of the window includes a series of check boxes that determine Pass/Fail criteria for the Surge test.  The 

L-L EAR (%) check box sets the maximum Lead-to-Lead Error Area Ratio (EAR) allowed between the different leads.  

This is usually set to 10%; however, some people have found settings as low as 4% to be useful.  

NOTE:  This option should not be set if testing a motor with a rotor installed.  If it is absolutely necessary to use the 

L-L EAR with the rotor installed, increase the tolerance to avoid nuisance trips.  The increase in EAR tolerance with 

installed rotors makes the use of this feature a poor detector of a turn-to-turn insulation problem. 
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Use the P-P EAR (%) field to set the maximum Pulse-to-Pulse Error Area Ratio allowed for the test.  

Fig 69: Pass/Fail tolerances.

The Zero Crossing (%) option allows comparisons of the horizontal positions (time-offsets) where a waveform 

crosses the zero reference line.  A turn-to-turn fault is normally identified by a sudden increase in ringing frequency, 

which appears as a surge waveform jumping to the left.  

Enabling this option instructs the software to compare zero crossings, looking for too much movement in either 

direction. The threshold value is a percentage of a zero crossing’s time offset, specifying the maximum amount that 

such an offset can change from one pulse to the next; anything beyond results in the motor failing the Surge test. 

NOTE:  Motors with heavy rotor influence can cause false failures when using Zero Crossing.  Zero crossing measures 

only frequency, whereas P-P EAR measures frequency and amplitude.

The remaining three columns (L1, L2, and L3) show real-time numbers for the specific lead while the test is running.  

These numbers will become visible during the test.  The number to the left of the “/” delimiter represents the last P-P 

EAR taken for the test (for most passing tests, this will likely be 0 or 1) and the number to the right is the highest P-P 

EAR recorded over the entire test.    

Check the Test-Ref EAR (%) box to enable setting pass/fail criteria when comparing the surge waveforms from the 

test to a previously stored reference test.  If the field is disabled as shown in this example, a reference waveform has 

not been set.  See “Creating a Surge test reference” later in this chapter for details.

The four buttons on the right side of the window will run a Surge test when clicked.  Clicking on the Lead 1 button 

starts a manual Surge test on lead 1 only; likewise for the Lead 2 and Lead 3 buttons.  

Clicking on the All Leads button starts a semi-automatic three-lead Surge test.  A Surge test can also be started by 

clicking one of the test buttons on the front panel of the analyzer.

Fig 70: Run surge buttons.
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The final voltage reached for each lead tested is displayed in the text boxes to the right of the graph area.  The EAR 

values shown correspond to the measured L-L EAR between the three leads during the test.

Fig 71: Final peak voltages and EAR values.

In the area just above the waveform display area, you will see a number of check boxes (depending on the model) 

that enable other Surge test features.

Fig 72: Final peak voltages and EAR values.

 � Enable PP—check when the AWA serves as a host to a Baker power pack.

 � Pause Between Leads—check when you need additional time between testing leads, typically to reconfigure 
the leads before continuing with testing.  

 � ZS Override—checking this box disables the zero start feature (voltage output beings at zero volts) and allows 
the tester to apply full output voltage to the unit under test.  The feature is used in situations where you want 
to apply a higher voltage to a unit under test without ramping up.  For example, you might test an initial single 
coil, ramping up to the target voltage, then select ZS Override and apply the same voltage level to subsequent 
identical coils.

 � Hi L—The Hi L (high impedance) feature extends the Baker AWA-IV 4 kV model’s base surge test circuitry range.   

It is used when testing high inductance devices such as shunt fields to provide higher sensitivity evaluation 

characteristics.  For more information on applying the feature, contact Megger Baker technical support. 

 � Arm—check this box to set up and conduct armature testing features.  A Baker ZTX or Baker power pack with 
armature testing capability is required to use this feature.  Refer to chapter 7, “Using the Baker ZTX with Baker 
AWA-IV Analyzers” for more information.  Similar information is also found in the Baker power packs user 
guides.
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E Bar Graph

The surge waveform graph is shown in the graphic below.  The vertical (y-axis) displays the voltage while the 

horizontal (x-axis) displays time.  The surge waveform is a plot of the voltage across a coil versus time.  On the right 

side of the graph is a bar graph with an E label at the top.  This bar graph will rise as the energy is increased by the 

analyzer to create the displayed waveform.  

Fig 73: Surge waveform window.

Effectively, the energy bar graph shows how far down the footswitch pedal must be pressed to obtain the surge 

waveform (when the footswitch accessory is used).  Low impedance coils (those with only a few turns) require more 

energy in the surge pulse to develop a given voltage than a higher turn count coil.  The E bar graph gives you an idea 

of how hard the analyzer is working.

The voltage readout seen just above the waveform (shown as 2040 in this example) shows you the voltage level as 

you increase the voltage with the footswitch or Voltage Output Control knob.
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Creating a Surge Test Reference

Creating a reference waveform involves determining and setting parameters collected from a known-good reference 

motor.

1. To acquire a reference waveform, check the Edit Test ID box in the Tests tab, and turn on the Surge test.

2. Click on the Surge test setup button.

Fig 74: Edit Test ID box checked in Tests tab.

3. When the Surge Test setup window opens, set the desired voltage, Zero Crossing, and both L-L EAR and P-P EAR 
tolerances.  

4. The Volts/div and µSeconds/Div parameters default to auto; however, if you know these settings, enter the values 
to give yourself a better view of the waveform.  If you do not know the settings needed, leave them at auto and 
run a test to determine the best setting to use.  Then enter the settings before running further tests. 

Fig 75: Surge Test reference parameters setup.

NOTE:  It is important when comparing waveforms that all settings are the same.  If the scales are different, a valid 

comparison cannot be made.
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5. After the test parameters have been modified as needed, click the Close button to return to the Main window, 
Tests tab.

6. Click on the Save button to save the parameter changes, but do not uncheck the Edit Test ID box.  You are now 
ready to test a known-good motor to obtain your Surge test reference.

Testing a Reference Motor

1. To obtain the reference test, ensure that the Edit Test ID box in the Tests tab is checked.  Immediately after 

setting up the test parameters, connect the reference motor to the tester and confirm that the Motor ID 

displayed on the toolbar is the reference Motor ID.  

2. If you want to ensure that the motor passes all tests, click the Run Auto Test button then resume the Surge Test 
reference waveform process when you get to the Surge Test window.  Otherwise, you can click on the Surge test 
run button in the Tests tab and proceed.

3. In automatic mode, the test will commence on its own.  For other modes, click on the All Lead button to start 
the test.  The analyzer will raise the test voltage to the define level and conduct all defined measurements for 
each test lead.  For a known-good motor, all tests should pass.  When the tests complete, the tester will return 
you to the Tests tab (in automatic mode; other modes, click Close to return to the Tests tab).

Fig 76: Surge Test reference waveform acquisition in progress.

4. A message dialog appears to confirm that you want to save the test result as a reference.   

5. If the results are good, click Yes.  If the test needs to be run again, click No.  Multiple tests can be run to obtain 
the desired reference.  In automatic mode, test results are always saved.  The reference will become part of the 
Test ID only when Yes is clicked in the Use as Reference dialog box.  

6. Motors that use the Test ID associated with the reference motor’s Test ID will now have Test-Ref EAR% enabled 
in the Surge Test setup window.  

7. When you have finished the process, click Save then uncheck the Edit Test ID box to turn off edit mode.
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NOTE: If the reference waveform is no longer needed or if has been created by accident, uncheck the Test-Ref 

EAR(%) and click the Done button, then update the Test ID and it will detach the reference waveform from the 

selected Test ID.

Testing a Production Motor by Comparing with a Reference Motor

1. Select the Motor ID for the production motor to be tested.  Ensure that it uses the same Test ID as the reference 

motor.  If the subject motor has not been entered into the database, add it via the Data tab Nameplate view, 

ensuring that it is the same type of motor as the reference.  Then ensure that the proper Test ID is assigned.  

2. You can confirm that the selected Test ID has a waveform attached by viewing the Surge Test setup window.  The 
Test-Ref EAR (%) box will be checked and a Display Ref button will be visible.  

3. Click on the Display Ref button and the reference waveform will be displayed.

Fig 77: Display reference button.

4. Click Close to return to the Main window, Tests tab.  

5. Click the Run Auto Test button to begin the test.  

6. The software will automatically run through the resistance and DC tests, and if the motor passes all other tests, it 
will automatically continue with the Surge test.

7. If the software detects a reference test, it will calculate the Error Area Ratio (EAR) at the end of the Surge test.  
The EAR is calculated between leads of the motor under test and compared to the reference motor test results.  
The software will then compare the EAR values with the tolerances entered in the Test-Ref EAR(%) parameter.  
If the EAR values are within tolerance, the motor passes.  Conversely, if an EAR value is outside the tolerance, the 
motor fails.  After the test has been performed and saved, surge waveforms can be examined via the Data tab 
Surge view.
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Viewing Surge Test Results

To examine Surge test results go to the Data tab, Surge view.  If the Test ID used has a reference motor attached to 

it, the software displays the selected motor’s surge waveform (solid lines) and the overlaid reference motor’s surge 

waveforms (dashed lines).  

Fig 78: Surge results display.

NOTE: If the reference waveform is very close to the selected motor’s waveform, it will hide the dashed waveform so 

only the solid lines are viewed.  To see one lead at a time, check or uncheck the desired lead’s check box.
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Using the Trending Tab

Clicking on the Trending tab brings up a graph that charts acquired data.  Trending information such as Max Delta 

R%, Balance Resistance, L-L Resistance, Coil Resistance, Megohm (correct or not corrected), PI, and HiPot leakage 

currents can be graphed over time so you can get an idea of the long-term status of a motor’s insulation.  

These graphs can be reset, are selectable by date, and have several printing options.

You can hold down the left mouse button and drag a box around an area of the screen to zoom in on a specific area.  

You can also use your finger to draw the box around the area you want to zoom in on.  Click on the Reset button to 

return to full view.

Fig 79: Trending graph.
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Max Delta R% 

Max Delta R% identifies the maximum resistance difference percentage between all three test leads.  This 

imbalance as it is commonly known is collected during each test conducted on the motor.  The results are plotted 

in this graph with the test date and time shown in the X axis.

Fig 80: Max Delta R% trending graph.

Resistance Trending Graphs

There are three different types of resistance data that can be trended: balance, line-to-line, and coil.  Selecting one 

will bring up a graph similar to the one shown in the example.  Resistance measurements are taken against time 

and show very little variation over the test interval.  

Each of the three leads is shown in its own color.  Each data point is indicated by a square, diamond, or triangle 

marker.  Hovering over a data point will show a date/time stamp and give the value of the test.  This feature 

allows for easy identification of the test record for that point.

  

Fig 81: Resistance trending graph.
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Insulation Resistance/Megohm

Megohm data is graphed by clicking on the Megohm Trend item in the drop-down list.  Hovering over a data point 

shows a date/time stamp and gives the value of the test.

Fig 82: Megohm trending graph.

NOTE: When trending Megohm values, the temperature corrected values should be used and not the uncorrected 

values.  Both values are available in the software.  However, sometimes it is not possible to acquire the temperature 

of a motor when testing due to inaccessibility of the motor.
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PI

Clicking the PI button displays the graph trending the PI ratio versus time, and has similar features to the other 

trending graphs.

Fig 83: PI trending graph.

HiPot

Clicking on HiPot in the drop-down box brings up a graph of the HiPot leakage current data.  This has the same 

features as the Megohm trending graph.

Fig 84: HiPot trending graph.
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Relative Humidity

Checking Relative Humidity (RH%) adds the RH percentage value entered at test time to the tool tips displayed 

when you hover over a data point.  Default values displayed in the tool tips include the Time/Date stamp and 

measurement value of the point.

Additional Trending Tab Features

On occasion, only a certain time period of data is desired, or some invalid points need to be excluded.  You can 

select specific data points using one of two methods.  The first is when the trending graph is displayed.  Hold the left 

mouse button then drag and draw a box around the points you want to display.  When you release the left mouse 

button, the graph will automatically re-scale and display the points inside the box you drew.  

To reset the graph, click on the Reset button then all points will be displayed.

Fig 85: Special trending features 

The second method is to choose points from a list of all test dates/times.  
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Clicking the Select Dates button opens a window showing all test dates and times along with a spreadsheet style 

view of the data.  All of the data can be selected or just specific tests.  Most often, this feature will be used to exclude 

a test that contains known bad data that, for example, might be acquired in a test that was aborted.  

To select or deselect dates, use the same type of selection techniques used to select files in Windows Explorer.  

1. Click the left mouse button to select a single record.

2. Click on the first record.  

3. Click the Shift key on your keyboard and click on the last record to select a range.

4. Within a selected range, click the Ctrl key on your keyboard and click on individual records to remove an 
unwanted record from the selection.

Fig 86: Dates to trend spreadsheet.

Additionally, all of the records on this window can be exported to a comma-separated values (CSV) file for later 

importing into a spreadsheet.  In this manner, data can be analyzed using your preferred tools.  

1. To create the CSV file, select the test date/time to export or select None and all data will be exported.  

2. Click on the Create Text File button and enter a file name.

3. The application will create a comma-delimited file.  This dialog will also allow printing of all the data see in the list 
box.  Click on Print List to print all selected data.
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5 — Test Procedures

Before Testing Begins

The starting point for conducting all motor testing involves creating a Motor ID and assigning or creating a Test ID 

that is properly configured for the motor under test.

Testing options include fully automatic testing, semi-automatic testing, and manual testing.  Examples of each type of 

testing are provided in several areas within this and other chapters.

Recommended Testing Sequence

To adequately test motors and to establish effective predictive maintenance programs, we suggest using a specific 

test sequence.  The general idea is to perform the test sequence as a series of progressively more rigorous tests, 

accepting the idea that if a test fails, troubleshooting and repair should begin at that time.  More rigorous testing 

should only commence after satisfactory diagnosis and/or repair.  

CAUTION: The test leads have exposed metal areas.  Do not touch the leads while tests are running.  Always ensure 

that test leads are not placed in proximity to the frame or any ground potential.  Coil and properly store unused test 

leads in a safe location.

The suggested testing sequence is: 

1. Resistance

2. Megohm, polarization index (PI), dielectric absorption (DA)

3. HiPot, ramp voltage, step voltage

4. Surge

NOTE:  This chapter includes brief descriptions of each test type conducted with the Baker AWA-IV analyzer.   For 

more details on the theory and application of each test, refer to the Motor Testing Theory Reference Manual.

Balance Resistance Test or Line-to-Line Resistance

A coil resistance test looks for resistance imbalance between phases.  If a large imbalance is found, the motor should 

be inspected for the cause of the discrepancies.  Typical problems include:

 � Hard shorts to the motor’s core.

 � Hard shorts between coils; either within the same phase or between phases.

 � Coils rewound with the improper gauge wire.

 � Loose or corroded connections.

 � Opens.

No further testing is necessary until the reason for an errant measurement is determined and corrected, and a 

satisfactory resistance measurement is obtained.

NOTE: Rotors installed during testing can also affect resistance testing because if the rotor turns at all during testing, 

the system cannot settle out the changes and determine a proper resistance value.
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Megohm Test 

A Megohm test is performed using a test voltage based on the operating voltage of the motor and the appropriate 

standards/company guidelines.  Look for an unusually low Megohm value when compared to previous measurements 

or industry-accepted limits for the type of insulation in the motor.  If a low Megohm value is measured, the motor 

should be inspected for ground wall insulation damage.  Possible problems include: 

 � Slot liner insulation or enamel wire insulation may be burned or damaged.

 � The motor might be full of dirt, carbon dust, water, or other contaminants.

 � Connections to the actual coils might be damaged.

 � The wrong insulation might have been used to connect the coils to the motor’s junction box. 

No further testing is necessary until the reason for a low Megohm reading is determined and corrected.  

DA/PI Test

The Polarization Index (PI) test is performed in order to quantitatively measure the ability of an insulator to polarize.  

When an insulator polarizes, the electric dipoles distributed throughout the insulator align themselves with an applied 

electric field.  As the molecules polarize, a polarization (or absorption) current is developed that adds to the insulation 

leakage current.  The additional polarization current decreases over time, and drops to zero when the insulation is 

completely polarized.

The PI test is typically performed at 500, 1000, 2500, or 5000 volts, depending on the operating voltage of the 

motor being tested.  PI test duration is 10 minutes.  The PI value is calculated by dividing the insulation resistance at 1 

minute by the resistance at 10 minutes. In general, insulators that are in good condition will show a high polarization 

index, while damaged insulators will not.  (See IEEE 43-2000 for recommended minimum acceptable values for the 

various thermal classes of motor insulation.)

Many insulating materials do not easily polarize.  As recommended in IEEE 43-2000, if the 1-minute insulation 

resistance is greater than 5000 Megohms, the PI measurement might not be meaningful.

The PI test is performed on motor of 100 Hp or greater.  The PI minimum alarm should be set a 2.0 for class B, F, and 

H insulation, and 1.5 for class A insulation.

It is important to note that PI should not be used as the basis for any motor acceptance criteria.  It should be used as 

a trending and diagnostic tool, along with other test results include the PI curve generated by the tester.

The PI test can be used to identify the following possible motor issues:

 � Slot liner insulation or enamel wire insulation could be burned or damaged.

 � The motor might be full of dirt, carbon dust, water, or other contaminants.

 � Motor windings shorted to ground.

 � Poor cable insulation.

The DA is essentially the same as PI, but shorter in duration (10 min vs 3 min).  The first minute for both tests is the 

Megohm test.

Test Procedures
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HiPot Test

A HiPot test is performed using a test voltage that is substantially higher than the Megohm test; however, it should 

be based on the motor’s operating voltage and the appropriate standards/company guidelines.  

During HiPot testing, look for unusually high leakage currents, a leakage current that does not stay constant, or a 

leakage current that intermittently jumps up and down.  

Breakdowns or high leakage currents are indications of damaged ground wall insulation.  

Inspect the motor’s slot liner, wedges, conductors between the junction box and the coils, and so on.  

No further testing is necessary until the reason for an unacceptable HiPot reading is found and corrected.

Step Voltage Test

The Step Voltage test is used for predictive maintenance and field-testing.  This DC test is performed at a voltage level 

of what the motor typically experiences during starting and stopping.  The test voltages are governed by IEEE or other 

industry-accepted standards organizations such as NEMA, EASA, and IEC.  

The DC voltage is applied to all three phases of the winding, raised slowly to a predetermined step level, and held for 

a predetermined time period.  This is continued until the target test voltage is reached.  

Because the test is most stable at the end of each step, data is logged at that time.  If at that time the change 

in leakage current (IµA) more than doubles, insulation weakness is indicated and the test should be stopped.  If 

the change in leakage current (IµA) increase is consistently less than double, the motor insulation is likely in good 

condition.

NOTE:  You should only evaluate the doubling if leakage current is greater than 0.05 µA.

A Step Voltage test applies DC voltage in incremental steps, with each step held for 60 seconds by default.  During 

the holding period, the voltage is constant and the current should drop from the higher charging current value to a 

lower leakage current value.  If at any time the current exceeds approximately 85% of scale, the test will stop due to 

an “overcurrent trip” condition.  

If a rapid change in voltage is detected due to an arcing fault, an “overcurrent trip” condition will again be flagged.  

An ideal change in leakage current will have an asymptotic decay to some minimal value.  This minimal leakage 

current at the end of the step is recorded and used to calculate the final resistance value for that step.  The value 

is then temperature compensated and compared to the minimum allowed insulation resistance.  If the corrected 

resistance falls below the limit threshold, the test will stop due to a “low Megohm” condition.  

Following the holding period, the tester will ramp the voltage to the next increment and again hold for 60 seconds.  

The final step will be at the standard test voltage and the final resistance calculation is recorded as the HiPot 

resistance result.  

The Step Voltage Test Setup Wizard can be used to customize the voltage, step times, and minimum resistance trip 

values.  
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During the step voltage test, you can evaluate the recorded step leakage current levels for linearity by comparing 

the change in leakage current between each step.  In the example below, the leakage current increases from 8.80 

µA to 12.80 µA—a 4 µA change in current.  The next step also changed by 4 µA.  This is considered a perfect linear 

response because there was no increase in the change in current.  The third step had a change in current of 5.4 µA.  

While this increase in the change in current is not ideal, it is still considered linear.  The current departs from a linear 

relationship when this change in current at least doubles.  

In step five, we see that the current has changed by 10.2 µA.  The previous step had only changed by 5 µA, so the 

increase in the change in current has more than doubled.  This greater increase in current is due to a significant drop 

in the insulation resistance value.  

While this test has not failed, the departure from linearity could be used to prompt you to stop the step voltage test 

because reduced insulation integrity has been detected.  

Fig 87: Example Step Voltage test illustrating increase in current change.

Time(s) Volts (V) I(µA) Megohms IR@40C Difference between intervals

60 3300 8.80 378 267

60 4320 12.80 338 239 12.8 - 8.8 = 4

60 5350 16.80 318 224 16.8 - 12.8 = 4

60 6360 22.20 286 202 22.2 - 16.8 = 5.4

60 7350 27.20 270 190 27.2 - 22.2 = 5

60 8320 37.40 222 156 37.4 - 27.2 = 10.2  DOUBLED

60 9360 51.80 181 127 51.8 - 37.4 = 14.4
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Surge Test

A Surge test is performed on each phase of the motor, using a test voltage based on the motor’s operating voltage 

and the appropriate standards/company guidelines.  

Look for a jump to the left of the surge waveform pattern; this is the signature of a turn-to-turn short.  If a jump is 

observed, inspect the motor.  Look for damaged insulation between adjacent conductors.  

The insulation might be hard to see, so you might have to disassemble the motor to find the problem.  If you do not 

observe a jump in the wave patterns, the likelihood of motor failure due to turn insulation failure is greatly reduced.

Recommended Test Voltages for Insulation Resistance Testing

The following table provides guidelines for DC voltage applied during insulation resistance test.  Test voltage should 

be applied for one minute.  (See IEEE 43, sections 5.4 and 12.2.)

Winding Rated Voltage (V)a Insulation Resistance Test Direct Voltage (V)

< 1000 500

1000–2500 500–1000

2501–5000 1000–2500

5001–12,000 2500–5000

> 12,000 5000–10,000

a Rated line-to-line voltage for 3-phase AC machines, line-to-ground for single-phase machines, and rated direct 

voltage for DC machines or field windings.

Recommended Test Voltages for HiPot and Surge Tests

The general recommended voltages for HiPot and Surge testing a motor, generator, or transformer are twice the 

nominal rated line voltage (from nameplate; represented as v below) plus 1000 volts.  

2 x v + 1000 volts = test voltage

This test voltage is consistent with NEMA MG-1, IEEE 95-1977 (for test voltage greater than 5000 volts), and IEEE 43-

2000 (test voltages less than 5000 volts).

For example, the test voltage for a 480-volt AC motor would be:

2 x 480V + 1000V= 920 + 1000 = 1960 V

Likewise, the test voltage for a 4160-volt AC motor would be:

2 x 4160V +1000V = 8320 + 1000 = 9320 V

For new windings or rewound motors, the test voltage is sometimes increased by a factor of 1.2 or even 1.7.  This 

provides for a higher level of quality control on the work performed.  For example, for the 480-volt motor, the test 

voltage would be:

1960V * 1.2 = 2352V
Or
1960 * 1.7 = 3332V

For additional information on recommended test voltages, refer to “Appendix C—Recommended Test Voltages.”
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Performing an Example Test

The following section walks you through an example setup of a motor being tested for the first time.  

 � First, a Test ID must be selected or created for the motor being tested.  

 � Next, you will create a Motor ID that uniquely identifies the motor. The Test ID is assigned to the Motor ID at this 
time.    

 � Then tests will be configured as needed to ensure that parameters are optimal for your motor.

 � After all elements have been set up, you can run your test then review the results.  

 � Finally, you can print reports as needed.

Creating a Test ID

In many cases, an existing Test ID will meet your needs.  Examine the list of available Test IDs by opening the Tests 

tab and clicking on the Test ID drop-down list.  Test ID names often provide a hint at what they contain, but you can 

select one to open and examine its default parameters by looking at the test setup windows.  

If an existing Test ID will serve your needs, you can simply select it and assign it to your motor when creating the new 

Motor ID.  

Fig 88: Creating a Test ID.
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However, if none of the existing Test IDs meets the needs for the device you want to test, you will need to create a 

new Test ID.

Fig 89: Creating a Test ID.

1. Click on the Tests tab.  The Test ID that appears in the TestID field is assigned to the currently selected Motor ID.  

For this example, we will add a new Test ID.  

2. From the Tests tab, check the Edit Test ID box.  The Edit Test ID checkbox background will be red when in edit 

mode

3. Enter the password in the dialog box that appears.  

4. Click OK when the application accepts the password.  The Update, Add, and Delete buttons will appear and 
the voltage class drop-down list will be enabled.  

5. Click on the Add button.  The Create New Test ID dialog box appears as shown below.
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6. Click on the Add Blank Test ID radio button.

7. Enter a descriptive Test ID name.  The naming convention used by the software starts with the voltage class and 
add elements that indicate test elements intended for the Test ID.  For this example, we use “480V w/rotor DA 
Step” to name a new a Test ID that will serve a 480-volt motor with rotor installed that will include DA and Step 
Voltage tests.

Fig 90: Test ID input.

8. Using the drop-down list, select a Target Motor Voltage Class.   For this example, choose the existing voltage 
class of 480.  

9. If a needed class does not exist, you can create a new one by typing the class voltage in the edit box of the drop-
down list.  When a new voltage class target has been entered, enter a description in the appropriate field then 
click on the Add Voltage Class button.  

Fig 91: Creating new motor voltage class option. 

10. A dialog box will appear asking if this action is correct.  If it is, click OK in the dialog box.  

11. When you are satisfied with your selections, click OK to close the Create New Test ID dialog box.
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12. The new Test ID will be displayed and all tests will be turned off.  

13. Turn on all required tests by clicking the ON/OFF buttons in the left-most column.  The buttons turn green when 
they are on.  

14. The new Test ID is created and ready for assignment to the new Motor ID, which you will create next.

Fig 92: Tests tab view with new Test ID created and selected.  All tests turned on.

Item Description

1 Test configuration buttons.

2 Run tests buttons (semi-automatic testing).

3 Test On/Off buttons.
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Creating a Motor ID

1. Often times, when a new motor is being added to the database, a similar motor already exists.  In such cases, you 

can select the similar motor using the Explore tab.

2. From the Data tab—Nameplate view, the Motor ID information is displayed for the selected motor.  As the view 
name suggests, the information presented here comes directly from the motor’s nameplate.  The information 
presented was entered by a user when the original Motor ID was created.

3. When starting with information from a similar motor, click on the Add button to clear the Motor ID and SN 
(serial number) fields.  Then, enter the a new unique Motor ID and serial number for the new motor, provided 
that the existing information matches the values on the new motor’s nameplate.  If other nameplate information 
for the motor is available, you can add it as well.  

4. If you are creating a Motor ID for a motor that does not have a similar motor already in the system, select a 
Motor ID with the same operating voltage just to start the process, then click on the Clear button to clear the 
nameplate form.  Then, you will provide a new Motor ID along with all information found on the nameplate.

5. Use the Tab and Shift/Tab keyboard keys to easily move from field to field.

NOTE:  In most cases, only the Motor ID, Location, and Building fields are required.  However, adding all available 

information from the nameplate has proven valuable for many applications including report generation, internal and 

external troubleshooting, and support.  

 

If the Enable Voltage Class feature has been enabled, the Volts Oper (operating voltage) field will also be required.   

If a voltage class for your motor is not available in the Volts Oper list provided, you can create a new motor voltage 

class as described at the end of this chapter. 

 

Often times, more data fields are available than the information provided on the nameplate.  Fill in only those fields 

that have corresponding information on the nameplate.  

6. The Reset button restores the previous motor’s information to the form.

7. Ensure that the proper radio button is selected for Winding Config.  This value will be used by the software 
during test setup.
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8. Examine the example below to see how the Nameplate view appears when a new Motor ID is created.

Fig 93: Example Data tab Nameplate view of new Motor ID.

9. After all data is entered, click on the Save button to add the new Motor ID to the database.  

10. After the Save button is clicked, the Select Test ID dialog box appears.  

Fig 94: Test ID.

11. Assign a Test ID to the newly-created motor.  In this example, we select the new Test ID we just created: 480 w/
rotor DA Step. 

12. Click on the OK button.  The new Motor ID is now added to the Motor Tree.
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Setting Up Temperature and Resistance Test

1. The temperature and resistance tests share the same setup window.   Click on either the Temperature or 

Resistance test configuration buttons; by default, they are labeled Manual or 3 Lead/High V.  The Temperature/ 

Resistance Test setup window will appear next.

2. Because the Temperature entry step has been selected, the Temperature Enable radio button is green.

3. Click on the Manual Temperature Entry radio button.   

NOTE:  The Baker AWA-IV will accept both ° C (Celsius) or ° F (Fahrenheit) temperatures and a temperature range 

of -32° C to 250° C.   If you choose not to use Temperature entry, click on the radio button and it will be disabled 

(grayed out).  

4. Because the resistance test was chosen, the Resistance Enable radio button is also green.  The motor in this 
example is wye-wound, which is indicated on the window and can be changed via the motor’s Nameplate tab.

Fig 95: Temperature/Resistance test parameters.

5. The 3 Leads and Automatic radio buttons will be selected by the software for the 3-phase motor by default.   
The analyzer will automatically acquire the resistance readings.

6. Depending on the model, some analyzers are equipped with a separate set of resistance test leads to perform a 
lead-to-lead low-voltage resistance test.   Resistance values must be greater than 0.500 ohms for high-voltage 
leads.  If the high-voltage leads are used on a motor with resistances less than 0.500 ohms, the analyzer will 
prompt the operator to switch to low-voltage leads.  For this example, the AWA model being used does not have 
the low-voltage leads, so there is no Res Leads box to check. 

7. Check the Delta R (%) box and ensure it is set to 10%.  If the spread of resistance readings are more than 10%, 
the motor will fail.

8. Because temperature is enabled, the Correct to box is checked and defaults to 25° C and the value for copper is 
set to the IEEE 118 constant.

9. Target Corrected Resistance is a feature that refines the pass/fail criteria.  If checked, the analyzer will fail 
a motor if the readings are not within tolerances.   For example, the resistance reading for a motor can be 
taken using a DVM.  Let’s say that the reading is 3.1 ohms.  In this case, we can check the Target Corrected 
Resistance box and enter the value of 3.1 +/- 10%.  One issue with using this feature is that enabling target 
corrected resistance makes this Test ID specific to a single motor.  If resistance data is not available, or you want 
to be able to use the Test ID for other motors, do not enable this feature.

10. Click on the Close button.
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Setting up DC Tests

1. DC tests include Megohm, DA/PI, HiPot, Ramp Voltage, and Step Voltage tests.

2. To configure one or more of these tests, click on any of the test configuration buttons to the right of the DC test 
buttons to open the DC Tests setup window.  

3. For this motor, the Megohm and DA tests will be run at 500 volts while the Step Voltage test will be run at 2000 
volts.  Consult IEEE 43/95 or another appropriate standard to determine test voltages.  

4. Because this is a small motor, the PI test will run only as a DA test by selecting the DA Only Test Type as shown 
in the example below.  Doing a full PI test would not likely yield useful information.  

Fig 96: DC Test parameters—Megohm and DA parameters set.

If you click on the DA Only drop-down list, you will see another option called Revert DA.  Selecting this test 

option sets up the analyzer to automatically skip the PI test in favor of the DA test at three minutes if the insulation 

resistance (IR) is greater than 5000 Megohms at the one-minute mark.  Insulation resistance readings of 5000 

Megohms or greater at one minute is the generally accepted criteria for aborting the PI test.
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5. Click on the HiPot/Step Voltage drop-down list to select the Step Voltage test (for this example).  The Ramp 
Voltage test option is also selected from this list.

Fig 97: DC Test parameters—Step Voltage parameters set.

6. When you select the Step Voltage option,  the Config Wizard opens so you can define the parameters needed 
for your test.  The software will automatically calculate values for the test based on other parameters entered, but 
you can adjust the parameters as needed to fit your situation.  When you have settled on the parameters needed, 
close the Config Wizard to return to the DC Test setup window.

7. In the example above, we see that parameters are set for the Step Voltage test.

8. Click on the Temp Correction drop-down list to select the insulation type for you motor.  Options include 
Thermoplastic or Thermosetting.  Choose None if you do not want to set this parameter.  

9. If you choose Thermoplastic or Thermosetting, the correction field will be enabled so you can set the value 
needed for temperature correction.

10. When you are satisfied that your DC Tests have been configured as needed, click the Close button to return to 
the main test window.  
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Setting up Surge Tests

1. Click on the test configuration button to the right of the Surge button to open the Surge Test setup window.    

2. Configure the Surge test as shown.  Set the Surge Voltage to 2000 volts, which is approximately 2 X  V + 1000.  

3. Set VRamp Rate to a typical 25 volts.  If the test should run faster, increase this number to 50 or 100 volts.  

4. For this example, we set the Surge Pulses number to 5, which means that five pulses will be applied to the 
windings after the analyzer reaches its maximum test voltage of 2000 volts.  

5. Set the Volts/Div and the µSeconds/Div to Auto.  The analyzer will automatically scale the waveform to fit the 
graph.  

Fig 98: Surge test parameters.

6. L-L EAR (%) (Line-to-Line EAR) is turned off because this motor will be tested with the rotor installed.  If this 
option is selected, a nuisance trip could occur because the rotor coupling is different for each phase winding 
unless the pass/fail value is set to a high number such as 50 percent.

7. The P-P EAR (%) (Pulse-to-Pulse EAR) is set to 10 percent.  This means that a pulse-to-pulse EAR value greater 
than 10 percent will cause the analyzer to stop testing and the motor will fail the test.  This number can be 
reduced provided the voltage ramp rate is also reduced.  

8. The Zero Crossing option is not used in this example.  When used, the percentage set for the option is the 
threshold at which the test will fail if the waveform shifts to the left and crosses the zero reference line outside 
the defined threshold.

9. The Test-Ref EAR(%) is also not used in this example because this motor does not have a reference motor/
waveform associated with the test.  If the feature was available, we could set the value to say 10 percent; then 
the acquired waveforms would be compared to the reference waveform.  If the EAR values between reference 
waveforms and acquired waveforms were greater than the value shown, the motor would fail the test.    

10. Checking the Pause Between Leads box tells the tester that you need additional time between testing lead 
1 and 2, and lead 2 and 3 typically to reconfigure the leads before continuing with testing.  In most cases, the 
feature is not needed; however, if you have an atypical application such as performing a three-phase test, but on 
three independent windings, the feature provides the time needed to complete the reconfiguration.   

11. Other features in the Surge Test setup window apply to special cases that are documented elsewhere and are not 
used in this example.
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12. When you are satisfied that the parameters have been properly set, click on the Close button to return to the 
Tests tab.  Labels on the test configuration buttons will change to indicate values defined during the setup 
process.

Fig 99: Surge test parameters.

13. From the Tests tab, click on the Save button to update the database with the new test information.  From this 
point, the test parameters defined will be used to test the subject motor or any other motor that has this Test ID 
assigned to it.

14. Uncheck the Edit Test ID box after you click Save to end the editing process.
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Running an Automatic Test

After new Motor and Test IDs have been created, a fully automatic test can be run.  It will test the motor in the 

following sequence:

1. Temperature

2. Resistance

3. Megohm

4. PI/DA

5. HiPot/Step Voltage/Ramp Voltage

6. Surge

At the end of the sequence, the test data will automatically be saved to the database.

NOTE: Tests can also be run from the test windows using a semi-automatic or manual process.  Semi-automatic tests 

can be executed by pressing the desired run button on the Tests tab.   Additionally, tests can be run manually using 

the controls on the front panel of the analyzer.

1. To start an automatic test, select the desired Motor ID using the Explore tab.  

2. Click on the Tests tab to get to the main testing window.  If the Motor ID setup and the Test ID setup procedures 
were properly completed, the analyzer should be at the correct place to begin the automatic test for this 
example.  

3. To start the test, click on the red Run Auto Test button in the Tests tab and follow the directions.

4. The Safe to Turn On dialog box appears, instructing you to verify that the correct set of leads is properly 
connected.  If the resistance test is turned on and the Res Leads box is not checked, this dialog box will direct 
you to attach the high-voltage leads.  If the Res Leads box is checked, the displayed dialog will request that low-
voltage leads be attached.

NOTE: The test leads available and the corresponding directions presented by the software depend on the tester 

model that you will be using.

Fig 100: Safe to turn on notifications—model dependent.

The following sequence of tests will run automatically:

 � Temperature—The Temperature/Resistance Test window will open, ready for the temperature reading to be 
entered manually.  Readings are taken using an external device.  Enter the temperature reading then click the 
Accept button to acknowledge the entry and inform the software to proceed with the next test.  The analyzer 
will automatically proceed with the remainder of the tests.  

 � Resistance—If the readings pass per the Test ID requirements, the Temperature/Resistance Test window will 
close.  If low-voltage leads were used, a dialog box appears to instruct you to switch to the high-voltage leads.  
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 � Megohm —Starts by ramping up all test leads to operating voltage (500 volts for this example).  This voltage 
will be held for 60 seconds during which the analyzer watches for overcurrent trips or insulation resistance values 
below the minimum Megohm setting.   If a failure is detected, all testing will stop, and the test leads will be 
discharged and grounded.  You will be given the choice to repeat the test, stop all testing, or continue to the 
next test.

Fig 101: DC Test window—appears when DC Tests are executed.

 � PI/DA —The DC Tests window will switch its focus to the PI/DA tests column.   Because the Test ID in this 
example was set up for a Dielectric Absorption (DA) test, the duration of the test is three minutes (180 seconds).  
At end of the test, if no failures occur, the software will continue with the next series.

 � HiPot/Step-Voltage/Ramp-Voltage—The test will begin automatically.   For Step-Voltage testing, a new 
window automatically appears to display the test results in progress.  Pre-set by the example Test ID, the voltage 
is ramped up to 2000 volts in 500-volt steps, and held for 60 seconds at each step.  If the analyzer detects a 
low Megohm reading or a overcurrent trip, testing will immediately stop, and the leads will be discharged and 
grounded.  You will be given the choice to repeat the test, stop all testing, or continue to the next test.

Fig 102: Step -Voltage Test window—called automatically from DC Tests process.

If no failures are found during this test, the analyzer will close the Step-Voltage Test and DC Tests windows, and 

continue to the Surge test.
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 � Surge—The Surge test will begin automatically.   The Surge Test window appears and the test voltage slowly 
ramps up on lead 1 to 2000  volts as specified by the Test ID.  If no pulse-to-pulse EAR failures are been 
detected, leads 2 and 3 will be tested in turn.  If a test fails at any point, a dialog box appears offering options to 
test the next lead, or to discontinue testing. 

Fig 103: Surge Test window—appears when Surge test is executed.

If no failures occur, the data from all tests will be saved to the database and the main test window will re-appear, 

showing the general results in the Tests tab.

Fig 104: Main window—Tests tab—with passing test results.
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Reviewing Test Results and Data

After the test results have been saved to the database, they can be reviewed using the Data tab in the right pane of 

the  software’s Main window.  The Results Summary tab has a Date/Time area on the top part of the window and 

a spreadsheet style view of the data on the bottom.   

Fig 105: Main window—Data tab; Results Summary view.

Fig 106: Date/time results summary section close-up.

The Date/Time area shows a quick summary of the time and date of tests, and whether the tests passed or failed.  

Double click on a test date and time to move to a new record.  

You can also right click on a record to open a Delete dialog box if you choose to remove a specific test record.
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If you want to expand a column to view more information, hover the mouse cursor over a column’s edge until the 

cursor changes to a two-headed arrow, then click and hold the left button down while dragging the edge to create 

the desired column width.

Fig 107: Date/time results summary section close-up.

The Results Summary view presents the test data acquired in a spreadsheet style.  The test date and time are shown 

across the top of the window with specific measurement results shown in each column.

Fig 108: Test results spreadsheet; lower section.
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Review the PI test results by pressing the PI tab.  PI view will display the PI/DA graph along with a table of the current 

and Megohm readings gathered at specific times.   The PI voltage, DA ratio, and PI ratio are displayed on the right 

side.   Because this test was a DA, only the PI ratio has I=0 No PI indicating there is no PI value because the current 

was zero.

Fig 109: Reviewing PI test data.

Click on the Surge tab to view surge test data.

Fig 110: Surge waveform view.
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Single-phase Testing

When performing single-phase testing (for example, on DC motors or when testing single coil) you must use this 

setup window to set the parameter that alerts the tester to operate in single-phase testing mode.

1. From the Tests tab, click on the test configuration button at the end of the second/Resistance row in the 

Temperature/Resistance Tests section. 

2. Click on the Temperature Enable radio button if you will be using temperature compensation.

3. Click on the Resistance Enable radio button to enable the parameter options in this area.

4. Click on 2 Leads (1 phase) and check the Res Leads box.  Notice that the list of leads to test in the Test Results 
section changes to include only one set (Lead 1–2).  

5. You can leave the Resistance Enable radio button active if you choose to run resistance tests, or turn it off if 
not.  However, you must ensure that the 2 Leads (1 phase) radio button is selected and the Res Leads box is 
checked to enable single-phase testing. 

NOTE:  The Temperature/Resistance Test setup window is the only place where you specifically define parameters to 

enable single-phase testing.  All other tests function in the same manner as they would for 3-phase testing, except 

that the software knows to use only test leads 1 and 2 during those testing steps.

  

Fig 111: Setting up the Resistance Test parameters for single-phase testing.

6. Set up parameters for DC and Surge tests as needed for the device using the respective setup windows.  No 
specific parameter in either window will directly affect single-phase testing.  The tests are set up and conducted 
the same as they would be for 3-phase testing, except that only leads 1 and 2 will be used.
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Single-coil Testing

NOTE:  The processes described in this section apply to testing coils with normal impedance.  For testing low-

impedance devices, refer to chapter 6, ”Using the Baker AT101 ZTX with Baker AWA-IV Analyzers” on page 119.

Go/No Go Surge Testing

This example describes a common application of conducting Go/No Go surge tests on a batch/lot of coils. While 

single coils can be subjected to a full battery of tests, only surge testing is used in this example process.  

You can create a separate Test ID and a Motor ID to use during the testing process if you prefer, but it is not 

necessary.  Everything in the process happens within the Surge Test window, and editing a Test ID is not part of the 

process.

Likewise, a dedicated Motor ID is not required because test information is not saved.  Of course, you have the option 

to create and use dedicated IDs,  but the process is a bit more complicated using that approach.  If you prefer to 

collect testing data during the process, or want to use a process that can be re-used over time, consider using the 

Single-coil Testing Using a Test Reference method, which is described in the next section.

1. Select a Motor ID to start the process then click on the Tests tab.

2. The Surge Test can be ON or OFF.  It has not effect on the test process.

Fig 112: Selecting single coil testing Motor ID and Test ID.

3. Click on the test configuration button (volts) in the Surge Test row.

4. The Surge Test window opens.
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5. Ensure that the test parameters are properly set up for the coil type you are testing. 

6. Check the L-L EAR box and set your tolerance as needed.  We use 3% in this example—a common tolerance for 
coil comparison testing.

7. Check the P-P EAR box and set a tolerance that will allow for a slow but practical ramping speed.

8. For this example, because we are testing 460-volt coils, we set a Surge Value of 2000 volts.

Fig 113: Setting parameter values for Surge testing.

9. Conduct the first test on a known good coil so that you can acquire a good baseline for all coils to be tested in 
the lot.  

NOTE:  This is not the same as establishing a reference wave for Test-Ref EAR%.  That procedure and evaluation 

technique is covered in the following section.

10. Connect the high-voltage test leads to the first coil to be tested as described in the table below.

Table 2: AWA-IV high-voltage test lead connections to device under test for single-coil Surge testing; first 

coil tested.

Test Lead 1 Test Lead 2 Test Lead 3 Ground Lead

Coil lead 1 Coil lead 2 Not Connected Not Connected
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11. Click on Lead 1 in the Run Surge section.

12. The software will automatically ramp to the defined Surge Voltage level.

Fig 114: Running Surge test on known-good coil, Lead 1.

13. Inspect the waveform and value for L1 in the Peak Voltage area.  When you are satisfied that you have a good 
baseline, disconnect the test leads from the coil and connect the next coil to be tested.  A Surge test is not run on 
Lead 2 for the first coil.

CAUTION:  Ensure that the Leads Energized light turns off before removing leads from the coil.

14. Connect the high-voltage test leads to the rest of the coils to be tested (in turn) as described in the table below.

Table 3: AWA-IV high-voltage test lead connections to device under test for single-coil Surge testing; all 

subsequent coils being tested.

Test Lead 1 Test Lead 2 Test Lead 3 Ground Lead

Coil lead 2 Coil lead 1 Not Connected Not Connected
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15. Click on Lead 2 in the Run Surge section.

16. The software will automatically ramp to the defined Surge Voltage level.

Fig 115: Running Surge test on subsequent coils; Lead 2.

17. Inspect the waveform and value for L2 in the Peak Voltage area.  Inspect the 1-2 value in the L-L EAR% section.  

18. If the coil fails, mark the coil according to your organization’s testing process and record relevant information as 
needed.  (This process is external to Baker AWA-IV recording of test results.  Results are not saved to the AWA-IV 
when using this process.)

19. If you are satisfied that you have a good test result, disconnect the test leads from the coil, connect the next coil 
to be tested, and repeat the testing process from step 14 for the new coil.

20. Repeat this process for each new coil until you have tested all coils.

21. Click on Close to leave the Surge Test window when you have completed your testing.

Alternative Go/No Go Surge Testing Method

If you want to shave a few seconds off of testing each coil (coils 2–X), check the ZS Override box when defining 

your test parameters.  Then, after ramping up the surge voltage for the first coil, the ZS Override feature will be used 

when testing the remaining coils.  

Using this method, the process becomes fully manual.  The L1 and L2 physical buttons on the AWA front panel are 

used to activate the tests rather than the Lead 1 and Lead 2 buttons in the software’s Run Surge section.

1. To test the first coil, press and hold the L1 button on the AWA front panel.

2. Turn the Voltage Output Control knob counterclockwise to start at zero volts; then slowly turn the knob 
clockwise to ramp up to the target surge voltage.  (Ramping too fast can cause an errant P-P EAR failure.)  

3. After a minimum of five surge pulses, remove the test leads from coil 1 and attach them to coil 2 as described 
above.
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4. Press the L2 button on the AWA front panel.  The Zero-start Override feature will immediately apply the target 
voltage level.  Inspect the waveform and L-L EAR values, and complete the testing process as described above.

WARNING:  When using the Zero-start Override feature, target voltage levels will be immediately applied 

to the device when the L2 button is pressed.  Ensure that no one contacts the device or tester leads to 

avoid injury.

Additionally, when using this feature, do not move the Voltage Output Control knob.  Changing the knob 

position will result in an improper test voltage level, which could damage the device under test.

Test Procedures

106 Baker AWA-IV 71-015 EN V16 User Guide       www.megger.com



Single-coil Testing Using a Test Reference

This application involves setting up a new Test ID that will include a test reference waveform for comparison.  The test 

reference is used during the immediate testing process and will be saved to re-use when testing other devices of this 

type in the future.   Using a test reference ensures that all devices of the same type are measured against a known-

good coil, establishing a consistent baseline for comparison.   

1. Connect the high-voltage test leads to a known-good coil as described in the table below.

Table 4: AWA-IV high-voltage test lead connections to device under test for single-coil Surge testing; 

reference coil.

Test Lead 1 Test Lead 2 Test Lead 3 Ground Lead

Coil lead 1 Coil lead 2 Not Connected Not Connected

Setting up the Test ID

1. Create a separate Test ID and a Motor ID to use during the testing process.  The Motor ID and Test ID can then 

be re-used when testing other devices of this type.  Refer to “Creating a Test ID” on page 84 and “Creating a 

Motor ID” on page 88 for details on these processes.    

2. For this example, the initial Test ID setup includes parameter settings as shown in the figure below.

3. Ensure that your test parameters are properly set up for the coil type you are testing.  

   

Fig 116: Creating Test ID; setting initial Surge Test parameters.

4. Check L-L EAR box and set your tolerance as needed.  We use 3% in this example, which is a commonly used 
tolerance for coil comparison testing.

5. Check the P-P EAR box and set a tolerance that will allow for a slow, but practical ramping speed.

6. For this example, because we are testing 460-volt coils, we set a Surge Value of 2000 volts.

7. Notice that the Test-REF and EAR(%) elements are grayed out (inactive at this time).

8. When the settings have been defined, click on Close.  

9. In the Tests tab, click on Save then uncheck the Edit Test ID box to complete the initial Test ID setup.
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10. Ensure that the parameters enabling single-phase testing have been set up in the Temperature/Resistance Test 
setup window as described in “Single-phase Testing” on page 101.    

11. Select the new Motor ID you just created then open the Tests tab.  The Motor ID and Test ID should be selected, 
similarly to the example shown below.

12. Ensure that the proper Test ID appears in the Test ID field and that at least the Surge Test is turned ON.  

NOTE: Other tests can be included when testing single coils.  This example focuses on the Surge test elements, and 

specifically setting a Test Reference.

Fig 117: Selecting single coil testing Motor ID and Test ID; editing to set test reference.

13. Check the Edit Test ID box.

14. Click on the Run Auto Test button.

15. The software will display the Safe to Turn On dialog box, instructing you to connect the high-voltage test leads 
then press the MΩ and L3 buttons on the front of the tester.  
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16. The software will automatically run the Surge test on leads 1 and 2.  As it does, examine the voltage level and 
waveform to ensure that you are getting a good reference.

  

Fig 118: Ramping voltage to acquire Lead 1 waveform for test reference.

17. When both leads have been tested, the software will automatically close the Surge Tests window and return you 
to the Tests tab.

18. The software will ask if you want to save the test result as a reference.

19. Click Yes if you are satisfied that you have a good reference level and waveform.

20. Click on Save to ensure that your new settings are retained.

21. Open the Surge Test window again.  You should see that the Test-Ref EAR elements have been enabled.  At this 
time, you should ensure that the EAR percentage is set to the value you need.  An EAR of 3% is commonly used 
for coil comparison purposes.

  

Fig 119: Ramping voltage to acquire Lead 1

22. After making final adjustments, click on Close.
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23. In the Tests tab, click on Save to ensure that your new settings are retained.

24. Uncheck the Edit Test ID box if it is still highlighted (red).  

25. You are now ready to test additional coils using the test reference acquired.

26. To continue testing additional coils, disconnect the coil used to acquire the reference and set it aside.

CAUTION:  Ensure that the Leads Energized light turns off before removing leads from the coil.

27. Connect the next coil to be tested to the high-voltage test cables as described in the table below.

Table 5: AWA-IV high-voltage test lead connections to device under test for single-coil Surge testing.

Test Lead 1 Test Lead 2 Test Lead 3 Ground Lead

Coil lead 1 Coil lead 2 Not Connected Not Connected

28. Click on the Run Auto Test button and follow the prompts provided by the tester for executing the tests.

  

Fig 120: Testing coils using the test reference.

29. Both leads will be tested and the Surge Test window will close automatically.  The test data is automatically saved 
for each test.

30. Disconnect the coil from the tester.

31. If you need to test another coil, connect it to the tester as described above and repeat the process starting from 
step 27.
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Printing Reports

The Baker AWA-IV’s software includes report generation features so you can provide test results to managers, 

customers, and repair personnel as required.  Reports containing test data, nameplate data, application data, and 

more can be sent to a printer, or they can be printed to a Microsoft Word file or other file formats as needed or 

preferred.  For convenience, you can print reports from a desktop computer rather than from the analyzer itself.

Fig 121: Report generator.

Start the Report Generator by: 

1. Clicking on File then Print.

2. Holding down the Ctrl key on your keyboard and pressing the P key.

3. Clicking on the printer icon in the upper left section of the Main window.  
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The Select Filter(s) section of the Report Generator contains filters you can use to select which tests results you 

want to print.   Select the current motor and test result, or use any combination of the other filters as needed.  For 

example, you can select a date range and all motors that failed any test during the selected test range.  

When you need to print data for several motors, you can select and print them one at a time, or you can select all 

records that match specified criteria using the report filters.  Different combinations of the motor’s location fields, 

date range, and/or pass/fail criteria help you select specific groups of reports.  

Fig 122: Select Filters section of the Report Generator window.

After you select your test results, you will use the Select Reports section of the Report Generator window to select 

the report type that you want to print.  You have several choices including Nameplate, Application, Summary, Surge, 

PI, and Step Ramp Voltage to name a few.  You can also add a report title, which will appear in the final report.

After selecting the report type you need, click on the Output Report To drop-down list to select the report format 

needed.  Your options include: RTF - Rich Text Format, MHTML (web archive), MS Word (if installed), Printer, Comma 

Delimited Text File, and Ref to Bar EAR CSV File.

Fig 123: Print selected reports.

In the simplest case, you will want to print the test result being reviewed.  The motor and test result selected in the 

main program will appear to the right of the Current motor/test checkbox in the Select Filter(s) section.   Ensure 

that box is checked then check the box(es) in the Select Reports section for the type of report you need.  Select 

Printer from the Output Report To drop-down list then click on the Create Report button.

In other cases, you will want to print a more specific set of reports and/or data for a collection of motors tested.  Just 

be sure to carefully consider what you need so you can generate the results required.  
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Using an example where an electrician tests many different motors during the day and needs to print reports for 

failed motors before going home.  In this case, the Report Generator window should be configured as shown below.  

1. The Select Filter(s) section has the Date Range selected and both dates are set to 3/17/2017 so the software 

will only include test results for that day.  

2. The Pass/Fail filter is selected along with the FAIL radio button so that results for motors that have failed one or 
more tests will be included.  Passed tests will not be included because that radio button is not selected.

3. In the Select Reports section, the Results Summary with Surge Summary is selected.  The Printer is selected as 
the output. 

4. When the Create Report button is clicked, the Report Generator will go through the entire database looking for 
failed tests that occurred on 3/17/2017.  

5. When the software completes its search, a dialog box appears showing how many records were selected.  
Clicking on Cancel stops the process; clicking on Continue completes the report generation and printing 
process.

Fig 124: Report generation example

NOTE: The Report Generator can be set up so that a large number of reports are created.  Printing out a large 

number of reports can be very time consuming, especially when going to Microsoft Word.   The Report Generator 

will show how many test results are chosen; however, this is not the number of pages that will be printed.   That 

depends on the number of reports chosen.

The program can also print reports to Microsoft Word—if it is installed on the analyzer—or on a desktop computer 

running the software.  This feature provides a way to annotate reports by adding text to the Word document as 

required.  For example, a comment regarding the vibration level of the motor before it was turned off can be added 

to the Word document.  This feature should also be used with discretion because printing reports to MS Word takes 

time; selecting a lot of records to print means the system would be tied up until all records can be transferred to the 

Word document.
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A example Word report is shown below.  Each section is a Word table; except the surge waveform, which is a 

bitmap.  The reports can be modified by adding text between the tables or the data tables can be cut and pasted 

into other documents.

Fig 125: Example MS Word report with nameplate, summary, and surge graphic.
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In the following example, we see a report that includes the Results Summary and the Surge Summary.

Fig 126: Example MS Word Report with nested surge results and graphics.

Files can be saved in other formats including MHTML (MIME HMTL / web archive), a comma delimited text file, and 

Ref to Bar EAR CSV file.
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Creating a New Motor Voltage Class

If an appropriate motor class is not available for your specific motor, you can create a new one following this 

procedure.

1. Open the Tests tab.

2. Check the Edit Test ID box and enter password as needed.

3. Click the Add button.

4. Click the Add Blank Test ID radio button to enable the fields below.

5. In the Target Motor Voltage Class field, enter the value for the new motor class needed.  In the following 
example, we created a 230 Volt class.  

6. You do not need to enter anything in the Enter new Test ID field, but you can do so if you plan to create a new 
Test ID as well.

Fig 127: Creating a new motor voltage class via the Create New Test ID dialog.

7. Click on the Add Voltage Class button then click Yes in the confirmation dialog that appears next.

The new motor voltage class will be added to the list for future use.
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Surge Testing Notes and Recommendations

The following notes are provided for additional insight into specific Surge testing issues and situations.

Surge Testing with Rotor Removed (typically motor shop testing)

 � Enable L-L EAR and set tolerance to 2% (form wound motor).

 � Enable LL-EAR and set tolerance to 3% (random wound motor).

 � Enable P-P EAR and set  tolerance to 10%.

 � Disable zero crossing.

Surge Testing with Rotor Installed (typically field testing)

 � Enable P-P EAR and set tolerance to 10%.

 � Disable L-L EAR when testing in the field.

 � Disable zero crossing.

Surge Testing DC Motors

 � Disable P-P EAR.

 � Enable L-L EAR when testing in the field.

 � Disable zero crossing.

False P-P EAR Failures

In some motors, the waveform will slowly migrate to the left as the voltage is increased.  If the voltage is increased 

at too fast a rate, the movement can cause the P-P EAR to generate a value greater than 10%, causing the tester to 

generate a false failure.  To eliminate this nuisance trip, increase the surge test voltage in 25 volt increments.

Surge Test Underpowered

The Surge test is load dependent.  Anything that adds capacitance to the motor under test will increase load on the 

tester.  If the motor draws more energy than the tester can deliver, the test will fall short of the recommended test 

voltage.  The will be realized when the energy bar on the right side of the Surge test window tops out and the surge 

voltage stop below the expected test voltage.  If this occurs, a larger surge tester with more joules of energy should 

be used.
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Surge Testing through Capacitors

When Surge testing a motor, all capacitors should be removed or the ground should be lifted.  Otherwise, the 

capacitors will absorb the surge pulse, preventing it from entering the coils, and negating the diagnostic value of the 

test.

Fig 128: Removing capacitors from motor circuit to prevent surge pulse absorption.

Test Procedures

118 Baker AWA-IV 71-015 EN V16 User Guide       www.megger.com



6 — Using the Baker AT101 ZTX with Baker AWA-IV Analyzers

NOTE:  This chapter describes how to combine the Baker AWA-IV analyzer with a Baker AT101 ZTX to test low-

impedance devices.  The Baker PPX 30A power pack includes Baker ZTX functionality, so it also can be used to this 

end.  For information on using the Baker AWA-IV analyzer with a power pack for this and other functionality, refer 

to the Baker Power Packs User Guide.

Low-impedance Armature or Coil Testing

Some coils or armature windings have very low impedance and cannot be tested with just the AWA host.  Baker 

AT101 ZTX functionality is required to test these coils.  Armatures, DC series fields, pole face windings, and interpoles 

are common examples of low-impedance circuits that require the ZTX functionality for proper evaluation.  When 

combined with a Baker AT101 ZTX, the Baker AWA accommodates testing of low-impedance coils and armatures. 

The Baker  AT101 ZTX combines hardware and software to help you determine insulation integrity of low-impedance 

armatures or coils.  The hardware includes the impedance-matching transformer and fixtures.  The software facilitates 

the acquisition of waveforms and comparison to a reference. 

NOTE:   The remainder of this chapter uses armature testing as the example base.  However, the principles and 

general process apply to all other low-impedance devices.

Principles of Armature Insulation Testing 

Armatures from DC motors are wound in many different ways, and some are rather complicated.  However, testing 

armature insulation is actually very simple.  The insulation of the copper to the steel or ground wall is evaluated using 

the HiPot test, while the turn insulation is evaluated using the surge test.

The ground wall insulation includes the insulation isolating the commutator bars from ground along with the 

insulation isolating the copper turns in the rotor slots.  A unit can also have “equalizer bars” that connect opposing 

commutator bars, which are also isolated from the steel armature core.

The armature winding consists of a few turns of high capacity conductors that span slots in the rotor and connect to 

the commutator bars.  These conductors are insulated from each other with the “turn insulation.”  Due to vibration, 

thermal expansion, chemical attack, and other factors the turn insulation can degrade, resulting in turns shorting to 

each other.

Because the inductance of armature winding turns is so low, a special impedance-matching transformer is used to 

convert the output of a Baker AWA-IV surge tester to voltage and current levels desirable for surge testing low-

inductance armature windings.  Additionally, armature windings are all in parallel, further reducing the bar-to-bar 

inductance, making the impedance-matching transformer all the more important.

A change in the surge waveform of a shorted coil as compared to a reference waveform indicates an arcing or 

shorted armature winding.

Typically, the reference waveform is acquired from the first bar (coil) tested.  Waveforms collected from subsequent 

bars are compared to the reference bar.  According to EASA guidelines, waveforms with a five percent or greater 

difference should be considered suspect. 
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Connecting Baker AWA-IV to the Baker ZTX Accessory

1. Connect the AUX cable to the AUX/PP connector on the front panel of the Baker AWA-IV and the AUX 

connector on the front panel of the Baker ZTX.

Fig 129: Connect AUX cable between AWA and ZTX.

Item Description

1 AUX cable connected to ZTX and AWA front panel receptacles.

2 Test cables connect to rear of ZTX (see image below).

2. Connect Baker AWA-IV test lead 1 to the TEST LEAD 1 receptacle located on the back of the Baker ZTX.

3. Connect Baker AWA-IV test lead 2 and 3, and the ground lead to the GND/L2/L3 LEADS receptacle on the back 
of the Baker ZTX.

Fig 130: Connect AWA test leads to ZTX.
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4. Connect the ATF-5000 armature testing accessory to the FOOT SWITCH connector on the front panel of the 
Baker ZTX.

5. Connect the ATF-5000 surge and sense cables to the Baker ZTX surge and sense cables (round connectors).

6. Use the thumb wheel to adjust the width of the bar-bar armature test accessory to fit the width of two adjacent 
bars on the armature being tested.  ATF-5000 contacts should be centered within each bar.

Fig 131: ATF-5000 bar-to-bar armature test accessory.

Item Description

1 Round connectors to ZTX surge (large) and sense (small) connectors.

2 Footswitch connector to front panel receptacle.

NOTE: Refer to the ATF-5000 User Manual for more information on using and maintaining the accessory.  Other 

accessories, such as test probes, can also be used during bar-to-bar testing.

Armature Preparation

1. Identify the bar on the armature to be used as “Bar 1.”

2. It is also helpful to label every 5th or 10th bar.

3. Insulating tape works well for labeling the bars.
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Setting Up a Surge Test for Armature Bar-to-bar Testing

1. First, you must create a Motor ID for the armature to be tested.  You can easily do this by starting with the Motor 

ID for the armature’s motor, allowing you to re-use most of the nameplate information already entered.  This 

information will also help you identify the target voltage needed for your armature test.

2. Save the new Motor ID with a name similar to the whole motor, but with “ARM” or “armature” attached for 
easier distinction.

3. Ensure that the new armature Motor ID is selected, then create a new Test ID to specifically test armatures.  For 
example, create a new test ID called “Arm 600 VDC.”  After creating the new Test ID, the Tests tab will look 
similar to the example below.

4. Check the Edit Test ID box.

5. Click on the ON/OFF button in the Surge Test section to turn Surge test ON.

Fig 132: Armature test set up via Surge Test setup window..

6. Click on the test configuration button at the end of the Surge Test section.  The Surge Test setup window will 
appear.
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7. Enter a value for the Surge Voltage based on your company and/or standards body recommendations for the 
motor armature being tested.  For this example, we use 600 volts.

8. Check the P-P EAR box.

9. Ensure that the Enable PP box is not checked. 

10. Check the ARM box as shown in the example below.   

Fig 133: Enable Baker ZTX by checking Arm box.

11. Immediately after you check the Arm box, the Surge Test setup window will change to the Surge Test Armature 
setup window as shown in the example below.  

NOTE: If the ARM check box is not visible, the Baker AWA-IV being used is not configured to work with a Baker ZTX.
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12. Ensure that the Target Voltage is set as needed for your armature.

13. Set the Volts/Div value to Auto.  The analyzer will auto-range for the reference wave.

Fig 134:  Surge Test window showing tester is Baker  ZTX compatible.

14. Change the reference-to-bar EAR% Limit as needed; the default is set to 10%.

15. Click on the Close button to return to the Main window, Tests tab.

16. Click the Save button to save the parameter settings made for the Test ID.

17. Click the Edit Test ID check box to turn off Test ID editing.

NOTE: The bar-to-bar surge test is a manual test that cannot be performed using the automatic features of the Baker 

AWA-IV.  Complete procedures for creating Test IDs and Motor IDs are provided earlier in this manual.
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Running the Manual Armature Surge Test Using the Baker ZTX

NOTE: In most applications, you will need help from another person to complete at least the first part of this test 

process: obtaining the reference waveform.  One person will operate the fixture on the armature while the other 

operates the tester.

CAUTION:  Ensure that both operators clearly understand the process and how to use the software.  The fixture/

probe operator must know how to properly use the ATF-5000 or test probes to avoid injury from electrical shock, or 

damage to the test equipment or the unit under test.   

1. For this example, a new Motor ID for the armature and a new Test ID have been created.  For your application, 

ensure that you have selected the proper Motor ID and Test ID for your armature. 

2. From the Tests tab, ensure that the selected Test ID has the Surge Test turned ON and that the section is labeled 
“Surge Test Using AT101ZTX.” 

3. Click on the test configuration button at the end of the Surge Test row to open the Surge Test setup window.  
Because this is a manual test, it is run from the Surge Test - Armature window.

4. The AWA operator must ensure that the Voltage Output Control knob on the AWA front panel is at zero; 
turned fully counter-clockwise.

5. The armature operator will position the test fixture (or probes) on the first bar and the second bar (adjacent to 
the right); bar 1 will be the reference bar.  Bars are tested in a progressing sequence of 1–2, 2–3, 3–4, and so on.

6. When both operators are ready, the armature operator will hold down one of the test buttons on the ATF-5000 
(or footswitch if using probes), then the AWA operator will ramp the voltage to the desired level.

7. After the first bar is tested and you are satisfied that you have a good reference waveform, the AWA operator 
will click on the Set Ref button.  This establishes the reference for the remainder of the test and sets the tester’s 
target voltage level.  

8. In the following example, the target waveform is acquired from bar 1, so the Set Ref button is pressed.

Fig 135: Reference wave EAR.
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9. A dialog box will appear with a warning that the output voltage will automatically start at the target voltage level 
for all subsequent test, overriding the zero-volt interlock feature.  

Fig 136: Zero-start Override warning message.

10. Move the test fixture to the second bar pairing (2–3). 

11. Press the Test button or footswitch.  The analyzer will energize Lead 1 at the preset voltage and the waveform 
will be displayed on the screen as the red wave. The reference is also displayed as the blue waveform.  A 
reference-to-bar EAR value will be displayed in the Ref Bar EAR field. 

12. If the EAR percentage is greater than the tolerance, the field background will turn red indicating a failed test.  If 
the EAR percentage is under or equal to the tolerance, the background of the Ref-Bar EAR box will be white, 
indicating a passing test.

13. When you are satisfied with the waveform, release the fixture’s test button or footswitch.  The EAR percentage 
will be saved and an inset bar graph will be displayed depicting the EAR percentage versus the reference bar’s 
waveform.  If the bar failed, the EAR bar on the graph will be red.

14. Up to three additional waveforms can be saved during the testing process.  If a bar fails or is of interest, click 
on one of the Save button in the Save Waveforms section at the top of the screen and that waveform will be 
saved along with its bar number; otherwise, only the reference-to-bar EAR percentage for the bar will be saved.

15. Continue to move the test fixture to the next bar and repeat steps 10–14 for each bar until all bars have been 
tested.  A maximum of 1,024 bars can be tested.

16. If at any time before you save the full test results you want to retest a bar, you can enter that bar number directly 
into the Bar Control field, or use the up and down arrows to navigate to the bar number, and retest as needed.  
Retesting will overwrite the previous data for that bar.  

17. The Total Bars Tested number gives you the number of the last bar tested.  Add one to that number to resume 
testing where you left off.
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18. After all bars have been tested, click the Close button.  The software will return you to the Main view Tests tab, 
which will look similar to the example below.

19. Because this is not an automatic test, you must click on the yellow Save Results button to save the test results to 
the database so it can be recalled for further viewing and to print reports.

Fig 137: Main window Tests tab after testing; Save Results.
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Reviewing Test Results and Data

1. Click on the Data tab, Surge view (bottom tab) to review the test results. The graph will display the reference 

waveform in black and up to three saved waveforms in red, blue, and yellow. 

2. The Surge view will also display the saved bars number, peak voltage, and reference-to-bar EAR. 

3. Click on the Enlarge button for a larger version of the surge graph. 

4. Click on the EAR Graph button for a bar graph of the reference-to-bar EAR results for all bars tested.

 

Fig 138: Armature Surge test results; Data tab in Surge view.
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Fig 139: Bar-to-Bar EAR graph.

This graph has zoom capabilities that allow you to look more closely at a section of bars.  

5. Hold the left mouse button down and drag the cursor to draw a box around the bars you want to enlarge.  
When you release the left mouse button, the graph will automatically rescale and display the bars inside of the 
box you drew. 

6. To reset the graph click on the Reset button and all bars will be displayed.
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Printing Reports

To print reports for bar-to-bar surge data, click on the printer icon on the upper left of the Main window.  The Report 

Generator window will appear.

1. Select the filter(s) you want to use.

2. Check the Surge-Comparison and EAR Graph boxes.

3. Select the output you want to use.

4. Click on the Create Report button

A report similar to the example below is generated.

The report generator determines which test results are collected via the normal surge testing process and which are 

taken using the Baker ZTX.  It then prints the appropriate graphs for the results and reports chosen.

Fig 140: Example report generated using parameters set above.

Using the Baker AT101 ZTX with Baker AWA-IV Analyzers

130 Baker AWA-IV 71-015 EN V16 User Guide       www.megger.com



Generating CSV Files

The report generator provides you with the option to print the reference-to-bar EAR values to a comma separated 

values (CSV) file for easy import in to a spreadsheet application.  To utilize this feature:

1. Start the report generator by clicking File, Print or by clicking on the Print icon in the top left of the Main 

window.

2. Select the desired filter options.

3. Using the Output Report To drop-down list, select “Ref to Bar EAR CSV” file.

Fig 141: Setting Output Report To Ref to Bar EAR CSV.

4. Click on the Print Text File button.  This will open a File Save dialog box.

5. Enter the name of the CSV file for data output. Click the Save button.

6. The selected records will be written to the file named with the extension of .txt.

Using the Baker AT101 ZTX with Baker AWA-IV Analyzers
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Appendix A — Baker AWA-IV Troubleshooting

Please review this section before you contact Megger Baker Instruments technical support, or return the unit.

Self-help and Diagnostics

Problems in testing often crop up.  If you are experiencing a problem and believe it might be with the analyzer, please 

take the following steps before calling or returning the unit.

By performing these procedures and having the requested information available, Megger Baker Instruments technical 

support will be able to better assess your situation and provide the appropriate response.  You can contact Megger 

Baker Instruments technical support toll-free at 800-752-8272 or 970-282-1200 for assistance.  You can also send an 

email to baker.tech-support@megger.com with questions or to request assistance.

Repair Parts

WARNING: Electrical shock hazard can be present when performing repairs.  Ensure that all precautions 

are taken to avoid injury or death from severe electrical shock.

During repairs, do not substitute any parts.  Use only factory-supplied parts to minimize safety hazards.

Do not modify or repair test leads in any way.  Defective, damaged, or broken test leads must be replaced with 

factory-authorized parts to ensure safe operation and maintain performance specifications.

Step #1: Basic Information

Record all basic analyzer information including:

 � Model number

 � Serial number

 � Product number

 � Software version number

NOTE:  All information above except for software version number is located on the rear panel product label.  

Software version can be found by starting the software and clicking on the Help-About Baker AWA-IV… menu item.  

If the analyzer has special options installed, please note these.  Any analyzer information derived is helpful! A great 

tool would be a printout or sketch of the waveforms displayed on the analyzer.

Step #2: Applications or Service Problem?

Generally, if a problem is noted only when testing a specific motor/generator or other coil type, then applications 

would be involved.  See “Applications: What to do first”  Please call the sales department for applications assistance.

If the problem is not associated with any one type of motor/generator, or other coil type, then service would be 

involved.  See “Service: What to do first”
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Applications: What to do First

Review the section on common application problems.  Please have basic information about the analyzer and specific 

information about the motor being tested available when calling or faxing to assist sales/support personnel in 

determining a solution to the problem.

Examples:

 � Hp rating

 � kW rating

 � RPM rating

 � Operating voltage and current

 � How the item being tested is wound and/or number and type of coils

 � Application of motor/generator

In short, all information from the motor nameplate would be helpful.  A great tool is a printout or sketch of the 

waveforms displayed on the analyzer.  

If a FAX is available, send a draft to 970-282-1010, attention: Applications.

Common Application Problems

There are a few common application-related problems.  Please review the following cases.

1. The Baker AWA-IV will not give the desired output test voltage for the apparatus under test.

1.1.  The test motor may be too large for the analyzer being used.  The impedance of the windings may be too 

low.

1.2.  The Baker AWA-IV may be at fault in this case.  Do not continue testing until you contact the Megger Baker 

Instruments product service department.

2. Separation of compared surge wave patterns is seen when surge testing known-good coils, or brand new motors 
or windings.  Often, separation is seen in all three comparisons for three phase motors, but to varying degrees.

2.1.  Generally, this is caused by unbalanced impedance in windings, which is inherent to the design.  It most 

commonly occurs in basket or concentric wound motors.  The phases are not magnetically balanced due to 

different coil lengths.

2.2.  When acceptance testing, waveforms that are separated because of improper turn counts, misconnections, 

or reversed winding groups may be seen.

2.3.  This condition may also be seen in DC fields or rotating poles.  Coils being compared must be tested in 

identical configurations.

2.4.  On very large equipment, slight differences in capacitance to ground may be the cause.  At low voltage 

levels, begin the test again with the black ground lead removed from the motor frame.  If the separations 

disappear, the problem was capacitance to ground.  Be sure the winding has passed the DC tests before 

doing the Surge test.

3. There is no dampened sinusoidal wave pattern on the display when testing a coil.  The wave pattern rises on the 
left and then slowly drops as it trails off to the right of the screen.  It may or may not cross the zero/base line.

3.1.  The coil under test is probably too high an impedance to get a good working pattern.  The coil may be very 

high in resistance.  

3.2.  A broken test lead may be the cause.  Under heavy use, test leads should be checked weekly to ensure that 

there is no breakage.  Grasp the boot and clip in one hand while pulling on the lead with the other hand.  A 

broken lead will stretch, whereas a good lead will not.
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Precautions for Proper Operation

 � Never raise the output control to attain a display from a blank screen.

 � Never attempt simulated problems by disconnecting the leads and positioning them to arc against each other.

 � Never come in contact with the item being tested and the test leads, or with the analyzer and the item being 
tested.

 � Never attempt a two-party operation.  

 � Never attempt a burn-out of a detected fault with the analyzer.

 � Always know what test is being performed and when.

Service: What to do First

Because history has shown that several simple solutions that do not require return of a unit may arise, please perform 

the following checks.

Open Condition Display

Note the figure below.  Is the surge waveform like this?

Fig 142: Open condition.

If yes, the unit may have at least one broken test lead causing an open condition.  In most cases, the test lead that is 

under test and gives this pattern is the broken lead.  

Verify this by pulling on the book/clip assembly of the lead.  A broken test lead will stretch.  If it does not, repeat 

this procedure at one foot intervals for the length of the lead.  If the leads of the analyzer are good, check the 

connections and continuity of the test winding.

HiPot Display Checks

1. The HiPot display shows only the voltage or current bar.  One of three problems might exist.

1.1. The item being tested is in fact faulty and has either low insulation resistance or open connections.

1.2. The Baker AWA-IV has an internal problem.

1.3. The analyzer has a test lead problem as shown above for an open condition.

Disconnect the test leads from the motor and isolate the analyzer from any grounded surface.  Reduce the output 

to minimum and attempt a HiPot test with an open lead condition.  Your display should indicate a rising voltage bar.  

The current bar may rise slightly, but fall back to zero when the output increase is stopped.  

 

www.megger.com 135



NOTE:   It is not necessary to run the output control at a high level to determine if the Baker AWA-IV is working 

properly.

If the display still shows no voltage bar, call the service department.  Use a meter to confirm the insulation resistance 

of the device being tested.

Current bar operation can be tested by shorting test lead 1 to the ground lead.  Under this condition, the voltage 

bar will not move off the zero line and the current bar should rise very rapidly and activate the HiPot overcurrent trip 

warning light (HiPot trip).  If the HiPot Trip light does not light, check for open test leads at either test lead 1 or the 

ground lead (see “Open ground check” below).  If the problem persists, contact the service department.

HiPot Overcurrent Trip Check

Either the HiPot trip lamp does not activate under known shorted conditions, or it will not go out when test is 

discontinued.

Call the service department immediately for assistance.  Please record information off the unit and the specific 

problem prior to calling.

Open Ground Check

The open ground check feature provides an indication that the AC power source is not properly grounded.  The 

presence of an open ground warning limits operation of high-voltage testing.

Answer these questions:

 � Has the unit recently been moved to a new location where the outlet might not be grounded?

 � Is the unit being operated in a field where the AC power source is unknown?

 � Is the unit being operated on a scope cart that has its own outlet or power source?

 � Is the unit being operated using a two-wire extension cord?

 � Is the unit being operated on a transformer-isolated circuit?

If you answer “yes” to any of these questions, the unit is probably operational and indicating that there is open AC 

line ground connection.

For the first three questions above, use an outlet analyzer to ensure proper wiring connections to the outlet.  

Limited Output Surge Waveform

The display shows a limited output (amplitude) surge waveform.  The display rises normally, but stops at some point.  

Alternatively, you must continually increase the output control for successive tests to achieve the same output test 

amplitude.

Call the service department immediately for assistance on this or any other abnormal condition noted.  Please record 

basic information from the analyzer and the specific problem prior to calling.

Proper Storage of Leads/Unit

After the analyzer has been correctly shut down, the high-voltage and resistance leads can be placed back into the 

nylon bag with the power cord.  This can be carefully placed on top of the touchscreen and the lid closed for storage.  

Not placing the leads in the nylon, bag and putting them directly onto the touchscreen can break or damage the 

screen.  If the screen is damaged, the unit will not operate properly and it will have to be sent to Megger Baker 

Instruments for replacement.  Although these units come with a comprehensive one-year warranty, exterior damage 

of this type is not covered.

Take care to keep the unit dry.  The analyzer should not be stored in any location where water entry to the analyzer 

can occur.  Humidity will also affect the operation of the analyzer.
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Checking Test Leads for Broken Sections

Either prior to using the analyzer or at least once a month, inspect each test lead for broken sections.  If the analyzer 

has a broken lead, it will not work properly and could yield erroneous results.  The typical spots where leads break 

are within the first six inches from the analyzer panel strain reliefs and 12–18 inches from the clips.  There are two 

methods to check for breaks in the leads: a manual check and an overcurrent trip test.

Manual Break Check

1. Inspect the lead wire for any cuts or nicks in the wire sheath.

2. Take the clip in one hand and grip the lead wire in the other had approximately 12–18 inches from the clip.

3. Grip the lead wire approximately six inches from the strain relief on the analyzer.

4. Steadily, pull the lead.  If the lead stretches, it is broken.  If it does not have any give, it is good.

Overcurrent Trip Test

The black ground lead is the most commonly broken lead.  This is an easy test to verify if the black lead is broken.

1. Connect all leads together (clip to clip) (three red, one black ground).

2. Place analyzer in either Meg-Ohm or DC HiPot mode.  Initiate test.

3. If the analyzer immediately shows an overcurrent trip, the black test lead is good.  If the analyzer continues to 
ramp up to the test voltage, the black test lead is broken.

Open Circuit Test to Verify Analyzer Operation

While doing periodic testing, there are some instances that the analyzer will immediately trip when first initiating 

testing.  When this occurs, there is generally some question by the operator if the motor is truly bad or if the analyzer 

is operating correctly.  A simple open circuit test verifies analyzer operation.

1. Remove all test leads from the motor being tested.

2. Store all leads in a safe place: on the floor, over the edges of a plastic trash can, and so on.  Ensure that the test 
clips do not touch.

3. Place the black lead away from the red leads.

4. Initiate either a Meg-Ohm or a DC HiPot test.

5. If the analyzer is operating correctly, it will ramp up to the test voltage with minimal leakage current and will not 
overcurrent trip.  If the analyzer is not operating correctly, it will overcurrent trip immediately as it did when it was 
attached to the motor.

6. If the analyzer is operating correctly, reconnect to the possible bad motor and retest.  If it is not operating 

correctly, contact the Megger Baker Instruments service department for assistance.

Third-party Software Warning

NOTICE: Do not install spyware or spam blockers, screen savers, virus detectors, or wireless internet software to 

the analyzer.  It will corrupt testing procedures and operations.  Many of these types of software packages, when 

installed on the analyzer, will continue to poll/use CPU resources of the computer even when not open on the 

desktop, which can create conflicts.
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Warranty Return

Please review the warranty notes and shipment sections at the beginning of this manual before sending your analyzer 

to Megger Baker Instruments for warranty repair.

The warranty-return form below must be filled out and returned with the analyzer to obtain warranty service.  This 

form will help to ensure that Megger Baker Instruments service personnel can identify the problem, and quickly repair 

your unit and return it to you.

Warranty Return Form

Please copy and fill out all the following information and return this form with the analyzer.  Make a copy of all 

records before sending the analyzer to Megger Baker Instruments.

NOTE:  Be sure to follow the guidelines for shipping when sending the analyzer.

Company Name:______________________

Name: ______________________________

Mailing Address:_______________________

Shipping Address:____________________

Phone Number: _____________________ 

Fax:______________________________

From the name plate on the back of the analyzer:

Megger Baker Instruments Product Number: _________________________________

Model Number: ____________________________________

Serial Number: ____________________________________

Software Version #: ____________________________________

Description of the problem:

Please give as much information as possible (what is not working, when it happened, what was being tested, any 

unusual noises, and so on) even if you already talked to someone by phone.  Use the back of the copy of this form if 

necessary.

Person contacted at Megger Baker Instruments: ____________________________________________________

Ship the analyzer to: 

Megger Baker Instruments

4812 McMurry Avenue

Fort Collins, CO 80525

Attn: Service Manager
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Appendix B — Technical Specifications and Applicable Standards

Calibration Information

New Baker AWA testers are calibrated at the manufacturing facility before shipping.  Calibration is recommended 

annually to ensure continued optimum performance.

For more information, please contact Megger Baker Instruments support for current calibration information.  You may 

also contact the Service department at (970) 282-1200 or (800) 752-8272.

Baker AWA-IV 2 kV and 4 kV Tester Specifications

Table 6: Surge test specifications.

Parameter Baker AWA-IV 2 kV Baker AWA-IV 4 kV

Output voltage 0–2160  volts 0–4250  volts

Max output current 200 amps 400 amps

Pulse energy .2 joules .9 joules

Storage capacitance .1F .1μF

Sweep range 0–1600μS 0–1600μS

Volts/division 500/1000/2000/ 3000 500/1000/2000/ 3000

Repetition rate 5 Hz 5 Hz

Voltage measurement and accuracy +/– 12% +/– 12%

Table 7: DC High Potential (HiPot) test specifications.

Parameter Baker AWA-IV 2 kV Baker AWA-IV 4 kV

Output voltage 0–2160 volts 0–4250 volts

Max output current 1000 μamps 1000 μamps

Current resolution .1/10/100/1000 μamps/ division .1/10/100/1000 μamps/ division

Overcurrent trip settings 1/10/100/1000 μamps 1/10/100/1000 μamps

Full scale voltage and current 
measurement and accuracy

+/– 5% +/– 5%

Megohm accuracy +/– 10% +/– 10% 

Max Megohm reading 50,000 MΩ 50,000 MΩ

Table 8: Physical characteristics.

Parameter Baker AWA-IV 2kV Baker AWA-IV 4kV

Weight 24 lbs. 24 lbs.

Dimensions (W x H x D) 15 x 8 x 8 inches 15 x 8 x 8 inches

Power requirements 85–264VAC 50/60 Hz @ 500 watts 
or more

85–264VAC 50/60 Hz @ 500 watts 
or more
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Table 9: Accuracy of measurements—Coil resistance test.  Four-wire Kelvin method resistance test (use 

separate test leads).

Range Resolution Full-scale accuracy

*10Ω–100Ω .1Ω +/– 5%

2Ω–20Ω .1Ω +/– 5%

.2Ω–2Ω .05Ω +/– 5%

.05Ω–.6Ω .005Ω +/– 5%

.005Ω–.07Ω .0002Ω +/– 5%

.001Ω–.01Ω .0001Ω +/– 5%

* Above 100Ω is reported as a potentially open circuit.

Table 10: Testing accuracy for HiPot measurements.

Range Approximate 
maximum 
measurable current

Resolution Full-scale accuracy

100 μA/Div 900μA +/– 5%

10 μA/Div 90μA +/–5% from  
9μA–90μA

+/– 5%

1 μA/Div 9μA +/–5% from  
.9μA–9μA

+/– 5%

.1 μA/Div .9μA +/– .045μA +/–5% from  
.1μA–.9μA

+/– 10%

Table 11: Voltage measurement accuracy—Surge test.

Range Resolution

500V/Div +/–12% 

1000V/Div +/–12%

2000V/Div +/–12%
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Baker AWA-IV 6 kV, 12 kV, and 12 kVHO Tester Specifications

Table 12: Surge test specifications.

Parameter Baker AWA-IV 6 kV Baker AWA-IV 12 kV Baker AWA-IV 12 HO

Output voltage 0–6000 Volts 0–12000 Volts 0–12000 Volts

Max output current 350 amps 400 amps 400+ amps

Pulse energy .72 joules 2.88 joules 7.2 joules

Storage capacitance .04μF .04μF .1μF

Sweep range 0–1600μS 0–1600μS 0–1600μS

Volts/division 500/1000/2000/ 3000 500/1000/2000/ 3000 500/1000/2000/ 3000

Repetition rate 5 Hz 5 Hz 5 Hz

Voltage measurement and 
accuracy

+/– 12% +/– 12% +/– 12%

Table 13: DC High Potential (HIPot) test specifications.

Parameter Baker AWA-IV 6 kV Baker AWA-IV 12 kV Baker AWA-IV 12 HO

Output voltage 0–6000 volts 0–12000 volts 0–12000 volts

Max output current 800 μamps 800 μamps 800 μamps

Current resolution .1/1/10/100 μamps/ 
division

.1/1/10/100 μamps/ 
division

.1/1/10/100 μamps/ 
division

Overcurrent trip settings 1/10/100/100 μamps 1/10/100/100 μamps 1/10/100/100 μamps

Full scale voltage and 
current measurement and 
accuracy

+/– 5% +/– 5% +/– 5%

Megohm accuracy +/– 10% +/– 10% +/– 10%

Max Megohm reading 50,000 MΩ 50,000 MΩ 50,000 MΩ

Table 14: Physical characteristics.

Parameter Baker AWA-IV 6 kV Baker AWA-IV 12 kV Baker AWA-IV 12 HO

Weight 40 lbs. 40 lbs. 40 lbs.

Dimensions 
 (W x H x D)

16 x 8 x 21 inches 16 x 8 x 21 inches 16 x 8 x 21 inches

Power requirements 85–264VAC 50/60 Hz @ 
2.5 amps

85–264VAC 50/60 Hz @ 
2.5 amps

85–264VAC 50/60 Hz @ 
2.5 amps

Resistance measurement 
range

.001Ω–50Ω .001Ω–50Ω .001Ω–50Ω

Table 15: Accuracy of measurements—Coil resistance test.  Resistance balance test (high-voltage  leads).

Range Full-scale accuracy

*10Ω–50Ω +/– 5%

2Ω–20Ω +/– 5%

.030Ω–2Ω +/– 5%

**.000Ω–.4Ω +/– 5%

* Above 50Ω is reported as a potentially open circuit.

**Balance test is not rated below .500Ω (for high-voltage test leads).
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Table 16: Accuracy of measurements—4-wire kelvin method resistance test.  (Use separate test leads).

Range Full-scale accuracy

*10Ω–50Ω +/– 5%

2Ω–20Ω +/– 5%

.2Ω–2Ω +/– 5%

.05Ω–.6Ω +/– 5%

.005Ω–.07Ω +/– 5%

.001Ω–.01Ω +/– 5%

* Above 50Ω is reported as a potentially open circuit.

Table 17: Testing accuracy for HiPot Measurements.

Range Approximate maximum 
measurable current

Full-scale accuracy

100 μ A/Div 900 μA +/– 5%

10 μ A/Div 90 μA +/– 5%

1 μ A/Div 9 μA +/– 5%

Table 18: Voltage measurement accuracy—Surge test.

Range Accuracy

500V/Div +/–12% 

1000V/Div +/–12%

2000V/Div +/–12%

3000V/Div +/–12%

Environmental Specifications

Specification Detail

Operating temperature range 
and humidity

Only operate the tester in temperatures ranging from 5 to 40° C (41 to 104° F).

This unit is for use at a maximum relative humidity of 80% for temperatures up 
to 31 °C (88 °F), decreasing linearly to 50% relative humidity at 40° C (104° F).  

Maximum altitude The unit has been tested for use up to 2,000 m (6,500 ft.).

Pollution degree II This unit is intended for Installation Category II in a Pollution Degree II 
environment. 

(From IEC 61010-1 3.6.6.2) Only non-conductive pollution occurs.  However, 
temporary conductivity caused by condensation is expected.
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Applicable Standards

 � EASA Standard AR100-1998 Recommended Practice for the Repair of Rotating Electrical Apparatus

 � IEC 60034-1 (1999-08) Consolidated Edition, Rotating Electrical Machines Part I:  Rating & Performance Ed.  10.2 

 � IEEE 43-2000 Recommended Practice for Testing Insulation Resistance of Rotating Machinery

 � IEEE 95-1977 Guide for Insulation Maintenance of Large AC Rotating Machinery

 � IEEE 112-1991 Test Procedures for Polyphase Induction Motors and Generators

 � IEEE 113-1985 Guide on Test Procedures for DC Machines

 � IEEE 115-1983 Test Procedures for Synchronous Machines

 � IEEE 429-1972 Evaluation of Sealed Insulation Systems for AC Electric Machinery Employing Form-Wound Stator 
Coils

 � IEEE 432-1992 Guide for Insulation Maintenance for Rotating Electrical Machinery (5hp to less than 10,000hp)

 � IEEE 434-1973 Guide for Functional Evaluation of Insulation Systems for Large High-Voltage Machines

 � IEEE 522-1992 Guide for Testing Turn-To-Turn Insulation on Form-Wound Stator Coils for Alternating-Current 
Rotating Electric Machines

 � NEMA MG1-1993 Motors & Generators

Table 19: Reprints of standards are available from:

EASA IEC IEEE NEMA

www.easa.com

1331 Baur Boulevard

St.  Louis, MO 63132

Phone:  314-993-2220

FAX:  314-993-1269

International 
Electrotechnical 
Commission (IEC)

www.IEC.ch

IEEE Customer Service

445 Hoes Lane

P.O.  Box Piscataway, NJ 
08855-1331

Phone: 1-800-678-IEEE

Fax: 908-981-9667

www.ieee.org

National Electrical 
Manufacturers Association 
(NEMA)

Global Engineering 
Documents

Phone:  1-800-854-7179

International:  303-379-
2740
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Appendix C — Recommended Test Voltages

Recommended DC Voltages for Insulation Resistance Test

EASA AR100 and IEEE 43 sections 5.4 and 12.2 provide guidelines on voltage to be applied during Insulation 

Resistance (IR) testing.  Test voltage should be applied for one minute.  

Table 20: Recommended DC Voltages for Insulation Resistance test: EASA AR100 and IEEE 43.

Winding Rated Voltage (V)* Insulation Resistance Test Direct Voltage (V)

<1000 500

1000–2500 500–1000

2501–5000 1000–2500

5001–12,000 2500–5000

>12,000 5000–10,000

* Rated line-to-line voltage for three-phase AC machines, line-to-ground for single-phase machines, and rated direct 

voltage for DC machines or filed windings.

Recommended DC HiPot and Surge Test Voltages

Megger Baker Instruments has a recommended standard (see table) for test voltages for DC tests and Surge tests 

conducted on a motor, generator, or transformer.  That standard is twice the AC line voltage plus 1,000 volts.  

This test voltage is consistent with NEMA MG-1, IEEE 95-1977 (for test voltage greater than 5,000 volts) and IEEE 43-

2000 (test voltages less than 5,000 volts).

View other standards in the tables below for a comparison of IEEE 95, EASA AR100 DC-HiPot, IEEE 522 Surge testing, 

IEC 34-15, and Megger Baker Instruments recommended testing voltages.

NOTE:  The tables list representations of motors, as well as the formulas to calculate voltages so that you can 

calculate test voltage of any size motor.

Table 21: IEEE 95 for HiPot test.

V Line Per Unit Min Test,
V Line × 1.25 × 1.7

Max Test,
V Line × 1.5 × 1.7

480 392 1,020 1,224

575 469 1,222 1,466

600 490 1,275 1,530

2,300 1,878 4,888 5,865

4,160 3,397 8,840 10,608

6,900 5,634 14,663 17,595

13,800 11,268 29,325 35,190
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Table 22: NEMA MG-1/EASA AR100 DC-HiPot.

V Line Per Unit New, 3.4 × V Line + 1,700 In Service, 65% of New

480 392 3,332 2,165.8

575 469 3,655 2,375.75

600 490 3,740 2,431

2,300 1,878 9,520 6,188

4,160 3,397 15,844 10,298.6

6,900 5,634 25,160 16,354

13,800 11,268 48,620 31,603

Table 23: IEEE 522 Surge testing.

V Line Per Unit New, 3.5 × Per Unit In Service, 75% of New

480 392 1,372 1,029

575 469 1,642 1,232

600 490 1,715 1,286

2,300 1,878 6,573 4,930

4,160 3,397 11,890 8,917

6,900 5,634 19,719 14,789

13,800 11,268 39,438 29,578

Table 24: IEC 34-15.

V Line Per Unit V Line × 4E + 5,000 0.2 us, 65%

480 392 6,920 4,498

575 469 7,300 4,745

600 490 7,400 4,810

2,300 1,878 14,200 9,230

4,160 3,397 21,640 14,066

6,900 5,634 32,600 21,190

13,800 11,268 60,200 39,130

Table 25: Megger Baker Instruments recommended voltages.

V Line Per Unit In Service, 2E + 1,000 (E = nominal line voltage)

480 392 1,960

575 469 2,150

600 490 2,200

2,300 1,878 5,600

4,160 3,397 9,320

6,900 5,634 14,800

13,800 11,268 28,600

NOTE: Use the “Peak Voltage” value shown on the screen to obtain the proper test voltages.
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Appendix D — Details of Customizable Motor Identifiers

Customizable Motor Identifiers

AWA software version 4.7.6 includes a special feature for customizing the motor names in certain parts of the AWA 

user interface display.  This feature will be hidden unless activated through a manual edit of the AWA.INI file.  This 

feature serves customers who use the AWA’s hierarchical structure for motors differently from the standard software 

design.

In such cases, every motor is uniquely identified by the database fields tree_level_1 and tree_level_2 (the 

default labels of “Location” and “Building” for these fields can be revised).  The motorid database field is also used 

to hold an equipment ID issued by a separate asset-tracking system.  

Additionally, the Routes listing in the AWA uses a custom identifier for the motors—each motor’s custom identifier 

would be built from just the tree_level_2 field.  

In conjunction with this new feature, the database upgrade with AWA software version 4.7.6 includes an expansion 

of the short text fields tree_level_1 and tree_level_2 from 25 characters to 40 characters (in both the 

MotorId table and the TestResults table).  The motorid field’s length of 30 characters remains unchanged.  

A third location field—tree_level_3—has also been added to allow for additional location description such as 

legacy identifiers.

The editable boxes in the Data tab Nameplate view for all three fields will now auto-scroll horizontally to display 

longer information.  Similarly, the list boxes in the Motor ID and Route tabs, and the Route Editor dialog will all 

provide a horizontal scroll bar when required by long motor identifiers.  The new feature applies to the Routes tab 

and the Routes Editor dialog by default, and to the MotorID tab as desired.  

Entries in the AWA.INI file customize how each motor is named in these lists, allowing new identifiers to be built 

using the tree_level_2 field and (if desired) the tree_level_1 field—with or without the inclusion of the 

motorid field.  The mechanism allows any database field to be included when building the custom identifier.  This 

feature does not affect the motor tree tab, nor the Print button’s output from the Routes tab because those already 

show all of the information from the tree structure.  The feature does not apply to the MotorID tab’s list of motors 

unless it is explicitly specified via entries the AWA.INI file [Options] section.

Here is an example of the entries in the AWA.INI file [Options] section to illustrate how they work.  The 

“AllowDupMotorIDs” option is a default parameter in this section—it has nothing to do with the new feature.

[Options]

AllowDupMotorIDs=0

MotorDisplaySpecs=3

MotorDisplaySpecs.AllowedContexts=RouteList

MotorDisplaySpec.1.Field=tree_level_2

MotorDisplaySpec.1.ExclusionsRegex=^(.*\bDefault.*|_TEMPLATE(_BACKUP)?)$

MotorDisplaySpec.1.Format=%s |

MotorDisplaySpec.1.AppliesTo=RouteList

MotorDisplaySpec.2.Field=tree_level_1

MotorDisplaySpec.2.Exclusions=_TEMPLATE,_TEMPLATE_BACKUP

MotorDisplaySpec.2.Format=| %s :

MotorDisplaySpec.3.Field=motorid

MotorDisplaySpec.3.Field=motorid

MotorDisplaySpec.3.Exclusions=_TEMPLATE,_TEMPLATE_BACKUP

MotorDisplaySpec.3.Format=: (%s)
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The “MotorDisplaySpecs” parameter identifies how many groupings of other entries there will be.  Each grouping 

consists of other parameters where the name is built with a prefix of “MotorDisplaySpec”, an ordinal group number 

(starting with 1 for the first grouping), and another item sub-name (the name specific to that sub-item in the group) 

using period delimiters.

Notice the difference in plurality between “MotorDisplaySpecs” and “MotorDisplaySpec”.  When this item is missing 

(or its value is 0), this feature is turned off, and every motor will be displayed using the “motorid” value.  If the 

item is present and its value is greater than 0, the custom identifier for each motor will initially be set to an empty 

string, and the various “MotorDisplaySpec” groups will determine which strings are appended to it to form the final 

customized identifier for display purposes.  

If no strings are appended because the groups do not specify any “Format” strings to append, the custom identifier 

will always be the empty string (the same situation used internally to indicate exclusions) essentially forcing the Motor 

ID and Route lists to always be empty.

The “MotorDisplaySpecs.AllowedContexts” parameter is optional and defaults to “RouteList”.  This identifies which 

AWA user interface contexts the specifications will apply to.  It should be the union of all contexts used across all 

“AppliedTo” parameters in all “MotorDisplaySpec” groupings (described below).  It may also specify “MotorIdList” 

and these separate contexts may be combined with a space, comma, or vertical bar delimiter.  The value “All” applies 

the specifications to all possible contexts, but at present only two have any effect: “RouteList” and “MotorIdList”.  

This does not set a default value for which contexts any grouping will apply to; it specifies which groupings will be 

allowed in the specifications.  

The special value of “None” means that the specifications are not to be allowed in any context, which is essentially 

the same as setting “MotorDisplaySpecs” to 0.  It allows you to keep the individual “MotorDisplaySpec” groupings in 

the AWA.INI file, but causes them to have no effect.

Each “MotorDisplaySpec” sub-item group (sharing the same ordinal group number) specifies a database field whose 

value will be checked and/or appended to a custom ID string for display purposes in only those three areas of the 

AWA software interface.  Each type of sub-item should only occur once per grouping.  

The possible sub-item names (after “MotorDisplaySpec.groupnumber.”) include:

 �  Field (required)—Identifies the database column in the MotorId table whose value is to be used.  If the column 
value is NULL (missing) on a particular motor’s row, the string value used in its place will usually be “NULL.”  All 
columns of the MotorId table are allowed.  Invalid names will trigger an error message display and the grouping 
being ignored.  The same error occurs if the “MotorDisplaySpecs” number exceeds the groupings of sub-items 
specified.  

 �  Format (required if the field is to be appended to the custom identifier)— Provides the format string to be used 
(along with the value of the field, when building the substring to be appended.  It minimally needs “%s” (or an 
alternative format item) in its value.  You will likely need a delimiter of some sort on all but one of the groupings’ 
“Format” parameters.  If the “Format” parameter is missing for a group, that field value will not be appended to 
the identifier.  This can be used to allow certain fields to be checked for excluding a motor, but not to compose 
the custom identifier.  

Refer to https://msdn.microsoft.com/en-us/library/56e442dc.aspx# for more explanation of what 

format specifications are possible.  Keep in mind that the column’s value, converted to a string, will be the only 

argument.

Exclusions (optional)—Provides a comma-separated list of exact values that the field value is compared to.  Any 

exact match (full-value, case-sensitive) will exclude the identified motor from being displayed where the custom 

identifiers are used.  This does not affect the motor tree in the Explore tab.  If a pattern you want to exclude contains 

a comma, it will have to be specified via “ExclusionsRegex”.  

ExclusionsRegex (optional)—Provides a valid ECMAScript-style regular expression, against which the entire field 

value is matched.  A successful full-value match excludes the identified motor from being displayed where the custom 

identifiers are used.  This does not affect the motor tree in the Explore tab.  
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Refer to https://msdn.microsoft.com/en-us/library/bb982727.aspx for more explanation about 

regular expression syntax.  Note that the ECMAScript variant is being used here.  Regular expressions are very 

powerful, but can prove tricky to get right.  Users already familiar with modern regular expression syntaxes—even 

those influenced by Perl—should still refer to the official description because ECMAScript (that is, standardized 

JavaScript) regular expressions sometimes deviate in meaning from other variants of Perl-inspired regular expressions.

AppliesTo (optional)—Provides a set of AWA user interface contexts to which the related field specification should be 

applied.  The values listed can be separated by commas, spaces, or vertical bars.  They are essentially added together 

in a set.  The individual values allowed are “RouteList” (the default value), “MotorIdList” and “All”.  If a context is 

listed that is not allowed via the “MotorDisplaySpecs.AllowedContexts” item, an error message is displayed.

There are two distinct ways of specifying exclusions, and both are optional.  The comma-separated list of values 

provided with “Exclusions” is probably the easiest to use.  However, if the field it applies to is motorid, and multiple 

motors are to be excluded, it might conflict with the disallowance of duplicated motor IDs.  For that reason, the 

“ExclusionsRegex” parameter provides a more powerful pattern-matching capability.  You can specify either or both 

of these exclusion specifications, but it is not expected to be a useful capability unless you are keeping your AWA 

motor lists synchronized with an external system that contains motor entries that should not be included in AWA 

routes.  If neither of these sub-items is specified in a group, then that field will not cause any motors to be excluded 

from the Motor ID or Route tabs’ lists, or that in the Route Editor dialog.

There is no facility provided to alter a field’s value before appending it to the custom identifier—neither by regular 

expression substitution, nor by any other mechanism.

By using the “MotorDisplaySpecs.AllowedContexts=All” item along with the “AppliesTo” sub-item in each grouping, 

separate specifications can be created for each context, some for RouteList and some for MotorIdList.  This allows 

distinct custom motor identifiers to be used in each context.  Even though the sub-list of specifications that applies 

to any given context may only be a portion of the total list of groupings, the groupings are still listed as a single 

contiguous sequence.  

Here is an example that displays tree_level_2, tree_level_1, and motorid in the motor lists of the Route 

tab and Route Editor dialog, while displaying motorid and tree_level_2 in the Motor ID tab:

MotorDisplaySpecs=4

MotorDisplaySpecs.AllowedContexts=All

MotorDisplaySpec.1.Field=tree_level_2

MotorDisplaySpec.1.BAK.ExclusionsRegex=^(.*\bDefault.*|_TEMPLATE(_BACKUP)?)$

MotorDisplaySpec.1.Format=%s |

MotorDisplaySpec.2.Field=tree_level_1

MotorDisplaySpec.2.Exclusions=_TEMPLATE,_TEMPLATE_BACKUP

MotorDisplaySpec.2.Format=| %s :

MotorDisplaySpec.3.Field=motorid

MotorDisplaySpec.3.Exclusions=_TEMPLATE,_TEMPLATE_BACKUP

MotorDisplaySpec.3.ExclusionsRegex=.*\b[Cc]opy\b.*

MotorDisplaySpec.3.Format=%s

MotorDisplaySpec.3.AppliesTo=All

MotorDisplaySpec.4.Field=tree_level_2

MotorDisplaySpec.4.Exclusions=_TEMPLATE,_TEMPLATE_BACKUP

MotorDisplaySpec.4.Format=: %s

MotorDisplaySpec.4.AppliesTo=MotorIdList  
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Appendix E — Database Definition

Version 4.0 Database Definition

The Baker AWA-IV database is an Access 97 database (.mdb).  It can also be converted to an Access 2000 database 

and be used by the analyzer.  The Access database is divided into several tables.  

 � The motor information and test results data is contained in the following tables:  MotorID, TestResults, 
TestResultsParameters, TestResultsPI, TestResultsPrgHiPot, and SurgeWaveform.  

 � The testing criteria used to run the tests are contained in the following tables: TestId, TestIdPrgHiPot, and 
RefSrgWaveform.  

 � Two addition tables are used, one is the DatabaseInfo table and the other is the Route table.  
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Nameplate Table—(MotorID)

The MotorID table contains the nameplate information for each motor added to the database.  There is only one 

motor record per motor.  The motor_key is the primary keyed field.  It is automatically generated when a new motor 

is added.   The Motor ID field is a unique identifier that the user gives each motor.

Table 26: Field name descriptions.

Field name Type Description

motor_key Long integer Automatically generated number used as the primary key.

tree_level_1 Text (40) First level used in the tree view.  Motor location 1 user defined field label, 
defaults to Location.

tree_level_2 Text (40) Second level used in the tree view.  Motor location 2 user defined field 
label, defaults to Building.

tree_level_3 Text (40) Third level used in the tree view.  Motor location 3 user defined field 
label.  Not used by default. To make this field show up in the interface, 
assign a label for it in the DatabaseInfo table (via View  Options  
Changeable Labels.

custom_string Text (40) General purpose description field; not related to motor location.  Not 
used by default.  To make this field show up in the interface, assign a 
label for it in the DatabaseInfo table (via View  Options  Changeable 
Labels.

motor_id Text (30) User entered Motor Identification value.  It must be unique.

manuf Text (25) Manufacturer of the motor.

manuf_type Text (25) NEMA MG 1 requires manufacturer’s type but may vary depending on 
manufacturer.

manuf_date_code Text (16) Manufacturer’s nameplate date.

model Text (25) Manufacture’s Identification of model type.

sn Text (25) Manufacture’s serial number.

hpkw Single Nameplate horse power or kilowatts.

rpm Single Revolutions per minute (RPM).

voltage_rating Text (16) Nameplate voltage ratings.

voltage_operating Single Name Plate Voltage used as a Voltage Class.

amps_rating Text (16) Nameplate current (amps) ratings.

amps_operating Single Operating current (amps).

frame Text (16) Frame type code indicating dimensions.

insulation_class Text (8) Locked rotor current in amps.

lockec_rotor_current Single Locked rotor current in amps.

locked_rotor_code Text (4) A letter code that groups motors based on KVA/hp. (KVA code)

service_factor Single Factor when multiplied by hp, gives the allowable hp loading.

enclosure Text (16) Classifies the motor as to its degree of protection from the environment 
and method of cooling.

freq_hz Long integer Input frequency usually 50 or 60 Hz.

NEMA_design_code Text (4) NEMA codes assigned to define torque and current characteristics of the 
motor.

NEMA_nom_efficiency Short This represents an average efficiency of a large population of like motors.

max_ambient_temp Single The maximum ambient temperature at which the motor can operate 
and still be within the tolerance of the insulation class at the max 
temperature rise in C.

duty_cycle Text (16) Defines the length of time during which the motor can carry its 
nameplate rating safely.

user_defined_description Text (64) User defined motor description field.

winding_config Text (8) Wye or delta winding configuration.
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Test Results Table—(TestResults)

The TestResults table has a test_resultno that is auto generated each time a test results record is added either after a 

test is performed or in the Application View of the AWA software. 

Table 27: Field name descriptions.

Field name Type Description

test_resultno Long integer Automatically generated number used as primary key.  Foreign 
key in other test result tables.

motor_key Long integer Used as the foreign key.  (Primary key of MotorID table).  Links 
the test results to the Motor ID’s.

testdate_time Date/Time Time stamped at the time the test results are saved.

testid Text (25) Test ID used for this set of test results.

test_level_1 Text (25) First level used in the tree view.  Motor location 1 user defined 
field label, defaults to Location.

test_level_2 Text (25) Second level used in the tree view Motor location 2 user 
defined field label, defaults to Building.

testfor Text (25) Enter the entity for which the motor is being tested.

testby Text (25) Enter the person who is performing the test on the motor.

baker_sn Long integer Serial number on the Baker AWA-IV being used for the test. 

baker_tester_type Text (25) Type of Baker AWA-IV being used for the test.  (AWA, D12R, 
and so on).

baker_calibration_date Text (20) Last date that the tester was calibrated.

baker_pp30sn Long integer Serial number of the power pack, if any.

use Text (25) Enter how the motor is being used.

verthoriz Text (16) Enter vertical or horizontal mounting.

starter Text (16) Motor starter type.

start24h Text (16) Number of starts per 24 hours.

percentld Text (4) Percent of load being applied.

roomno Text (25) Room number.  Can also be used as a job number.

mcc Text (25) Motor control cabinet Identification.

app_volts1 Double Application phase 1 voltage.

app_volts2 Double Application phase 2 voltage.

app_volts3 Double Application phase 3 voltage.

app_amps1 Double Application phase 1 current.

app_amps2 Double Application phase 2 current.

app_amps3 Double Application phase 3 current.

repairno Text (16) Repair number.

install Text (8) Date the motor was installed at the current location.

basic Text (8) Date when the motor had basic service.

rewind Text (8) Date the motor was last rewound.

memo_used Yes/No Indicates a memo has been entered.
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Table 28: Temperature test results.

Field name Type Description

temp_status Text (8) Contains the status of the test, PASS or FAIL if a test has 
been performed or blank if no temperature test has been 
conducted.

temp_why_failed Text (25) Reason why motor failed (if it failed).

temp_temperature Double Temperature of motor, always stored as Celsius.

temp_degF_C Yes/No False if temp was entered as C. True if temp was entered as F.

Table 29: Resistance test results.

Field name Type Description

resist_status Text (8) Contains the status of the test, PASS or FAIL if a test has been 
performed or blank if no resistance test has been conducted.

resist_why_failed Text (25) If the motor failed, reason why.

resist_balance1 Double Balance resistance for lead 1.

resist_balance2 Double Balance resistance for lead 2.

resist_balance3 Double Balance resistance for lead 3.

resist_12 Double Lead 1 to lead 2 resistance.

resist_23 Double Lead 2 to lead 3 resistance.

resist_31 Double Lead 3 to lead 1 resistance.

resist_corrected1 Double Corrected resistance for lead 1.

resist_corrected2 Double Corrected resistance for lead 2.

resist_corrected3 Double Corrected resistance for lead 3.

resist_delatR_max Double Max delta resistance test tolerance.

resist_coil1 Double Coil resistance for lead 1.

resist_coil2 Double Coil resistance for lead 2.

resist_coil3 Double Coil resistance for lead 3.

resist_corrected_coil1 Double Corrected coil resistance for lead 1.

resist_corrected_coil2 Double Corrected coil resistance for lead 2.

resist_corrected_coil3 Double Corrected coil resistance for lead 3.

Table 30: Megohm test results.

Field name Type Description

Meg-Ohm_status Text (8) Contains the status of the test, PASS or FAIL if a test has been 
performed or blank if no Meg-Ohm test has been conducted.

Meg-Ohm_whyFailed Text (25) Reason why motor failed (if it failed).

Meg-Ohm_voltage Long integer Voltage used in Meg-Ohm calculations.

Meg-Ohm_current Double Current used in Meg-Ohm calculations.

Meg-Ohm_Meg-Ohm Long integer Meg-Ohm value = voltage/current.

Meg-Ohm_IR_at_40C Long integer Meg-Ohms (insulation resistance) at 40 °C.
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Table 31: PI test results.

Field name Type Description

pi_status Text (8) Contains the status of the test, PASS or FAIL if a test has been 
performed or blank if no PI test has been conducted. (DA Only 
DPASS/DFAIL.)

pi_whyFailed Text (25) Reason why motor failed (if it failed).

pi_voltage Short integer Test voltage for PI test.

pi_da_ratio Double 3-minute resistance value divided by 30-second resistance 
value.

pi_ratio Double 10-minute resistance value divided by 1-minute resistance 
value.

Table 32: HiPot test results.

Field name Type Description

HiPot_status Text (8) Contains the status of the test, PASS or FAIL if a test has been 
performed or blank if no HiPot test has been conducted.

HiPot_whyFailed Text (25) Reason why motor failed (if it failed).

HiPot_voltage Long integer Voltage at the end of test.

HiPot_current Double Current at the end of test.

HiPot_Meg-Ohm Long integer Meg-Ohm value = voltage/current.

HiPot_IR_at_40C Long integer Meg-Ohms (insulation resistance) at 40 °C.

Table 33: DC High Potential (HIPot) test results.

Field name Type Description

surge_status Text (8) Contains the status of the test, PASS or FAIL if a test has been 
performed or blank if no surge test has been conducted.

surge_whyFailed Text (25) Reason why motor failed (if it failed).

surge_peak_volt1 Short integer Peak voltage reached for lead 1.

surge_peak_volt2 Short integer Peak voltage reached for lead 2.

surge_peak_volt3 Short integer Peak voltage reached for lead 3.

surge_ear1_2 Short integer Error Area Ratio lead 1 to lead 2.

surge_ear1_3 Short integer Error Area Ratio lead 1 to lead 3.

surge_ear_2_3 Short integer Error Area Ratio lead 2 to lead 3.

Memo Table—(Memo)

This table contains the memo if any that a user can fill out per test result.

Table 34: Memo table field descriptions.

Field name Type Description

Test_resultno Long integer Foreign key used to link test result records.

motor_key Long integer Motor key Identification key.

memo Memo Memo field type containing the user entered text.
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Polarization Index Test Results Table—(TestResultsPI)

The TestResultsPI table contains a record for a test result, only if a DA/PI test has been performed.  Then a record 

containing the motor_key and same test_resultno for each step of the test is added to the table. 

DC High Potential (HIPot) test results.

Field name Type Description

test_result_no Long integer Foreign key used to link test result records.

motor_key Long integer Motor Identification  key.

piamps15 Double Current in micro amps @ 15 seconds.

piamps30 Double Current in micro amps @ 30 seconds.

piamps45 Double Current in micro amps @ 45 seconds.

piamps60 Double Current in micro amps @ 60 seconds.

piamps90 Double Current in micro amps @ 90 seconds.

piamps120 Double Current in micro amps @ 120 seconds.

piamps150 Double Current in micro amps @ 150 seconds.

piamps180 Double Current in micro amps @ 180 seconds.

piamps240 Double Current in micro amps @ 240 seconds.

piamps300 Double Current in micro amps @ 300 seconds.

piamps360 Double Current in micro amps @ 360 seconds.

piamps420 Double Current in micro amps @ 420 seconds.

piamps480 Double Current in micro amps @ 480 seconds.

piamps540 Double Current in micro amps @ 540 seconds.

piamps600 Double Current in micro amps @ 600 seconds.

pires15 Double Resistance in Meg-Ohms @ 15 seconds.

pires30 Double Resistance in Meg-Ohms @ 30 seconds.

pires45 Double Resistance in Meg-Ohms @ 45 seconds.

pires60 Double Resistance in Meg-Ohms @ 60 seconds.

pires90 Double Resistance in Meg-Ohms @ 90 seconds.

pires120 Double Resistance in Meg-Ohms @ 120 seconds.

pires150 Double Resistance in Meg-Ohms @ 150 seconds.

pires180 Double Resistance in Meg-Ohms @ 180 seconds.

pires240 Double Resistance in Meg-Ohms @ 240 seconds.

pires300 Double Resistance in Meg-Ohms @ 300 seconds.

pires360 Double Resistance in Meg-Ohms @ 360 seconds.

pires420 Double Resistance in Meg-Ohms @ 420 seconds.

pires480 Double Resistance in Meg-Ohms @ 480 seconds.

pires540 Double Resistance in Meg-Ohms @ 540 seconds.

pires600 Double Resistance in Meg-Ohms @ 600 seconds.

pi_current_1sec Memo Comma delimited field containing the current for each second 
180 data , if it is a DA only,  or 600 if a full PI was run.
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Step Voltage Test Results Table—(TestResultsPrgHiPot)

The TestResultsPrgHiPot table contains a record for a test result, only if a Step Voltage Test test has been performed.  

Then a record containing the motor_key and same test_resultno for each step of the test is added to the table. 

Table 35: Step voltage table field descriptions.

Field name Type Description

test_resultno Long integer Foreign key used to link test result records.

motor_key Long integer Motor Identification  key.

step_order Long integer Enumerator used to sort results in step order.

step_voltage Long integer Voltage for the given test interval.

step_time Short integer Length of step in seconds.

step_ramp_rate Short integer Not used at this time.

step_min_Meg-Ohm Long integer Minimum Meg-Ohms aloud for the step.

Meg-Ohm_at_endstep Long integer Meg-Ohm value at the end of the step.

current_at_endstep Double Current in micro amps at the end of the step.

voltage_1sec Memo Comma delimited field containing the voltage for each second 
of the interval, including ramping voltage.

current_1sec Memo Comma delimited field containing the current for each second 
of the interval, including current during ramping of voltage.

time_1sec Memo Comma delimited field containing the times progression for 
each second of the interval, including time during ramping of 
voltage.

 

www.megger.com 157



Surge Test Results Table—(SurgeWaveform) 

The SurgeWaveform table contains a record for a test result. After  a surge test has been performed, a record that 

contains the motor_key and same test_result for one test is added to the table. This record contains all three surge 

tests for a three-phase motor.

Table 36: Detailed surge test results.

Field name Type Description

test_rsultno Long integer Test result number (unique key ties to other test results).

motor_key Long integer Motor identification key.

waveFormatVr Double Version of waveform record.

xscale Short integer Scale index for the x-axis (micro seconds per division).

yscale Short integer Scale index for the y-axis (volts per div).

microSecPerPnt Double Micro seconds per point (Not used ).

voltsPerPnt Double Volts per point (Not used at this time).

wave1Full Full waveform for lead 1.

wave1Mid Middle waveform for lead 1.

wave1Min Minimum waveform for lead 1.

wave1PrevFail Wave form before the failed waveform for lead 1.

wave1ppEAR Pulse-to-Pulse EAR for lead 1.

wave2Full Full waveform for lead 2.

wave2Mid Middle waveform for lead 2.

wave2Min Minimum waveform for lead 2.

wave2PrevFail Wave form before the failed waveform for lead 2.

wave2ppEAR Pulse-to-Pulse EAR for lead 2.

wave3Full Full waveform for lead 3.

wave3Mid Middle waveform for lead 3.

wave3Min Minimum waveform for lead 3.

wave3PrevFail Wave form before the failed waveform for lead 3.

wave3ppEAR Pulse-to-Pulse EAR for lead 3.
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Test Results Parameters Table—(TestResultsParameters)

This table contains the test parameters used at the time of testing and is associated with the TestResults records by 

the test_resultno field.

Table 37: Test results parameters table field descriptions.

Field name Type Description

test_resultno Long integer Foreign key automatically generated in the TestResults Table.

test_mode Text (15) Will contain one of the following values AUTOMATIC, 
SEMIAUTOMATIC, MANUAL, or UNKNOWN.

temp_enabled Yes/No Temperature test: 1=on; 0=off.

resist_enabled Yes/No Resistance test: 1= on; 0=off.

Meg-Ohm_enabled Yes/No Meg-Ohm test: 1=on; 0=off.

pi_enabled Yes/No PI test: 1=on; 0=off.

HiPot_enabled Yes/No HiPot test: 1=on; 0=off.

prgHiPot_enabled Yes/No Step Voltage Test enabled: 1=on; 0=off.

surge_enabled Yes/No Surge test: 1=on; 0=off.

Table 38: Test results parameters table; temperature test parameters field descriptions.

Field name Type Description

temp_isAuto Yes/No 1=Manual; 0=Automatic.

temp_degF_C Yes/No 1=F degrees; 0=C degrees.

Table 39: Test results parameters table; resistance test parameters field descriptions.

Field name Type Description

resist_no_leads Short integer # of leads (2 or 3) Used also in surge.

resist_deltaR_enabled Yes/No 1=delta R used in pass/fail; 0=Not used.

resist_ deltaR_maxpercent Short integer Max difference in percent.

resist_external_enabled Yes/No Always false 0=No external testing.

resist_isAuto Yes/No 1=Automatic; 0=Manual

resist_4lead_test_enabled Yes/No 1=4 lead test enabled; 0=4 lead test disabled (Only disabled at 
this time)

resist_correct_to_temp_
enabled

Yes/No Correct resistance 1=Yes; 0=No.

resist_temp_correct_to Short integer Defines the value that the temperature will be corrected to.

resist_temp_correct_factor Double Default 234.5 for copper.

resist_target_coilRes_
enabled

Yes/No 1=Coil resistance checking enabled;0=not enabled.

resist_target_coilRes Double Coil resistance to compare tested value with.

resist_target_coilRes_
tolerance

Long integer Tolerance set for target coil resistance.
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Table 40: Test results parameters table; Meg-Ohm test parameters field descriptions.

Field name Type Description

Meg-Ohm_test_voltage Short integer Target voltage of test.

Meg-Ohm_min_Meg-Ohm Short integer Minimum Meg-Ohm value.

Meg-Ohm_test_time Short integer Length of test.

Meg-Ohm_ramp_rate Short integer Ramp rate.

Meg-Ohm_trip_level Short integer HiPot trip value.

Meg-Ohm_discharge_
multiplier

Short integer Number of minutes to discharge.

Meg-Ohm_PowerPack_
enabled

Yes/No 1=PP enabled; 0=No PP.

Table 41: Test results parameters table; polarization index test parameters field descriptions.

Field name Type Description

pi_test_voltage Short integer Target voltage of test.

pi_min_Meg-Ohm Short integer Minimum Meg-Ohm value.

pi_min_ratio Double Length of test.

pi_ramp_rate Short integer Ramp rate.

pi_trip_level Short integer HiPot trip value.

pi_da_only_enabled Yes/No 1=DA only; anything else PI.

pi_revert_to_da_enabled Yes/No

pi_discharge_multiplier Short integer Number of minutes to discharge.

pi_PowerPack_enabled Yes/No 1=PP enabled; 0=No PP.

Table 42: Test results parameters table; HiPot test parameters field descriptions.

Field name Type Description

HiPot_test_voltage Short integer Target voltage of test.

HiPot_min_Meg-Ohm Short integer Minimum Meg-Ohm value.

HiPot_test_time Short integer Length of test.

HiPot_ramp_rate Short integer Ramp rate.

HiPot_trip_level Short integer HiPot trip value.

HiPot_discharge_multiplier Short integer Number of minutes to discharge.

HiPot_PowerPack_enabled Yes/No 1=PP enabled; 0=No PP.

StepHiPot_PowerPack_
enabled

Yes/No Not used.
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Table 43: Test results parameters table; Surge test parameters field descriptions.

Field name Type Description

surge_test_voltage Short integer Target voltage of test.

surge_no_leads Short integer Number of leads: 2 or 3.

surge_ramp_rate Short integer Ramp rate.

surge_pulses Short integer Number of pulses surged at test voltage.

surge_time_scale Short integer Index indicating the time per division.  

0 – 2.5 uS      4 – 50 uS

1 – 5 uS         5 – 100 uS

2 – 10 uS       6 – 200 uS

3 – 25 uS       7 – Auto scaling

surge_volts_scale Short integer Index indicating the volts per division.

0 – 250       w/power pack  1000

1 – 500       w/power pack  2000

2 – 1000     w/power pack  4000

3 – 2000     w/power pack  8000

4 – Auto scale

surge_PauseBetweenLeads Yes/No 1=Yes pause; 0=No do not pause.

surge_zero_enabled Yes/No Zero tolerance  error checking on/off.

surge_zero_percent Short integer Zero tolerance  percent.

surge_EAR_enabled Yes/No EAR checking on or off.

surge_EAR_percent Short integer EAR error tolerance

surge_ppEAR_enabled Yes/No Pulse to pulse EAR error checking enabled.

surge_ppEAR_percent Short integer Pulse to pulse EAR tolerance percent.

surge_refEAR _percent Short integer EAR tolerance with reference wave.

surge_refwave_test_key Long integer 0=No reference waveform; if any other number then it is a key 
to the ref waveform record in the RefSrgWaveform table.

surge_PowerPack_enabled Yes/No 1=PP enabled; 0=No PP

Table 44: Test results parameters table; additional fields descriptions.

Field name Type Description

surge_AT101_enabled Yes/No 1=AT101 enabled; 0=Not enabled

motor_voltage_class Long integer Voltage class of the Test ID used

temp_RH_enabled Yes/No 1=Relative Humidity enabled; 0= Not enabled

HiPot_rampVTest_enabled Yes/No 1=Ramped Voltage Test enabled; 0= Not enabled
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Test ID Table—(TestId)

The TestId table contains information that is used to set up the test criteria.  There is only one motor record per 

motor.  The test_key is the primary key.  It is automatically generated when a new test is added.   The testid field is 

a unique identifier that the user gives each set of test criteria to identify what motor(s) is meant to be tested.  For 

example, 480 V w/o PI.

Table 45: Test ID table field descriptions.

Field name Type Description

test_key Long integer Automatically generated number used as the primary key.

testId Text (25) Test identification.

datetime_modified Date/Time Date and time stamp as to when a Test ID gets updated.

temp_enabled Yes/No Temperature test: 1=on; 0=off.

resist_enabled Yes/No Resistance test: 1= on; 0=off.

Meg-Ohm_enabled Yes/No Meg-Ohm test: 1=on; 0=off.

pi_enabled Yes/No PI test: 1=on; 0=off.

HiPot_enabled Yes/No HiPot test: 1=on; 0=off.

PrgHiPot_enabled Yes/No Step Voltage Test enabled: 1=on; 0=off.

Surge_enabled Yes/No Surge test: 1=on; 0=off.

Table 46: Test ID table; temperature test parameters field descriptions.

Field name Type Description

temp_isAuto Yes/No 1=Manual; 0=Automatic.

temp_degF_C Yes/No 1=F degrees; 0=C degrees.

Table 47: Test ID table; resistance test parameters field descriptions.

Field name Type Description

resist_no_leads Short integer # of leads (2 or 3) Used also in surge.

resist_deltaR_enabled Yes/No 1=delta R used in pass/fail; 0=Not used.

resist_ deltaR_maxpercent Short integer Max difference in percent.

resist_external_enabled Yes/No Always false 0=No external testing.

resist_isAuto Yes/No 1=Automatic; 0=Manual

resist_4lead_test_enabled Yes/No 1=4 lead test enabled; 0=4 lead test disabled (Only disabled at 
this time)

resist_correct_to_temp_
enabled

Yes/No Correct resistance 1=Yes; 0=No.

resist_temp_correct_to Short integer Defines the value that the resistance temperature will be 
corrected to.

resist_temp_correct_factor Double Default 234.5 for copper.

resist_target_coilRes_
enabled

Yes/No 1=Coil resistance checking enabled; 0=not enabled.

resist_target_coilRes Double Coil resistance to compare tested value with.

resist_target_coilRes_
tolerance

Long integer Tolerance set for target coil resistance.
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Table 48: Test ID table; Meg-Ohm test parameters field descriptions.

Field name Type Description

Meg-Ohm_test_voltage Short integer Target voltage of test.

Meg-Ohm_min_Meg-Ohm Short integer Minimum Meg-Ohm value.

Meg-Ohm_test_time Short integer Length of test.

Meg-Ohm_ramp_rate Short integer Ramp rate.

Meg-Ohm_trip_level Short integer HiPot trip value.

Meg-Ohm_discharge_
multiplier

Short integer Number of minutes to discharge.

Meg-Ohm_PowerPack_
enabled

Yes/No 1=PP enabled; 0=No PP.

Table 49: Test ID table; polarization index test parameters field descriptions.

Field name Type Description

pi_test_voltage Short integer Target voltage of test.

pi_min_Meg-Ohm Short integer Minimum Meg-Ohm value.

pi_min_ratio Double Length of test.

pi_ramp_rate Short integer Ramp rate.

pi_trip_level Short integer HiPot trip value.

pi_da_only_enabled Yes/No 1=DA only; anything else PI.

pi_revert_to_da_enabled Yes/No

pi_discharge_multiplier Short integer Number of minutes to discharge.

pi_PowerPack_enabled Yes/No 1=PP enabled; 0=No PP.

Table 50: Test ID table; HiPot test parameters field descriptions.

Field name Type Description

HiPot_test_voltage Short integer Target voltage of test.

HiPot_min_Meg-Ohm Short integer Minimum Meg-Ohm value.

HiPot_test_time Short integer Length of test.

HiPot_ramp_rate Short integer Ramp rate.

HiPot_trip_level Short integer HiPot trip value.

HiPot_discharge_multiplier Short integer Number of minutes to discharge.

HiPot_PowerPack_enabled Yes/No 1=PP enabled; 0=No PP.
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Table 51: Test ID table; Surge test parameters field descriptions.

Field name Type Description

surge_test_voltage Short integer Target voltage of test.

surge_no_leads Short integer Number of leads: 2 or 3.

surge_ramp_rate Short integer Ramp rate.

surge_pulses Short integer Number of pulses surged at test voltage.

surge_time_scale Short integer Index indicating the time per division.  

0 – 2.5 uS      4 – 50 uS

1 – 5 uS         5 – 100 uS

2 – 10 uS       6 – 200 uS

3 – 25 uS       7 – Auto scaling

surge_volts_scale Short integer Index indicating the volts per division.

0 – 250       w/power pack  1000

1 – 500       w/power pack  2000

2 – 1000     w/power pack  4000

3 – 2000     w/power pack  8000

4 – Auto scale

surge_PauseBetweenLeads Yes/No 1=Yes pause; 0=No do not pause.

surge_zero_enabled Yes/No Zero tolerance  error checking on/off.

surge_zero_percent Short integer Zero tolerance  percent.

surge_EAR_enabled Yes/No EAR checking on or off.

surge_EAR_percent Short integer EAR error tolerance

surge_ppEAR_enabled Yes/No Pulse to pulse EAR error checking enabled.

surge_ppEAR_percent Short integer Pulse to pulse EAR tolerance percent.

surge_refEAR _percent Short integer EAR tolerance with reference wave.

surge_refwave_test_key Long integer 0=No reference waveform; if any other number then it is a key 
to the ref waveform record in the RefSrgWaveform table.

surge_PowerPack_enabled Yes/No 1=PP enabled; 0=No PP

Table 52: Test ID table; additional fields descriptions.

Field name Type Description

surge_AT101_enabled Yes/No 1=AT101 enabled; 0=Not enabled

motor_voltage_class Long integer Voltage class of the Test ID used

temp_RH_enabled Yes/No 1=Relative Humidity enabled; 0= Not enabled

HiPot_rampVTest_enabled Yes/No 1=Ramped Voltage Test enabled; 0= Not enabled
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Step Voltage Test ID Table—(TestIdPrgHiPot)

Table 53: Step Voltage Test ID table fields descriptions.

Field name Type Description

test_key Long integer Test identification key.

test_voltage Long integer Voltage for this step.

min_Meg-Ohm Short integer Minimum Meg-Ohm value for this step.

test_time Short integer Length of time for this step.

ramp_rate Short integer Ramp rate for this step.

prg_order Long integer Step number.

powerpack_enabled Yes/No 1=PP enabled; 0=No PP

Reference Surge Waveform Table— (RefSrgWaveForm)

This table contains the waveforms used as test criteria to pass or fail a motor base on a reference waveform. 

Table 54: Reference surge waveform table fields descriptions.

Field name Type Description

refwave_test_key Long integer Primary key field it is also stored in TestParameter and TestId 
tables.  Auto generated number.

WaveFormatVr Double Version of waveform record.

Xscale Integer Scale index for the x-axis (micro seconds per division).

Yscale Integer Scale index for the y-axis (volts per division).

MicroSecPerPnt Double Microseconds per point (Not used at this time).

VoltsPerPnt Double Volts per point (Not used at this time).

peak_volts1 Short integer Peak voltage reached for lead 1

peak_volts2 Short integer Peak voltage reached for lead 2.

peak_volts3 Short integer Peak voltage reached for lead 3.

wave1Full Full wave form for lead 1.

wave2Full Full wave form for lead 2.

wave3Full Full wave form for lead 3.
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Database Information table—(DatabaseInfo)

Table 55:  Database information table fields descriptions.

Field name Type Description

database_type Text (25) Type of database (AWA, MTA).

revised_date Date/Time Data and time the database was created or revised.

database_version Text (25) Version of the database.

software_version Text (25) Software version that is used with this version of the database.

revising_app Text (25) Application that revised the database. (AWA, MTA, Data 
Transfer, and so on).

tree_level_1_field_name Text (10) The label to use for the hierarchical motor location field tree_
level_1 (in the MotorID table); default is Location.  The record 
with the most recent date contains the field description used.

tree_level_2_field_name Text (10) The label to use for the hierarchical motor location field tree_
level_2 (in the MotorID table); default is Building.  The record 
with the most recent date contains the field description used.

tree_level_3_field_name Text (10) The label to use for an optional motor location field tree_
level_3 (in the MotorID table); default is that it is omitted 
entirely (neither the tree_level_3 field value nor this label for it 
will be shown).  The record with the most recent date contains 
the field label used.

custom_string_field_name Text (20; 10 per 
line)

The label to use for the optional motor field custom_string 
(in MotorID); default is that is is omitted entirely (neither the 
custom_string field value nor this label for it will be shown). 
The record with the most recent date contains the field label 
used.

Work List Table—(Route)

Table 56: Work list table fields descriptions.

Field name Type Description

route_id Text (25) Name of the route.

motor_key Long integer Motor key of the motor belonging to this route.

route_order Long integer Order of Motor IDs in Route.

Motor Voltage Class Table—(MotorVoltageClasses)

Table 57: Motor voltage class table fields descriptions.

Field name Type Description

motor_voltage_class Long integer Voltage class (480, 4160, and so on).

class_description Text (64) Voltage class description.

 

166 Baker AWA-IV 71-015 EN V16 User Guide       www.megger.com



Appendix F — Baker AWA-IV Specific Winding Faults

Table 58: Software fault  messages

Status Failure type Failure message

PASS No failure was detected according to the Test Model given.

FAIL USER ABORT  A user abort has been detected.

FAIL EMERGENCY 
SHUTOFF

Emergency Shutoff has been detected

Tested Tested No message, cannot determine Pass/Fail because no test criteria 
was turned on.

FAIL CANCEL User canceled test.

Table 59: Resistance failure types

Status Failure type Failure message

FAIL DELTA R Resistance test result:  Fail – DELTA R.  Delta R percent is out of 
tolerance.

FAIL OPEN LEADS Test results: Fail-OPEN LEADS.  Open Leads Detected.

FAIL TOLERANCE Test Results:  Fail-TOLERANCE Resistance(s) outside of user 
defined targeted range.

CAUTION Resistance out of 
range

Resistance values must be greater than 0.500 ohms for HIGH 
VOLTAGE LEADS and greater than 0.001 for the RES LEADS.  
You may stop Testing, reconfigure Test ID with the appropriate 
leads, and repeat the test OR continue with the remaining tests.

CAUTION MAX R Range 
Exceeded

Test Results:  Caution – MAX Resistance Range Exceeded.  

Possible Open lead(s).

FAIL No Resistance 
Solution

Resistance values do not have a solvable solution.  This issue can 
be caused by improper lead contact.  Recheck all test leads and 
connections before retesting.

It can also be caused by manually editing the MotorID table that 
results in bad values entered into the “winding_config” column.  
Contact Megger support for additional information on fixing 
MotorID table issues of this sort.

FAIL NOISY ADC Instrument detecting excessive electrical noise.  Resistance 
measurements are unstable.  Check for noise sources nearby 
(welders, VFDs, etc.) or a free wheeling rotor.
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Table 60: DC test failure types

Status Failure type Failure message

FAIL Over voltage Over Voltage Condition has been detected.

FAIL Open ground An open ground has been detected.  Check power cord outlet 
ground for continuity.

FAIL Min Meg-Ohm Test Result.  Fail – MIN MEG-OHM.  Meg-Ohm value is less than 
the minimum tolerance.

FAIL Min PI PI test results:  Fail – Min PI.  PI Ratio is less than minimum 
tolerance.  

FAIL Over current Test result:  FAIL – OVER CURRENT.  An over current trip was 
detected.

FAIL No steps defined No steps for Step-Voltage Test exist in this Test ID.

FAIL Low PRG HPT voltage The last step voltage is below the previous Meg-Ohm/PI test 
voltage.

Table 61: Surge test failure types

Status Failure type Failure message

FAIL Open leads Test Results:  Fail – OPEN LEADS.  Open leads detected.

FAIL Over voltage Over Voltage Condition has been detected.

FAIL Open ground An open ground has been detected.  Check power cord power 
outlet ground for continuity.

FAIL ppEAR Limit  Surge test results:  Fail – ppEAR LIMIT.  Pulse-to-Pulse EAR%.

FAIL L-L EAR Surge Test Result:  Fail – L-L EAR Lead- to-Lead EAR % is out of 
tolerance.

CAUTION Unequal zero 
crossings

Test results:  Caution – UNEQUAL ZERO CROSSINGS Waveforms 
do not have the same number of zero crossings.
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Table 62: Fault analysis chart

Failure mode Winding 
resistance

Megohm 
test

PI test Step 
Voltage

Surge

Weak insulation turn-turn X

Weak insulation phase-
phase

X

Weak insulation coil-coil X

Turn-turn shorts X X

Phase-phase shorts X X

Coil-coil shorts X X

Open coils X X

Reversed coils X

Unbalanced phases X X

Weak ground wall 
insulation

X X X X

Dirty windings X X X

Moisture X X X

Faulty feeder cables X X X X

Motor Lean line connections X

Table 63: AWA-IV static testing parameters, indicators, and common causes
Parameter Indication Result/Cause

Resistance Imbalance Indication of high resistance connection.  Improper winding 
connection, or circuit shorting.

Insulation resistance Low Megohms Indication of significant thermal degradation, contamination of 
moisture influences.

Insulation resistance Overcurrent trip Insulation breakdown at the test voltage.  Indication of imminent 
or existing insulation failure.

Insulation resistance HiPot Non-linear 
current

Indicates insulation is reaching its end of life, or contamination 
near exposed conductors.

Surge test Erratic wave Indicates weakness in copper-to-copper insulation.  Most likely 
turn-to-turn insulation.  Indicates insulation’s end of useful life.

Surge test Wave imbalance Indicates winding imbalances caused by asymmetries from the 
winding process or an insulation failure.
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SE-182 17 

DANDERYD

T. 08 510 195 00

E. seinfo@megger.com

Megger USA - Fort Collins

4812 McMurry Ave., Suite 100

Fort Collins 

Colorado, 80525 

USA

T. 1-970-282-1200 or 1-800-752-8272 
F. 1-282-1010

E. baker.tech-support@megger.com

Manufacturing sites

Local Sales office

This instrument is manufactured in the United States.

The company reserves the right to change the specification or design 
without prior notice.

Megger is a registered trademark.
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